Contents

Chapter 1
Finding the information you need
  Looking at what's inside ........................................ 9
  Finding other resources ........................................ 12

Chapter 2
Understanding OpenScript programming
  About OpenScript ............................................. 14
  OpenScript development tools ................................. 15
  Comparing OpenScript with other languages ............. 18
  Extending ToolBook and OpenScript ....................... 19

Chapter 3
Learning OpenScript basics
  About scripting in ToolBook ................................. 22
  Writing scripts ............................................... 22
  The object hierarchy ......................................... 26
  Objects and properties ...................................... 29
  Types of handlers ............................................ 34
  Entering and displaying data ............................... 35
Chapter 4
Using the scripting tools
   Using the script editor ........................................... 40
   Working in the Command window ............................. 50
   Preventing common scripting errors ....................... 55

Chapter 5
Handling messages, events, objects, and properties
   About messages in OpenScript ................................. 58
   Working with system objects and properties ............. 69
   Defining user properties ....................................... 71
   Creating properties using scripts ......................... 74
   Creating self-contained objects using notify handlers.. 79

Chapter 6
Creating an OpenScript statement
   About OpenScript commands ................................. 84
   Using OpenScript control structures .................... 86
   Using functions .................................................. 93
   Creating user-defined functions ............................ 95
   Creating expressions with operators ...................... 97
Chapter 7
Using variables, values, and text

Using variables ................................................. 111
Assigning data types to variables ....................... 115
Using arrays .................................................. 119
Working with literal values ............................... 126
Working with constants .................................... 132
Working with character strings ......................... 134
Working with lists ............................................ 139
Referring to colors ........................................... 141

Chapter 8
Writing common scripts

Designing navigation ....................................... 145
Checking for results and errors ......................... 153
Creating scripts in a running application ............. 155
Saving changes to applications ......................... 159
Creating libraries of handlers using system books ... 162
Initializing an application ............................... 167
Setting startup properties for ToolBook ............... 175

Chapter 9
Handling user events

Handling mouse events ................................. 177
Handling keyboard events ............................. 188
Chapter 10
Managing data

Formatting data .......................... 199
Validating data .......................... 203
Reading and writing to files .......... 208
Searching pages ........................ 213
Sorting pages ........................... 215

Chapter 11
Using special effects

Animating objects ...................... 218
Adding drag-and-drop behavior ...... 232
Creating sound effects ................. 249

Chapter 12
Using dynamic data exchange

About dynamic data exchange .......... 270
Using ToolBook as a client .......... 272
Using ToolBook as a server .......... 279
Chapter 13
Using dynamic-link libraries

About DLLs .................................................. 284
Linking and declaring DLL functions ................. 287
Allocating Windows memory ......................... 295
Calling Windows API functions ..................... 297
Translating Windows messages in ToolBook ........ 298

Chapter 14
Debugging OpenScript programs

About debugging a ToolBook script ................. 307
Responding to the Execution Suspended message .. 313
Using the ToolBook Debugger ..................... 315
Using scripts for debugging ......................... 326
Chapter 1

Finding the information you need

This book, *Programming in OpenScript*, explains how to use the OpenScript programming language. An overview of the topics is available in this chapter, as well as an explanation of the other resources available for learning about OpenScript.

Looking at what's inside ................. 9
Finding other resources .................. 12
Looking at what's inside

This online guide contains a wealth of information on OpenScript, the programming language that you can use to enhance the applications you create with ToolBook™. This guide provides a basic foundation for understanding OpenScript, and then builds on that foundation, chapter by chapter. In addition to this chapter, here is what you will find:

♦ **Chapter 2**, “Understanding OpenScript programming,” introduces OpenScript and provides an overview of the ToolBook scripting tools.

♦ **Chapter 3**, “Learning OpenScript basics,” explains the fundamental concepts, vocabulary, and techniques you need to know to create scripts.

♦ **Chapter 4**, “Using the scripting tools,” describes how to use the ToolBook scripting tools.

♦ **Chapter 5**, “Handling messages, events, objects, and properties,” teaches you how to work with built-in messages, system objects, and system properties, and how to create your own messages, user properties, and self-contained objects.

♦ **Chapter 6**, “Creating an OpenScript statement,” describes the components that make up a statement and the control structures you use to control blocks of statements.

♦ **Chapter 7**, “Using variables, values, and text,” focuses on how to use individual components of OpenScript programs, such as variables, constants, and literal values, and how to use text in your scripts.
◆ Chapter 8, “Writing common scripts,” teaches you how to use OpenScript to accomplish many common tasks, such as checking for errors.

◆ Chapter 9, “Handling user events,” discusses how to work with events that a user generates by clicking a mouse button or typing at the keyboard.

◆ Chapter 10, “Managing data,” provides information on using OpenScript to perform several data-management tasks, such as validating user input.

◆ Chapter 11, “Using Special effects,” describes how to use OpenScript to include special effects, such as animation, in your application.

◆ Chapter 12, “Using dynamic data exchange,” explains how to send and receive data from other Microsoft® Windows® applications.

◆ Chapter 13, “Using dynamic-link libraries,” shows how to extend ToolBook and OpenScript by calling Windows functions and other utility programs, and by translating Windows messages into ToolBook messages.

◆ Chapter 14, “Debugging OpenScript programs,” presents tools and techniques for building more reliable applications.
# Identifying visual cues

To help you interpret the information it contains, this guide uses the visual cues listed in the table below.

## Visual cues

<table>
<thead>
<tr>
<th>Example format</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+ALT+DELETE</td>
<td>Keys separated by a plus sign indicate keys to press in combination.</td>
</tr>
<tr>
<td><code>comboBox</code></td>
<td>In a paragraph, italic type indicates OpenScript keywords.</td>
</tr>
<tr>
<td><code>button id 12</code></td>
<td>This font indicates an OpenScript code example.</td>
</tr>
<tr>
<td><code>\</code></td>
<td>A backslash indicates that an OpenScript statement continues on the next line.</td>
</tr>
<tr>
<td><code>←</code></td>
<td>This symbol indicates that OpenScript syntax is continued from the previous line.</td>
</tr>
<tr>
<td><code>&lt;isShift&gt;</code></td>
<td>In a code example or syntax statement, angle brackets indicate a parameter that represents a literal value or expression.</td>
</tr>
<tr>
<td><code>--Initialize</code></td>
<td>In a code example, two hyphens precede a comment.</td>
</tr>
<tr>
<td>`before</td>
<td>after`</td>
</tr>
<tr>
<td><code>end [step]</code></td>
<td>In a syntax statement, square brackets indicate optional words and parameters.</td>
</tr>
<tr>
<td><code>...</code></td>
<td>In OpenScript syntax, an ellipsis indicates that the parameter can be repeated. In code examples, ellipses indicate the presence of any number of statements.</td>
</tr>
</tbody>
</table>

![Icon](image) This icon is located by text that indicates where to look in online Help for more information.
Finding other resources

In addition to this guide, there are a variety of other resources available for learning about OpenScript and ToolBook. These are:

◆ the ToolBook web site, which contains a Knowledge Base, an FAQ list, information on sample files, patches, and newsgroups. To visit the ToolBook web site, go to http://www.toolbook.com/

◆ the ToolBook online Help system, which includes an OpenScript reference of objects, properties, keywords, and dynamic-link library (DLL) functions, and also a comprehensive glossary. To use online Help, press F1 from anywhere in ToolBook, or select an item from the ToolBook Help menu.
Chapter 2

Understanding OpenScript programming

This chapter introduces OpenScript, the ToolBook programming language, and describes how to use it to develop applications. This chapter also includes an overview of the tools you can use to create OpenScript programs, and a comparison of OpenScript and other popular programming languages.

About OpenScript .......................................................... 14
OpenScript development tools ................................. 15
Comparing OpenScript with other languages .......... 18
Extending ToolBook and OpenScript .................... 19
About OpenScript

OpenScript is the ToolBook programming language. When you create applications in ToolBook, you use ToolBook’s built-in tools for tasks such as drawing objects on pages and creating hyperlinks. To take full advantage of ToolBook capabilities, you can use OpenScript to control the behavior of your application more directly and precisely.

OpenScript is a full-featured programming language that includes commands to accomplish a wide variety of tasks, from creating and managing new objects to linking functions in Windows dynamic-link libraries (DLLs). Though a powerful language, OpenScript is also easy to use because of its syntax (similar to English), its wide range of commands, and its object-oriented nature. Using ToolBook and OpenScript, you can program sophisticated Windows applications in a fraction of the time and effort needed to create similar applications in C or C++.

OpenScript is fully integrated into the ToolBook environment. You write scripts in the ToolBook script editor or enter commands directly into the Command window. The programs are compiled using the ToolBook compiler, and ToolBook runs the finished scripts at Reader level as part of your application. Because OpenScript is an integral part of ToolBook, the processes of creating, testing, and maintaining your programs are greatly simplified compared with the same processes in other programming languages.
OpenScript development tools

You enter OpenScript statements in the script editor or the Command window to create a script. One quick way to build a script is to copy an existing object that has the script you want (such as an object in a sample application), and then paste the object into your application.

Working with the features of the Debugger, you can set breakpoints and trace the execution of statements in any script. On the following pages, you’ll find a description of the Debugger as well as the other scripting tools.

🔹 Script editor Use to type new scripts and handlers, edit existing scripts, or cut, copy, and paste script segments from the Clipboard. Editing a script in the script editor is much like editing a document in a simple word processing program. In addition, you can check a script’s syntax, print the script, and display the ToolBook Debugger window.
◆ **Command window** Use to send messages, display information, and test short script segments. You can enter one or more OpenScript statements in the Command window and execute them immediately.

**Command [Main Window]**

◆ **ToolBook Debugger window** Use to correct errors in your scripts. You can set and clear breakpoints, display the values of local and system variables, and trace execution of script statements and calls to other handlers.

**ToolBook Debugger**

For details about using the script editor and Command window, see Chapter 4, “Using the scripting tools.” For details about the ToolBook Debugger, see Chapter 14, “Debugging OpenScript programs.”
Comparing OpenScript with other languages

If you have used another programming language, you will find that OpenScript provides virtually all the features you are familiar with from languages such as C, BASIC, and Pascal.

<table>
<thead>
<tr>
<th>OpenScript</th>
<th>C</th>
<th>BASIC</th>
<th>Pascal</th>
</tr>
</thead>
<tbody>
<tr>
<td>if/then/else</td>
<td>if/else</td>
<td>If/Then/Else</td>
<td>If/Then/Else</td>
</tr>
<tr>
<td>step</td>
<td>for</td>
<td>For/Next</td>
<td>For/Do</td>
</tr>
<tr>
<td>while</td>
<td>while</td>
<td>While/Wend</td>
<td>While/Do</td>
</tr>
<tr>
<td>do/until</td>
<td>do/while</td>
<td>Do/Loop Until</td>
<td>Repeat/Until</td>
</tr>
<tr>
<td>conditions/when</td>
<td>switch/case</td>
<td>Select Case/Case</td>
<td>Case/Of</td>
</tr>
<tr>
<td>increment</td>
<td>+=</td>
<td>inc</td>
<td>dec</td>
</tr>
<tr>
<td>decrement</td>
<td>-=</td>
<td></td>
<td></td>
</tr>
<tr>
<td>send &lt;message&gt;</td>
<td>void function</td>
<td>Sub</td>
<td>procedure</td>
</tr>
<tr>
<td>to get &lt;message&gt;</td>
<td>function</td>
<td>Function</td>
<td>function</td>
</tr>
<tr>
<td>system books</td>
<td>libraries</td>
<td>libraries (or DLLs)</td>
<td>units</td>
</tr>
<tr>
<td>system variables</td>
<td>global variables</td>
<td>global variables</td>
<td>global variables</td>
</tr>
<tr>
<td>break</td>
<td>break, return</td>
<td></td>
<td></td>
</tr>
<tr>
<td>format (number)</td>
<td>printf</td>
<td>print using</td>
<td></td>
</tr>
</tbody>
</table>
The following list tells you where to look in this manual for more information on several important ToolBook features.

- **Scope of variables** Variables can be local or global in OpenScript. For details, see Chapter 7, “Using variables, values, and text.”

- **Data typing** Variables are not typed by default, though you can assign data types for efficiency. If variables are not typed, you can use the data they contain alternately as strings and numbers. For details, see Chapter 7, “Using variables, values, and text.”

- **Arrays** You can define one-, two-, or many-dimensional arrays, or arrays containing variable numbers of elements. For details, see Chapter 7, “Using variables, values, and text.”

- **Data formatting** You can format numbers, dates, and times to alter how they are displayed and to make it easier to perform calculations with them. For details, see Chapter 10, “Managing data.”

- **User properties** Each object you create has built-in properties, and you can also define user properties to hold values that you create. For details, see Chapter 5, “Handling messages, events, objects, and properties.”

- **System books** You can establish any ToolBook file as a system book, or library, making its functions and handlers available to any ToolBook application. For details, see Chapter 8, “Writing common scripts.”
◆ **User-defined functions** In addition to using the built-in functions of ToolBook, you can define your own functions to calculate values, perform operations, or carry out other tasks. For details, see Chapter 6, “Creating an OpenScript statement.”

◆ **Notify handlers** Using the `notifyAfter` and `notifyBefore` message handlers, you can create objects that you can put into any ToolBook application without altering any scripts. For details, see Chapter 5, “Handling messages, events, objects, and properties.”

◆ **Dynamic script creation** Using the `execute` statement and `evaluate` function, you can create and execute scripts from within other scripts while your application is running. For details, see Chapter 8, “Writing common scripts.”

---

**Extending ToolBook and OpenScript**

You can extend OpenScript by interacting with other Windows applications, and even mainframe computers, by using:

◆ the Windows dynamic data exchange (DDE) protocol to incorporate the strengths of other Windows applications into your ToolBook application. For example, an application might get the results of complex calculations from Microsoft Excel and display the results graphically in ToolBook. For details, see Chapter 12, “Using dynamic data exchange.”

◆ the `linkDLL` command to link a Windows DLL and call its functions. ToolBook can use functions from 32-bit Windows DLLs; you need to know what functions are in the DLL and the data types of their parameters, but after that you can use them like any ToolBook function. For details, see Chapter 13, “Using dynamic-link libraries.”
the `translateWindow32` command to translate Windows messages into ToolBook messages so that your ToolBook application can respond to events generated by the Windows system. For details, see Chapter 13, “Using dynamic-link libraries.”
Chapter 3

Learning OpenScript basics

This chapter is a primer on OpenScript that explains the fundamental concepts, vocabulary, and techniques used to create scripts, and presents simple examples of all the OpenScript elements discussed.

The chapter assumes that you already know how to use the ToolBook user interface to create objects and change their properties, and that you have a basic understanding of general programming concepts, including statements, variables, functions, and control structures (such as if/then/else). You can find details about how each of these elements is implemented in OpenScript later in this book.

About scripting in ToolBook ......................... 22
Writing scripts ..................................... 22
The object hierarchy ............................... 26
Objects and properties ............................ 29
Types of handlers ................................. 34
Entering and displaying data ....................... 35
About scripting in ToolBook

ToolBook is an object-oriented programming environment, which means that you build your application by creating objects using the ToolBook user interface. For example, buttons, rectangles, and fields are all objects. They reside on pages and backgrounds, which are also objects, and all of these together reside in a book, which is an object as well. You set an object’s properties to define its appearance (color, shape, text) and behavior (for example, what happens when the user clicks it).

Like Windows, ToolBook is event-driven. ToolBook waits for an event to occur, such as when a user presses a key, clicks the mouse, opens a ToolBook file, chooses a menu item, moves the cursor across an object, or even does nothing (an idle event).

Each event creates one or more messages in ToolBook. ToolBook sends a message to the target, which is the object directly affected by the event. For example, when the user goes to a new page in the book, the enterPage message is sent to the new page, and the leavePage message is sent to the original page. When the user clicks an object, ToolBook sends the buttonClick message to the object indicating that the user pressed and released the left mouse button. If the user is doing nothing, ToolBook sends the idle message continuously to the current page.

Writing scripts

ToolBook has built-in responses to many of the messages generated by events. For example, its response to the message sent when a user chooses a built-in menu command is to display a dialog box or perform an action.
For many events, you can rely on the built-in responses of ToolBook. However, if you want to control directly how an object responds to an event, you create a handler for a message. A handler is a series of OpenScript statements that define the response to a particular message. For example, this handler defines how an object will respond when a user clicks it:

```openscript
to handle buttonClick
   request "I've been clicked."
end buttonClick
```

Handlers are part of the `script` property of an object. A script can contain any number of handlers, each responding to a different message.

Any object in a ToolBook application, including books, pages, and backgrounds, can have a script. To create a script, you use the script editor, which you invoke much the same way you do the dialog box for other properties of an object.

**To create a simple handler:**

1. In a new ToolBook book, add a button to a page.
2. To display the script editor, right-click the button, and then click the Script button on the shortcut menu toolbar.
3 Enter this script:

    to handle buttonClick
    request "I've been clicked."
    end buttonClick

4 To save the script, choose Update Script & Exit from the File menu, or press CTRL+S.

    When you save a script, ToolBook automatically compiles it. If there is an error in the script, ToolBook cannot compile it and displays an error message. You cannot run a script until it has compiled successfully.

5 Switch to Reader level (press F3), and then click the button.

    ToolBook displays a message box with the text "I've been clicked."

The handler you wrote above is for the buttonClick message, which is sent when you click the left mouse button. Without the script, the button does nothing when you click it; by adding this handler to the button's script, you define the button's response to the click.

The entire script for an object is limited to that which can be displayed in the script editor (64 KB). However, handlers can be converted to simple wrappers that can call more detailed scripts stored in other objects. For example:

    to handle buttonClick
    send MyHandleButtonClick to page 2
    end

    In this script, the detailed script to handle the buttonClick message is handled in the MyHandleButtonClick handler on page 2.
Using the Command window to enter scripts

You can also run OpenScript statements at Author level using the Command window, shown below. You can type one or more OpenScript statements in the Command window to make an immediate change to your application or to see the effect of an OpenScript command. Use the Command window to quickly set properties for objects or to test statements as you build your application.

**Figure 1** The Command window

You can open the Command window by:
- choosing Command from the View menu.
- pressing SHIFT+F3.
- clicking the Command Window button on the toolbar.

For details about using the script editor and the Command window, see Chapter 4, “Using the scripting tools.”
The object hierarchy

When an event occurs, ToolBook sends the corresponding message to the target object. If the target object’s script has a handler for the message, ToolBook runs the handler and the message travels no further (unless the handler forwards the message, as explained later in this chapter). If the object does not have a handler for the message, the message passes to another object. The order in which a message goes from object to object is called the object hierarchy.

In the object hierarchy, a message passes from an object to its parent object. A page is the parent for objects and groups that reside on it, the background is the parent for the page, and the book is the parent for the background. If the object has no script for the message, the message moves further up the hierarchy until it either encounters the handler it is seeking or reaches the ToolBook system at the top of the hierarchy. If the message reaches the system level, ToolBook provides the default behavior (which might be to do nothing).

Messages enter the object hierarchy at different levels, depending on the message. For example, most mouse-event messages are sent to the object under the cursor. Menu-event messages enter the hierarchy at the page level, as do navigation messages such as enterPage, leavePage, next, and previous.

Note When a message enters the hierarchy at the page level, an object with a notifyBefore handler for that message will intercept the message before it starts at the page level. It’s important to keep this in mind when writing self-contained objects. For more information on creating self-contained objects using notify handlers, see Chapter 5, “Handling messages, events, objects, and properties.”
The following procedure demonstrates how the object hierarchy works. Before starting, create the button and script discussed in "Writing scripts" earlier in this chapter.

**To show the object hierarchy:**

1. Add more objects to the same page: another button, a rectangle, and a circle.
2. Make sure no object is selected, and then click the Script button on the toolbar.
   ToolBook displays the script editor with the script for the page, which is the default when no objects are selected.
3. Enter this handler in the page’s script:
   ```
   to handle buttonClick
      request "Your click reached the page."
   end buttonClick
   ```
4. To save the script, choose Update Script & Exit from the File menu, or press CTRL+S.
5. Switch to Reader level (press F3). Then, to see the results, click on each object and on a part of the page that contains no objects.

There are now two buttonClick handlers in your book: the one you created earlier for the button and the one you just entered as part of the page script. If you click the button with its own handler, ToolBook runs the handler for that button. However, if you click an object without a handler for the mouse event, the message passes up the hierarchy to the page, where ToolBook runs the handler you just entered.
Forwarding a message

If an object has a handler for a message, the message stops at that object. However, you can forward a message to send it further up the object hierarchy so that the message triggers additional handlers or the ToolBook default response.

For example, if a button on the page handles a `buttonClick` message, the message stops with the button. If there is another handler for the `buttonClick` message higher in the hierarchy, the second handler will not run because it will never receive the message. If you want both handlers to run, use the `forward` command in a handler to pass the message up the hierarchy.

Use the script editor to modify the script you created earlier for the button by adding a `forward` command:

```plaintext
to handle buttonClick
    request "I've been clicked."
    forward
end buttonClick
```

When you click the button at Reader level, you will get two messages: one produced by the handler you just modified and one produced by the handler you entered earlier for the page.

Forwarding a message is often necessary when ToolBook already has a default response to a message, as for keystrokes. For example, you can capture keystrokes with a handler for the `keyChar` event in a page script. When you do, however, ToolBook does not get the keystroke messages, and so it will not display the keystrokes unless you also forward the messages.

For example, create a field and ensure Enabled is selected on its right-click shortcut menu. Then, add this handler to the script of the field:
When you enter data into the field at Reader level, each keystroke causes a beep. In addition, the messages caused by the keystrokes pass up the object hierarchy to the ToolBook system. The ToolBook default response is to display the correct characters in the field. If you remove the `forward` statement, your handler runs, but ToolBook does not receive the messages and no characters are displayed.

**Using the object hierarchy effectively**

You can take advantage of the object hierarchy to make writing and debugging scripts easier. For example, you can use the `forward` command to pass messages up the object hierarchy. This allows multiple handlers to respond to a single message. You can also put a message handler in a page or book script so that no matter what the target object is, you can handle the message with a single script. Finally, you can selectively disable events to prevent handlers at a higher level from taking effect by not including the `forward` command.

**Objects and properties**

Everything about an object, including its position, size, color, and script, is defined by a property. You can view and set many object properties using the ToolBook user interface. For example, you can set the color of an object by clicking a tile in the color tray. However, you often get and set properties using OpenScript statements.
For example, you can set the color of an object to red as a warning, or get the text of a field after the user enters data. This section explains how you refer to objects and properties using OpenScript statements.

For a complete list of ToolBook objects and their properties, refer to the OpenScript reference in online Help.

**Note** ToolBook has system objects with their own properties, such as the palettes. For details, see Chapter 5, “Handling messages, events, objects, and properties.”

### Referring to objects in scripts

If you want to set or get the properties of an object in a script, you must identify the object by type and name. To identify the type, use OpenScript keywords such as `button`, `page`, and `roundedRectangle`. For example:

```plaintext
caption of button ID 3
objectCount of page "Contents"
bounds of roundedRectangle ID 1
```

To refer to a particular object, assign a name to the object in its Properties dialog box, and then use the name as follows:

```plaintext
to handle leavePage
  hide field "User Tip"
  go to page "Contents"
  forward
end
```

You must use quotation marks around an object name if it includes spaces or special characters other than an underscore. For example, you must use quotation marks around the name `"Planting Schedule"` but not around `Garden_Plan`. However, you should use quotation
marks around names in all cases because ToolBook runs faster if it does not have to determine whether the object name is a variable.

You can also refer to an object by its ID number, which is assigned by ToolBook when you create the object, as in this example:

button ID 1 of page ID 0

When practical, however, you should use a name to refer to an object. If you copy and paste an object, its ID number changes because ToolBook creates a new version of it, but its name remains the same.

Using implicit and explicit references

If the object you are referring to is on the current page (the page displayed in the current viewer), you can use an implicit reference to your object. An implicit reference identifies only the object type and name. This makes your scripts short and easy to read. However, if the object is on the background, on another page, or in another book, you need to use an explicit reference that includes the location of the object. The following statements illustrate explicit references:

- --On the background
  bounds of recordField “Name” of background ID 1
- --On another page
  text of field “Name” of page “Introduction”
- --In another book
  script of group “clock” of page 3 of book “widgets.tbk”

To determine the correct explicit reference for an object, move the cursor over it at Author level. ToolBook displays the explicit reference of the object in the status bar.

Every object has a uniqueName property that contains its explicit
reference. The *uniqueName* is a formal object reference; when OpenScript commands and functions return the name of an object, the name is always the *uniqueName* property of the object.

**Referring to the current object**

You can refer to the current object using the special terms *this, my, self, target,* and *selection:*

- **this** refers to the page or background displayed in the current viewer, or to the current book. For example:
  
  ```
  bounds of recordField "Name" of this background
  pageCount of this book
  ```

- **my** and **self** in a handler refer to the object whose script contains that handler. For example:
  
  ```
  request my uniqueName
  move self by 1000,1000
  ```

- **target** refers to the object that first received the message that triggered the current handler. For example, if the user clicks a pushbutton, that button is the target, even if the message is forwarded up the object hierarchy to the book. You can use *target* to write scripts that handle the same event for many different objects, as in this handler for a book script:

```
--Determines what type of object the user clicked
to handle buttonClick
  if target contains "button" then
      request "You clicked a button."
  end if
  if target contains "field" then
      request "You clicked a field."
  end if
end buttonClick
```
◆ selection refers to the currently selected object or objects. For example:

move selection by 2880,-2880

Setting and getting the values of properties

You assign a value to a property of an object using the assignment operator (=) or the command set or put. All three methods accomplish the same task, so you can interchange them as you like. The following examples illustrate how to use all three:

fillColor of ellipse "face" = red
set fillColor of ellipse "face" to red
put red into fillColor of ellipse "face"

Many properties have constraints on the values you can assign to them. For example, the property transparent can only be set to the values true or false. If you attempt to assign an invalid value, an error results.

Except for ID numbers, the properties of objects are persistent. This means that the properties of an object are stored with and accompany the object when it is cut or copied. Some properties are read only; for example, a book’s pageCount property. You can get the value of the property, but ToolBook does not allow you to alter it.

Note If you misspell the name of a property when you assign a value to it, ToolBook creates a user property with that name instead of reporting an error. For details, see Chapter 5, “Handling messages, events, objects, and properties.”

To get the value of a property, use it in any expression:

if fillColor of ellipse "face" is red then
    fillColor of ellipse "face" = blue
end
You can also use a `get` command to put the value of a property into a special variable called `it`:

```
get fillColor of ellipse "face"  --Puts the value of fillColor -- into the variable it
```

For details about the variable `it`, see Chapter 7, “Using variables, values, and text.”

**Types of handlers**

The most common type of handler in ToolBook responds to messages and begins with `to handle`. However, there are actually five types of handlers in ToolBook:

- **to handle** responds to a message.
- **to get** returns a value for use in other handlers. Use this type of handler to create a user-defined function or to get the value of a property defined using OpenScript statements. For details, see Chapter 5, “Handling messages, events, objects, and properties” and Chapter 6, “Creating an OpenScript statement.”
- **to set** defines new properties with OpenScript statements. For details, see Chapter 5, “Handling messages, events, objects, and properties.”
- **notifyBefore** or **notifyAfter** defines a handler that is notified when a page receives a particular message. Use these handlers to create objects that can be copied into an application without having to change scripts anywhere in the book. For details, see Chapter 5, “Handling messages, events, objects, and properties.”
Using parameters with handlers

A parameter is information that accompanies a message to provide more detail. For example, ToolBook sends three parameters with a buttonClick message, two of which indicate whether the user was holding down the SHIFT or CTRL key when the button was clicked. You can include variables on the opening line of the handler to receive parameters:

--Displays a message if the user clicks while pressing SHIFT;
--the variable's location, isShift, and isCtrl are parameters
to handle buttonClick location, isShift, isCtrl
  if isShift is true then
    request "You clicked while the Shift key was down."
  end if
end buttonClick

Entering and displaying data

The user generally interacts with your application through the objects you create—clicking buttons, entering text into fields, or choosing menu items. At times, however, you might need a more direct way to get data from the user or to display text. For example, you might need to display the values of variables, display an error message, or prompt the user for a password. You can use the:

◆ Command window to enter OpenScript statements or display values.
◆ ask command to solicit text from the user.
◆ request command to display a message and prompt the user to click a button in response.
text of fields and record fields to display text or the values of variables.

status bar, in which you can display any text.

dialog boxes that you create to prompt the user for information.

**Using the Command window to display information**

You can execute OpenScript statements directly in the Command window; ToolBook displays the results immediately. You can also use the Command window to view data. If you use the `put` statement without naming a container to put the data into, ToolBook displays the data in the Command window:

```
put pageCount of this book --Shows page count in
--the Command window
```

**Prompting for information with the ask command**

To prompt the user to enter a single line of data, use the `ask` command, which displays a dialog box with OK and Cancel buttons. The user’s response is returned in the variable `It`:

```
to handle enterBook
  ask "Enter your name:" 
  if It is not null then 
    request "Welcome to the Tutorial," & It
  end if 
  forward 
end enterBook
```
**Asking a yes or no question with the `request` command**

If you just want a quick yes-or-no answer from the user, use the `request` command to display a message and buttons for Yes and No. The text of the button the user clicks is returned in the variable `It`:

```plaintext
request "Do you wish to move to the next page?" with "Yes" or "No"
if It is "Yes" then
    send next
end
```

**Setting the text of fields and record fields**

If you want to display information as part of the current page, set the text of a field or record field. The text is a property of the field or record field, so it retains its value until you change it again. For example, this handler shows the name of the current page in a record field, updating it as the user navigates from page to page:

```plaintext
to handle enterPage
    text of recordField "Caption" = name of this page
    forward
end
```

**Setting the caption of the status bar**

To display text in the status bar at the bottom of the ToolBook main window, set its `caption` property. Using the status bar to display information is especially effective when you do not want to interrupt the flow of the application with a message box. To display the status bar at Reader level, press F12, or use the command `show statusBar` in a script or in the Command window. For example:
-- Identifies the clicked object in the status bar
to handle buttonClick
  caption of statusBar = "Current object name is" && target
end

Creating dialog boxes

The most flexible way to collect information from a user is to display a dialog box. The dialog box can contain multiple fields, buttons, combo boxes, and other controls, and it can display default data and provide data validation of user entries. You can create viewers that act like dialog boxes.

For details about viewers, refer to the OpenScript reference and other viewer topics in online Help.
Chapter 4

Using the scripting tools

To make your scripting and application development easier, ToolBook includes a script editor and the Command window. This chapter describes how to use these scripting tools and provides tips for preventing common mistakes.
Using the script editor

You can use the script editor to write, edit, check syntax for, and save the script of a selected object. Like the ToolBook main window, the script editor has a toolbar with buttons for the most frequently used commands for writing and editing scripts.

Figure 1  The Script editor
### Buttons on the script editor toolbar

<table>
<thead>
<tr>
<th>Default script editor button</th>
<th>Script editor button when CTRL key is pressed</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save icon" /></td>
<td><img src="image" alt="Uncomment icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Check Syntax icon" /></td>
<td><img src="image" alt="Indent icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Debug icon" /></td>
<td><img src="image" alt="Outdent icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Undo icon" /></td>
<td><img src="image" alt="Find icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Redo icon" /></td>
<td><img src="image" alt="Find Next icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Cut icon" /></td>
<td><img src="image" alt="Replace icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Copy icon" /></td>
<td><img src="image" alt="Parent icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Paste icon" /></td>
<td></td>
</tr>
</tbody>
</table>
You open the script editor at Author level by:

◆ selecting an object and then clicking the Script button on the toolbar.
◆ right-clicking an object and then clicking the Script button on the shortcut menu toolbar.
◆ selecting an object, choosing the appropriate Properties command from the Object menu, and then clicking the Script button on the script editor toolbar.
◆ typing edit script of <object> in the Command window.
◆ pressing CTRL and then double-clicking an object.
◆ in the active script editor, clicking the Parent button and choosing an object from the pop-up menu.

Tip To create a page script, press CTRL and click the status bar. To create a background script, press CTRL+ALT and click the status bar. To create a book script, press ALT and click the status bar.

Editing multiple scripts

You can open one script editor for each object you want to work with. Script editors are modeless, except when associated with shared scripts. Modeless script editors allow you to perform other ToolBook tasks while they are open, and jump from one open script editor to another to work on the contents of several scripts simultaneously. To move between modeless script editors, click the one you want to work in, or choose one from the current script editor Window menu.
Tip You can display the script editor and modify a script at Reader level in two ways. You can execute the OpenScript statement `edit script of <object>` from the script of another object or from the Command window. Or, when Show right-click menus at Reader level is selected in the Options dialog box, you can right-click the object and click the Script button on the object’s shortcut menu toolbar.

Note The ability to edit scripts at Reader level is disabled in the run-time version of ToolBook.

Writing scripts

You can write a script for any ToolBook object by opening the object’s script editor and entering the script as you would with any text editor. Use these guidelines when you write a script:

- Lines can be any length, but lines over 80 characters are truncated when you print the script. Split a statement across more than one line by using the backslash (\) as a continuation character between expressions. (You cannot use a backslash in the middle of a string.) For example:

  ```
  ask “Enter your complete address.”
  ```

- Put multiple statements on one line by separating statements with semicolons (;).

- Indent handlers to make the script easier to read.

- If the previous line was indented, the script editor automatically indents to the same point when you press ENTER. Press BACKSPACE to remove an indent.
Insert comments in the script by typing two hyphens (--) before the comment text, or use block comments on selected text.

You can also write scripts by putting script text into the script property of an object. For details, see Chapter 8, “Writing common scripts.”

**Using script editor commands**

The following tables list the menu commands, toolbar buttons, and keystroke shortcuts you use in the script editor while writing scripts.

Use the following commands to move the insertion point.

**Script editor commands for moving the insertion point**

<table>
<thead>
<tr>
<th>To move</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any direction</td>
<td>Arrow keys</td>
</tr>
<tr>
<td>Left one word</td>
<td>CTRL+LEFT ARROW</td>
</tr>
<tr>
<td>Right one word</td>
<td>CTRL+RIGHT ARROW</td>
</tr>
<tr>
<td>Between the beginning of a line and the first</td>
<td>HOME</td>
</tr>
<tr>
<td>nonspace character of a line</td>
<td></td>
</tr>
<tr>
<td>To the end of a line</td>
<td>END</td>
</tr>
<tr>
<td>To the previous screen</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>To the next screen</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>To the beginning of the script</td>
<td>CTRL+HOME</td>
</tr>
<tr>
<td>To the end of the script</td>
<td>CTRL+END</td>
</tr>
<tr>
<td>To the top of the current screen</td>
<td>CTRL+PAGE UP</td>
</tr>
<tr>
<td>To the bottom of the current screen</td>
<td>CTRL+PAGE DOWN</td>
</tr>
</tbody>
</table>
Use the following commands to select text.

**Script editor commands for selecting text**

<table>
<thead>
<tr>
<th>To</th>
<th>Key command</th>
<th>Menu command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select to the start of a line</td>
<td>SHIFT+HOME</td>
<td></td>
</tr>
<tr>
<td>Select to the start of the script</td>
<td>SHIFT+CTRL+HOME</td>
<td></td>
</tr>
<tr>
<td>Select a single word</td>
<td>Double-click</td>
<td></td>
</tr>
<tr>
<td>Select a block of text</td>
<td>Click and drag</td>
<td></td>
</tr>
<tr>
<td>Select the contents of the script editor</td>
<td>SHIFT+F9</td>
<td>Select All from the Edit menu</td>
</tr>
<tr>
<td>Extend a selection</td>
<td>SHIFT+arrow keys</td>
<td></td>
</tr>
<tr>
<td>Cancel a text selection</td>
<td></td>
<td>Click elsewhere</td>
</tr>
</tbody>
</table>
Use the following commands to work with text and scripts.

### Script editor commands for working with text

<table>
<thead>
<tr>
<th>To</th>
<th>Key command</th>
<th>Toolbar button</th>
<th>Menu command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo changes</td>
<td>CTRL+Z</td>
<td></td>
<td>Undo from Edit menu</td>
</tr>
<tr>
<td>Reverse an Undo</td>
<td>CTRL+A</td>
<td></td>
<td>Redo from Edit menu</td>
</tr>
<tr>
<td>Indent line or selection to next TAB</td>
<td>CTRL+TAB</td>
<td></td>
<td>Indent from Format menu</td>
</tr>
<tr>
<td>Indent according to previous line</td>
<td>ENTER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move a line or selection back one TAB</td>
<td>CTRL+SHIFT+TAB</td>
<td></td>
<td>Outdent from Format menu</td>
</tr>
<tr>
<td>Find text</td>
<td>F5 or CTRL+F</td>
<td></td>
<td>Find from Edit menu</td>
</tr>
<tr>
<td>Find next instance of specified text</td>
<td>SHIFT+F5 or CTRL+N</td>
<td></td>
<td>Find Next from Edit menu</td>
</tr>
<tr>
<td>Search for and replace specified text</td>
<td>CTRL+F5</td>
<td></td>
<td>Replace from Edit menu</td>
</tr>
<tr>
<td>Print current script</td>
<td>CTRL+P</td>
<td></td>
<td>Print from File menu</td>
</tr>
<tr>
<td>Cut selection to Clipboard</td>
<td>CTRL+X</td>
<td></td>
<td>Cut from Edit menu</td>
</tr>
<tr>
<td>Copy selection to Clipboard</td>
<td>CTRL+C</td>
<td></td>
<td>Copy from Edit menu</td>
</tr>
</tbody>
</table>

46
### Script editor commands for working with text, continued

<table>
<thead>
<tr>
<th>To</th>
<th>Key command</th>
<th>Toolbar button</th>
<th>Menu command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste from Clipboard</td>
<td>CTRL+V</td>
<td></td>
<td>Paste from Edit menu</td>
</tr>
<tr>
<td>Import a text file into the script</td>
<td>F7</td>
<td></td>
<td>Import File from File menu</td>
</tr>
<tr>
<td>Export selected text to a text file</td>
<td>CTRL+F7</td>
<td></td>
<td>Export Selection from File menu</td>
</tr>
<tr>
<td>Write entire script to a text file</td>
<td>SHIFT+F7</td>
<td></td>
<td>Export Script from File menu</td>
</tr>
<tr>
<td>Make current line or selection into comments</td>
<td>CTRL-HYPHEN</td>
<td></td>
<td>Comment from Format menu</td>
</tr>
<tr>
<td>Uncomment current line or selection</td>
<td>CTRL+ =</td>
<td></td>
<td>Uncomment from Format menu</td>
</tr>
<tr>
<td>Invoke Debugger</td>
<td>CTRL+D</td>
<td></td>
<td>Debug from File menu</td>
</tr>
</tbody>
</table>
Use the following commands to save changes to a script.

**Script editor commands for saving scripts**

<table>
<thead>
<tr>
<th>To</th>
<th>Key command</th>
<th>Toolbar button</th>
<th>File menu command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compile, update, and leave the current script</td>
<td>CTRL+S</td>
<td><img src="image" alt="Update Script &amp; Exit" /></td>
<td>Update Script &amp; Exit</td>
</tr>
<tr>
<td>Compile and save without exiting</td>
<td>CTRL+U</td>
<td></td>
<td>Update Script</td>
</tr>
<tr>
<td>Compile, update, and save book</td>
<td>CTRL+B</td>
<td></td>
<td>Update &amp; Save Book</td>
</tr>
<tr>
<td>Exit without saving changes</td>
<td>ALT+F4</td>
<td></td>
<td>Exit</td>
</tr>
<tr>
<td>Check the current script’s syntax</td>
<td>CTRL+Y</td>
<td><img src="image" alt="Check Syntax" /></td>
<td>Check Syntax</td>
</tr>
</tbody>
</table>

Use the following commands to perform additional functions.

**Commands for performing additional functions**

<table>
<thead>
<tr>
<th>To</th>
<th>Menu command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change display font</td>
<td>Font from View menu</td>
</tr>
<tr>
<td>Hide or show toolbar</td>
<td>Toolbar from View menu</td>
</tr>
<tr>
<td>Hide or show status bar</td>
<td>Status Bar from View menu</td>
</tr>
</tbody>
</table>
Checking the syntax of a script

The syntax of a script must be correct before it will run. ToolBook checks the syntax of a script automatically when you choose Update Script or Debug from the script editor File menu. You can also check the syntax of a script as you write it.

To check the syntax of a script:

1. From the script editor File menu, choose Check Syntax. Or, click the Check Syntax button on the toolbar.

   If ToolBook finds a syntax error, it displays an error message and highlights the error. Otherwise, it displays the Syntax OK message. Assuming a syntax error is found:

2. Click OK to cancel the error message.

   ToolBook highlights the first syntax error it finds in the script.

3. Correct the error, and then choose Check Syntax again.

4. Continue checking and correcting the syntax of the script until ToolBook displays the Syntax OK message.

For details about syntax errors, see Chapter 14, “Debugging OpenScript programs.”
Working in the Command window

You can use the Command window to execute OpenScript statements without working in a script. You can also use shortcut keys to move commands or statements from scripts to the Command window. ToolBook runs statements in the Command window as soon as you press ENTER. The Command window is available at both Reader level (if specified in the script of an object) and Author level, and from the ToolBook Debugger. For details about using the Command window from the ToolBook Debugger, see Chapter 14, “Debugging OpenScript programs.”

Use the Command window to test an OpenScript statement or handler, or to quickly get or set the value of a property, send event messages to objects, or send messages up the object hierarchy. Command window messages enter the hierarchy at the page level.

Tip Because you can immediately see what happens when statements are executed, typing commands in the Command window is a good way to become familiar with OpenScript and test parts of scripts.

Figure 2 The Command window
You can use any of the following methods to display the Command window:

- Click the Command Window button on the toolbar.
- Choose Command Window from the View menu.
- Press SHIFT+F3.
- Use the `show commandWindow` statement in an OpenScript program.
- Use the `put` command without a target container in an OpenScript program.

You close the Command window as you close any other window. You can also move, resize, and maximize the Command window.

**Running Command window scripts**

ToolBook executes script in the Command window within the context of the page displayed in the last active viewer (ignoring “always reader” viewers). This means that:

- viewer is the target window. For example, `this page` refers to the page displayed in the viewer.
- script executes as if it is in the page’s script. For example, `self` refers to the page.

The name of the current viewer is displayed in the Command window title bar.
Using variables in the Command window

By default, variables used in the Command window are untyped local variables that do not persist beyond the execution of the script in the Command window. You can, however, declare a variable as a system variable in the Command window. For the values that ToolBook assigns to the special variables such as \textit{It}, \textit{my}, and \textit{self}, see the following table.

\textbf{Values of special OpenScript containers in the Command window}

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>\textit{It}</td>
<td>Value set by the last OpenScript command executed in the Command window</td>
</tr>
<tr>
<td>\textit{focus}</td>
<td>ID of object that had the focus at the time the Command window was displayed</td>
</tr>
<tr>
<td>\textit{my, self, target}</td>
<td>\textit{uniqueName of currentPage of current execution context}</td>
</tr>
<tr>
<td>\textit{this page, background, book}</td>
<td>\textit{uniqueName of page, background, or book displayed in current execution context}</td>
</tr>
<tr>
<td>\textit{CommandWindow}</td>
<td>*Text entered in the Command window</td>
</tr>
</tbody>
</table>

\textbf{Tip} You can use the Command window to write script for an object without displaying the script editor. For example, create a button, select it, and then type the following in the Command window:

\begin{verbatim}
script of selection = "to handle buttonClick" & CRLF & "go next page" & CRLF & "end"
\end{verbatim}

When you display the script for the button, the script text within the quotation marks appears.
Using the Command window to run and evaluate statements

Use the Command window to test commands before making them part of your scripts. Type an OpenScript statement in the Command window and then press ENTER. ToolBook executes the statement.

To create multiline statements in the Command window, press CTRL+ENTER at the end of each line or use a semicolon (;) to separate statements.

After you are satisfied with the statements you have entered in the Command window, you can paste the contents of the Command window into the script of an object.

Figure 3 Multiline scripts in the Command window
Command window history

The Command window keeps a history of the last 20 commands you entered in the current session. ToolBook displays the most recent command in the history area above the area where you enter commands. To resize the history area and show more commands, drag down the split bar located just below the Command window title bar. Browse the commands in the history area using either the mouse or the PAGE UP and PAGE DOWN keys. Clicking a command in the history area inserts it in the Command window for you to edit or execute. Double-click a command in the history area to execute the command.

Figure 4  Command history area is above the split bar

Debugging scripts in the Command window

To debug a Command window script, place it in the script of an object, and then debug that script. You cannot use the ToolBook Debugger to debug scripts in the Command window because Command window statements are read by ToolBook as one line of script, which the debugger does not break down into intermediate lines.
For details about using the ToolBook Debugger, see Chapter 14, “Debugging OpenScript programs.”

Preventing common scripting errors

You can prevent certain common scripting errors and make the debugging process easier by following these suggestions:

◆ Use the Command window to execute statements so you can observe the results and determine which statements work properly.

◆ Ensure that ToolBook displays the Execution Suspended message when an execution error occurs by setting the sysSuspend property to true (the default) while you are debugging a script. For details about debugging, see Chapter 14, “Debugging OpenScript programs.”

◆ Name objects consistently and descriptively. For example, if you have a page that contains a map of the United States, you might name the page USMap. If another page contains a map of Europe, you might name it EuropeMap.

◆ Make certain you have named an object before referring to it by name in a script. Also, enclose names in quotation marks to speed execution and avoid any confusion with OpenScript keywords.

◆ Verify that the values for a function referred to in a script, whether literal or variable, are within the valid range. For example, if you use the square root function, you cannot specify sqrt(-1) because negative numbers are outside the valid range for this function.
◆ Do not use OpenScript keywords as variable names.
◆ Make certain that you declare and initialize variables before referring to them in a script.
◆ Use variable names that describe the variable’s purpose. For example, if a variable holds the totals from a row in a spreadsheet, you might name the variable rowTotal. If another variable contains sales data from Japan, you might name this variable japanSales.
◆ Make sure that variable names are spelled correctly and consistently everywhere they occur in scripts. If you misspell the name of a variable, ToolBook creates a new local variable with that name.
◆ Include parentheses in or around expressions to force evaluation in a particular order.
◆ Add comments to your scripts to explain the use of handlers, statements, and variables so that others can understand how your script works.
◆ Indent control structures when you write handlers to make the script easier to read.
◆ When you finish building an application, get rid of any unused code, old hidden objects, and obsolete user properties.
Chapter 5

Handling messages, events, objects, and properties

This chapter describes the fundamentals of OpenScript programming—handling messages, events, objects, and properties. Here you will learn to work with built-in messages, create your own messages, work with system objects and system properties, create user properties, and create self-contained objects that are automatically notified of events.
About messages in OpenScript

ToolBook has two kinds of messages: built-in and user-defined. Built-in messages are those ToolBook sends automatically in response to an event, such as `buttonClick`, `enterField`, and `newPage`. User-defined messages are those you create and send.

Sending built-in messages

ToolBook sends a built-in message when you perform the action corresponding to that message. For example, ToolBook sends a `buttonClick` message when you click the left mouse button, and sends a menu-event message when you choose a menu item. ToolBook sends different types of built-in messages, depending on what actions you performed, as explained in the following section.

You can also achieve the effect of a built-in message by sending the message explicitly with the `send` command. For example, you can cause a button to respond as if it has been clicked by running a command such as this one from the Command window:

```
send buttonClick to button "Next"
```

Types of built-in messages

You can write handlers for these types of built-in messages:

- **Menu-event message** Sent to the current page when a menu item is selected from a menu at Reader or Author level. For example, if you select an object at Author level and choose Group Properties from the Object menu, the `properties` message is sent to the current page.
◆ **Mouse-event message** Sent at Reader level when the mouse button is clicked or the cursor moves over an object. For example, if a reader clicks a hotword in a field, ToolBook sends `buttonDown`, `buttonUp`, and `buttonClick` messages to the hotword.

◆ **Keyboard-event message** Sent at Reader level when a keyboard key is pressed. For example, if a user presses ENTER while typing in a field, ToolBook sends `keyDown`, `keyChar`, and `keyUp` messages to that field.

◆ **Enter/leave-event message** Sent at Reader or Author level to the viewer, page, background, book, or system when a user opens or closes an application, book, or viewer; navigates to another page; or clicks a menu. These event messages are also sent at Reader level to a button, combo box, or field when the object receives or loses the focus. For example, if a user presses TAB to move the focus to a field, the `enterField` message is sent to the field. If the user clicks another field, ToolBook sends a `leaveField` message to the previous field and an `enterField` message to the new field. ToolBook also sends a `mouseEnter` message to the new field.

◆ **Notification message** Sent to notify the system of various events, such as when an object is created, destroyed, or moved. For example, if you paste a field into a book, ToolBook sends the `make` message to the new field. If nothing is happening at Reader level, the `idle` message is sent repeatedly to the current page.

◆ **Drag-and-drop message** Sent before, during, and after a drag-and-drop operation. ToolBook sends the `beginDrag` message to signal the start of the drag operation, and an `endDrag` message to indicate that the user has released the mouse button. During the drag operation, ToolBook continually sends `enterDrop`, `stillOverDrop`, and `leaveDrop` messages to objects as the cursor passes over them.
◆ **Query message** Sent to an object to determine the object's state or the value of a particular property. For example, during a drag-and-drop operation ToolBook sends an `allowDrop` query message to each object under the cursor in order to determine whether the object will accept a drop, which in turn determines whether ToolBook displays the drag image or the no-drop image.

◆ **DDE-event message** Sent at Reader or Author level when information is exchanged between applications through dynamic data exchange (DDE). For example, if an instance of Microsoft Excel requests data from ToolBook, the `remoteGet` message is sent to the current page.

◆ **Standard message** Sent at Reader level only to the ToolBook system (not up the object hierarchy). For example, `editScript`.

For a complete list of messages, refer to the OpenScript reference in online Help.

### Sending user-defined messages

User-defined messages allow you to create scripts for specific tasks that are not already part of ToolBook. Sending a user-defined message is like calling one of your own procedures or functions in another programming language.

You can send a user-defined message using the `send` command. You can also create menu items that send a user-defined message. In addition to creating the user-defined message, you must write a handler that responds to it.

For example, you might create an index page in your application, and then add a menu item named Index to the Page menu. ToolBook automatically sends the message `index` to the page when a user
chooses this menu item, or when you execute the command send index in a script. To define the response to the index message, write a handler like the following:

```--Place this handler in the page script, the background script, or the book script to handle index
  to handle index
  go to page "Index" of book "overview.tbk"
end```

If you don’t write a handler for a user-defined message, ToolBook displays an error message:

- For menu-event messages related to a user-defined menu item, ToolBook displays a message that there is no handler for the user-defined message.
- For other user-defined messages, ToolBook displays the Execution Suspended message.

When you create a user-defined message, make sure its name includes only letters and the underscore character, and that it is not an OpenScript keyword.

For details on keywords, refer to the OpenScript reference in online Help.

User-defined messages are particularly effective for creating modular applications because you can create individual handlers that are easier to code and maintain. For example, to streamline an enterBook handler, you can create separate handlers for different tasks, such as initializing menus, sizing windows, and establishing default values. Then, you can send user-defined messages from the enterBook handler to run these handlers, rather than including all of the statements required to do these tasks. The individual handlers
will run automatically when the book is opened, or you can call
them as needed with a send command.

to handle enterBook
   forward
   --The following are all user-defined messages
   send InitMenus
   send sizeAppWindow
   send setSystemDefaults
end

Placing handlers for built-in messages

You can place a handler for a built-in message in the target object’s
script or anywhere higher in the object hierarchy. Use these tips to
help you decide where in the object hierarchy to place the handler
for a specific message:

◆ Place handlers for built-in messages in the script of the target
  object or higher. For example, because leavePage is automatically
  sent to the page, don’t put a leavePage handler in the script of a
  button.

◆ To program general behavior for several objects, place a message
  handler high in the object hierarchy. For example, if the handler
defines behavior for several objects on a page, put the handler in
the script for that page, or group the objects and place the handler
in the script of the group. This strategy allows you to change, add,
or remove the component items of the page or group without
changing the scripts of the individual objects.
For example:

--Handler that asks for confirmation each time the user navigates to a new page; place this handler in a book script to handle next request “Are you sure you want to proceed?” with “Yes” or “No”
  if it is “Yes” then
    forward
  end if
end next

To program specific behavior for one object, or to cause various objects to respond differently to the same message, put the handler in the script of the target object. Or, put the handler in the page or book script, and then use the target property to distinguish which object received the message using a control structure.

For example:

--Handles navigation for buttons named “Next” and “Previous”
--and for hotwords whose name matches that of a page
handle buttonClick
  conditions
    when object of target is “button”
      send (name of target)
    when object of target is “hotword”
      go to page (name of target)
  else
    forward --User clicked some other object
  end conditions
end buttonClick
To define both specific and general behavior for an object, put a handler in the target object’s script to define specific behavior and forward the message. Then, put a handler for the same message higher in the message hierarchy to define general behavior. To allow a message to get to the ToolBook system while bypassing all scripts higher in the message hierarchy, use `forward to system`.

**Note** You can also create self-contained objects that are notified automatically of messages that are forwarded to the page they are on. For details, see “Creating self-contained objects using notify handlers” later in this chapter.

### Sending messages from scripts

Use the `send` or `forward` command to send a message regardless of whether the event that usually triggers the message occurred. By sending messages from scripts, you can:

- run a handler for a user-defined message.
- execute scripts of hidden objects.
- handle a message more than once.
- send menu-event messages without choosing the menu item.
- send mouse or keyboard messages at Author level.
- send enter- and leave-event messages (such as `enterBook` or `enterSystem`) without actually navigating.
- streamline handlers so they are easier to maintain.

Use the `send` command to run a handler in the current object’s script or send a message to any other object, including objects lower in the hierarchy or in another book. For example, `send buttonDoubleClick to`
selection runs the corresponding handler in the script of the selected object, and send buttonClick to this page runs the corresponding handler in the page script. When you send a message with the send command, ToolBook sets the target property to the uniqueName of the object you sent the message to.

Use the forward command to pass the current message to the next highest object in the hierarchy. For example, the forward command in an enterBook handler in a page script sends the enterBook message to the background. Use forward to system to forward a message directly to the ToolBook system, skipping any other objects in the object hierarchy. Forwarding a message does not change the target property.

A handler with a send or forward statement that runs another handler is referred to as a calling handler. The handler that is invoked is the called handler. When ToolBook encounters a send or forward statement in a script, it suspends the calling handler until the called handler is finished, and any additional handlers that the called handler in turn calls. Eventually, control returns to the calling handler.

Tip: Sending a message to a specific object is faster than allowing the message to travel up the hierarchy.

Sending message names as variables

You can pass the name of a message as a variable. To force ToolBook to recognize that you want the contents of the variable sent, not the variable name, put parentheses around the name of the variable that contains the message to be sent. For example:

ask "What message do you want to send?"
send (It)
Changing or disabling built-in messages

Because many messages move up the object hierarchy before they reach the ToolBook system, you can change a message or disable it altogether. For example, you can trap a keyboard-event message by writing a handler for it, and if you do not forward the message, ToolBook doesn’t ever receive and react to the message. For example:

◆ You can trap the author message and display a message instead of actually switching to Author level:

```plaintext
-- Traps the author message and asks for a password before
-- changing to Author level
to handle author
    ask password “Enter password for Author level:”
    if It is ”uAKmnKpw” then --The encrypted form of ”ToolBook”
        forward
    end if
end author
```

◆ You can trap the right mouse click and disable that event:

```plaintext
-- Traps and disables the rightButtonDoubleClick message
-- (no forward here, so the handler stops the message)
to handle rightButtonDoubleClick
end
```

◆ You can trap keyboard events and substitute a character (for example, an uppercase letter for a lowercase one) before forwarding the message:

```plaintext
to handle keyChar key, isShift, isCtrl
    -- The uppercase() function requires a letter, but key values
    -- are passed as numbers, so they must be converted
    uppercaseKey = uppercase(ansiToChar( key ))
```
Using parameters with messages

ToolBook sends some messages with parameters that contain additional information about the message. For example, ToolBook includes a parameter for the mouse position with the built-in message `buttonClick`. You can add parameter variables to handlers to capture this additional information. For example:

--- “Position” is a parameter variable containing the location of the cursor when the button was clicked
```
to handle buttonClick pos
    request "You clicked at " && pos
end
```

When you send a built-in or user-defined message with the `send` command, you can send values or variables as parameters for the message. Parameters are always placed after the message name and multiple parameters are separated with commas:

--- Sends a user-defined message with 3 parameters
```
send specialEffects location, color, grayTone
```

In the handler for the message, put the parameter variables in the same order, so you have access to the values that were passed:

--- Handler for a user-defined message with three parameters
```
to handle specialEffects location, color, grayTone
```
Naming variables for parameters

Parameters are placeholders, so only their position in the to handle statement is important. When you create a parameter variable, you can give it any valid variable name—it need not have the same name as the parameter in the calling routine, only the same position. For example, the first statement works as well as the second:

to handle specialEffects location, color, grayTone

to handle specialEffects place, colorCode, gradation

Scope of parameters

A parameter is passed by value—that is, it is a copy of the value in the calling handler. Therefore, parameters become local variables in the handler to which they are sent. If you change the value of a parameter in the called handler, it does not affect the value of the corresponding parameter in the calling handler.

Declaring data types for parameters

You can add data-type declarations to parameters in a to handle statement. As with any variable for which you declare a data type, this can make the parameter more efficient because it requires less memory and ToolBook can access the data faster. When you declare a data type for a variable, ToolBook converts the parameter variables to the appropriate type, and enforces that data type for the rest of the handler. For example:

to handle buttonClick point loc, logical isShift, logical isCtrl
   loc = mousePosition of this window
   loc = "abc" --Error (loc has been typed as a point, not string)
--Further statements here
end
For details about data types, see Chapter 7, “Using variables, values, and text.”

**Counting and listing parameters**

Besides referring to a parameter by its name, you can refer to a parameter in several other ways:

- Use the special variable `argList` to get a list of the parameters passed, and then refer to a parameter as an item in `argList`:
  
  ```plaintext
  put item 3 of argList into field “MyList” of this page
  ```

- Use the special variable `argCount` to get the number of parameters passed to determine (for example) that all of the parameters you intended to pass were passed.

- Use `itemCount(argList)` to get the number of items passed with a message, which is different from using `argCount`. For example, if a message has a location parameter, the parameter will contain a list of two numbers. In this case, `itemCount(argList)` returns 2, but the value of `argCount` is 1.

**Working with system objects and properties**

In addition to the objects that you create, such as buttons, fields, pages, and backgrounds, ToolBook contains a number of system objects that belong to the ToolBook system, but which you can manipulate to change the way ToolBook looks and behaves. Examples of system objects are the Command window, tool palette, and polygon palette.
ToolBook system objects differ from objects such as buttons and pages because you cannot create or destroy system objects. However, they have properties you can get or set. For example, you can hide and show these objects, set the caption of the status bar, and so forth. The object type names for the ToolBook system objects are:

- colorTray
- patternPalette
- statusControls
- commandWindow
- polygonPalette
- statusIndicators
- lineEndsPalette
- statusBar
- toolBar
- linePalette
- statusBox
- toolPalette

**Note** Only the `statusBar` system property is available in the run-time version of ToolBook.

System properties define default behavior for the entire ToolBook system or identify objects that are currently receiving messages. By changing the values of certain system properties you can set default properties for new objects, set margins and other printer properties, or format system-wide values such as the current date and time.

For example, if you set the system property `sysFontStyle` to `bold`, the text in new fields and buttons is automatically bold. By getting the value of other system properties such as `target`, `focus`, and `selection`, you can determine which object is the target for user events.

There are five types of system properties:

♦ **General system properties** These properties affect every book opened during the current ToolBook instance. For example, if you set the `sysTimeFormat` property in the `enterBook` handler for the first book opened in a ToolBook instance, that format will be used in all other books opened in that instance until another statement resets the format.
◆ Event-focus properties  The *target* property indicates the object that receives the current message. The *targetWindow* property indicates the viewer that displays that object. The *focusWindow* property indicates the viewer that is currently active (which may or may not be the same as *targetWindow*).

◆ Printer system properties  These properties affect various aspects of how a book prints. For example, if you set the *printerBorders* property to *true*, all pages and reports printed from that book will have a border around them.

◆ International system properties  These properties can be used to automatically adapt books to the local conventions of specific countries. For example, the value of *sysDecimal* specifies which character separates the fractional part of formatted numbers.

◆ Startup system properties  These properties affect all books in all instances of ToolBook. When you set a startup system property, ToolBook changes a value in the Tb100.ini file.

For details about the properties you can get and set for a specific system object, and for a list of all system properties, refer to the OpenScript reference in online Help.

### Defining user properties

You can assign a user property to an object to extend the kind of data the object can contain. For example, you can create a *lastScore* property for a book to store the final score in a game application. You can use user properties as global containers, much like system variables. However, unlike system variables, user properties are retained when you close the book and are associated with only one object.
Tip Data stored in user properties takes up space in a book; therefore, you should not include a lot of user properties if disk space is a consideration in your application.

Creating a user property

You create a user property by using it in an OpenScript statement as you would any built-in property. If the property you name does not already exist, ToolBook automatically creates it and sets it to the value specified:

userScore of button "Play" = 0

Note: If you misspell the name of a built-in property when setting its value (for example, set fullColor to blue instead of set fillColor to blue), ToolBook will create a user property instead of reporting an error.

When you refer to a user property, you must always include a reference to the object that owns the property. If you omit the object reference, ToolBook creates a local variable instead of a property. For example:

userScore of this book = 190 --Defines a user property
userScore = 190 --Defines a local variable
Getting the value of a user property

You get the value of a user property the same way you get the value of a built-in property. For example, the following statement gets the value of a `userScore` property:

```plaintext
get userScore of button "Play"  --Puts value into It
```

Listing user properties

You can use the keyword `userProperties` to list the properties you have created for any object. The most recently assigned user property appears at the front of the list. For example:

```plaintext
--Puts list of user properties into the Command window
put userProperties of button "Play"
```

Deleting a user property

To delete a user property and remove its name from the list `userProperties`, you can set the property value to null or use the `clear` command.

For example, to set a user property value to null:

```plaintext
userScore of button "Play" = null
```

To clear a user property:

```plaintext
clear userScore of button "Play"
```

Note To recover the space used by a user property that has been deleted, choose Save As from the File menu or run the OpenScript save as command and give the book a new name. This reorganizes the book to its most efficient size.
Creating properties using scripts

You can create properties with values determined by the handlers you write. The handlers are called when you use the set or get commands, just as if you were setting or getting a built-in or user property. However, instead of setting or getting a property value, ToolBook calls your handler, which can set values, modify objects, or run any other process that your application requires. Using this technique, you can create a property that:

◆ filters or converts characters, such as a ucText property that returns the uppercase version of the text of a field.

◆ checks for specific values when you assign them to an object, such as a dateText property that sets the text of a field but only allows valid dates.

◆ sets a group of properties to a predetermined value, such as a property that resets a number of objects to a single color, or a menu to a default configuration.

◆ calculates a value using DDE calls to another Windows application.

◆ adjusts visual elements of the application as its value changes, such as the bars on a chart.

To create a property using a script, write a to set handler. When you use a set command to assign a value to a property, ToolBook determines if the property is built-in. If so, ToolBook assigns the value to that property. However, if the property is not built-in, ToolBook sends a message to the target object and then up the object hierarchy. ToolBook runs the to set handler that matches the property name. If there is no corresponding to set handler, ToolBook creates a user property and assigns a value to it.
Creating a to set handler

The syntax for a to set handler is:

to set <propertyName> [parameters] to <value>
  --Further statements here
end

When you call the handler with a set command, the value that you assign to the property is passed to the to set handler as the <value> parameter. For example, the following to set handler defines a property called texture for a filled object (such as an ellipse) or for the background. Possible values for the texture property are bricks, waves, hearts, or none. Based on the value you assign to the texture property, the to set handler changes the pattern and fill color of the target object to a new value.

to set texture to vTextureName
  validObjects = "ellipse,rectangle,polygon,pie,background,irregularPolygon,roundedRectangle"
  --Check that this is a valid object type
  if object of target is not in validObjects
    break
  end if
  conditions
    when vTextureName is "bricks"
      pattern of target = 105
      fillColor of target = red
    when vTextureName is "waves"
      pattern of target = 94
      fillColor of target = blue
    when vTextureName is "hearts"
      pattern of target = 114
fillColor of target = 300,50,100 --Pink
when vTextureName is "none"
  pattern of target = 254 --None
  fillColor of target = white
end conditions
end texture

To call this handler, use a set command such as:

texture of ellipse “circle” = “bricks”

**Placing to set handlers in the object hierarchy**

You can place to set handlers in the script of a target object or anywhere higher in the object hierarchy. Use the same guidelines for placing the to set handler as you use for other handlers—for example, if you are creating a general-purpose handler, place it in the script of a book or system book. You can identify the object for which you are assigning the property using the target property.

**Note** When you write a to set or to get handler for a property, do not refer to that property in the body of the handler. If a statement in the handler tries to set or get the same property, ToolBook calls the handler again, creating an infinite loop.

**Getting a property's value with a to get handler**

To define the value of a property created with a to set handler, create a corresponding to get handler. The syntax for a to get handler is:

```
to get <propertyName> [parameters]
  --(calculate value here)
  return <value>
end
```
The following example shows the *to get* handler that corresponds to the *to set texture* handler shown earlier:

to get texture
   validObjects = “ellipse, rectangle, polygon, pie,” & \
   “background, irregularPolygon, roundedRectangle”
-- Check that this is a valid object type
   if object of target is not in validObjects
      break
   end if
conditions
   when pattern of target = 105 and fillColor of target = red
      retVal = “bricks”
   when pattern of target = 94 and fillColor of target = blue
      retVal = “waves”
   when pattern of target = 144 and fillColor of target = 300,50,100 -- Pink
      retVal = “hearts”
   when pattern of target = 254 and fillColor of target = white
      retVal = “none”
   else
      retVal = pattern of target & “.” & fillColor of target
   end conditions
return retVal
end texture

As with a built-in property, ToolBook will invoke the *to get* handler whenever you get the value of the property. For example:

request texture of ellipse “circle”

or

text of field “display” = texture of ellipse “circle”
If there is no `to get` handler for a property created with a `to set` handler, ToolBook returns `null`. ToolBook searches the hierarchy for a `to get` handler the same way it searches for a `to set` handler, so it’s a good idea to keep these together in the same script.

**Tip** Remember that if you provide `to get` and `to set` handlers, ToolBook will call the `to get` handler whenever it needs to get the property, and the `to set` handler whenever it needs to set the property. This happens in situations that are not immediately obvious. For example, consider a `brightness` property that changes the brightness of an object:

```openScript
to get brightness
    return item 2 of fillColor of target
end
to set brightness to value
    -- maximum brightness is 100, minimum is 0
    if value > 100
        value = 100
    else
        if value < 0
            value = 0
        end
    end
    item 2 of fillColor of target = value
end
```

If you execute a command such as:

```openScript
increment brightness of ellipse “light”
```

ToolBook will call the `to get` handler to get the value of `brightness`, increment it by one, and then call the `to set` handler to set it again.

**Note** You can also use `to get` handlers to create user-defined functions. For details, see Chapter 6, “Creating an OpenScript statement.”
Creating self-contained objects using notify handlers

A notify handler is one that is automatically notified when the message it handles reaches the page. Usually, objects receive messages only if they are the targets of a user action or of the `send` command, or if another handler forwards the message to them. However, if an object contains a notify handler, the page sends a copy of the message to that object. For example, you can create a "Next" button that is automatically notified of any `enterPage` event. If the user navigates to the last page of the book, a notify handler in the button can disable the button.

The advantage of using a notify handler is that rather than simply responding to a message, the object can be completely self-contained—you do not have to add a handler elsewhere to send a message to the object. You can copy the object to another book with no other changes. In the example of the "Next" button, without notification you would have to change the book script to send an `enterPage` message to the button in addition to simply copying the button to the background.

Types of notify handlers

You can use two types of notify handlers: `notifyBefore` handlers and `notifyAfter` handlers. `notifyBefore` handlers execute just before the message for which they are being notified is sent, and `notifyAfter` handlers execute just after the message is sent. You write a notify handler just as you write a normal handler, substituting the words `notifyBefore` or `notifyAfter` for the words `to handle` in the first line of the handler:

```
notifyBefore enterPage
   -- Further statements here
end
```
As an example, you can create an on-screen clock by displaying the time of day in a field. Create a notifyBefore handler in the field that responds to the idle event by setting the field's text to the current time:

```
notifyBefore idle
  system oldTime
  if oldTime is not sysTime then -- Update if time has changed
    my text = sysTime
    oldTime = sysTime
  end if
end idle
```

Another use for a notify handler is to create an object that is visible only at Author level. The following script illustrates how you can use notify handlers to ensure that the object is always hidden when the user switches to Reader level:

```
notifyBefore reader
  hide self
end
notifyAfter author
  show self
end
notifyBefore enterPage
  if sysLevel = "author"
    show self
  else
    hide self
  end if
end enterPage
```
Using notify handlers

When you use notify handlers, keep these points in mind:

◆ Multiple objects can be notified of the same message if each object contains a notify handler. However, you cannot specify the order in which the objects are notified of the message.

◆ Do not use the `forward` command in notify handlers. If you do, ToolBook generates an error when you attempt to save the script.

◆ To stop a notify handler from processing a message in its script, use `break`.

◆ You can put notify handlers into the script of any object on a page or background. However, you cannot put notify handlers into the scripts of pages, backgrounds, viewers, or books.

◆ Notify handlers respond only to messages that reach a page. If an object traps a message and does not forward it to the page, ToolBook will not call the notify handler. Similarly, if the message goes first to an object on the background and the script in that object does not explicitly send it to the page, ToolBook will not call the notify handler.

The table on the next page shows the properties and OpenScript commands that you can use with notify handlers.
### Properties and commands for notify handlers

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>notifyObjects</td>
<td>Page or background property that specifies a list of all objects that contain notify handlers</td>
</tr>
<tr>
<td>notifyAfterMessages, notifyBeforeMessages</td>
<td>Properties of an object that list the notify handlers written for that object</td>
</tr>
<tr>
<td>sendNotifyAfter</td>
<td>Command that activates a specific notifyAfter handler within a script</td>
</tr>
<tr>
<td>sendNotifyBefore</td>
<td>Command that activates a specific notifyBefore handler within a script</td>
</tr>
</tbody>
</table>
Chapter 6

Creating an OpenScript statement

This chapter describes how to create a statement in OpenScript and includes detailed information about the components that make up a statement: commands, functions, expressions, and operators. You will also learn about control structures, such as if/then/else and do/until, which you use to control blocks of statements in a script and expressions.
About OpenScript commands

To create an OpenScript statement, use a command and the parameters the command requires. OpenScript includes commands to:

◆ declare variables and get and set the values of variables or properties (get, increment, local, pop, push, put, set, and system).
◆ manipulate objects (align, clear, draw, and move).
◆ interact with the user and navigate between pages (ask, go, request, search, sort, and transition).
◆ print, save, read, or write data in ToolBook files (export, openFile, print, readFile, and writeFile).
◆ add and remove menu items (addMenu and addMenuItem).
◆ exchange data with other Windows applications (executeRemote).
◆ extend programming code to include routines and data within Windows DLLs.

For a complete list of commands and information on them, refer to the OpenScript reference in online Help.
Using commands versus sending messages

In some instances, you can either use a command or send a message to accomplish the same task. For example, commands such as align, clear, export, import, run, save as, search, and sort are also messages. Use these guidelines to determine when to use a command or message:

- Use commands such as export or search to execute the action without displaying the related dialog box. Use commands with keywords such as author or reader if you want to avoid running related message handlers. For example, the statement set sysLevel to reader does not execute actions in a to handle reader handler, but the working level is changed to Reader.

- Send messages such as import or saveAs if you want the user to perform the action by filling in a dialog box. Send a message such as reader or clear when you want any handlers for the message to run in addition to accomplishing the primary action. Sending a message results in the same behavior as choosing the related menu item.
Using OpenScript control structures

A control structure is a group of statements that runs under particular circumstances, such as when handling a message, looping (repeating) a block of statements, or testing a condition. The OpenScript control structures are shown below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looping</td>
<td>step</td>
<td>Repeats a fixed number of times</td>
</tr>
<tr>
<td></td>
<td>do/until</td>
<td>Repeats until a condition is met; always executed at least once</td>
</tr>
<tr>
<td></td>
<td>while</td>
<td>Repeats while a condition is true</td>
</tr>
<tr>
<td>Establishing conditions</td>
<td>if/then/else</td>
<td>Executes statements if a condition is true; else branch optional</td>
</tr>
<tr>
<td></td>
<td>conditions</td>
<td>Executes one from a set of mutually exclusive choices</td>
</tr>
<tr>
<td>Handling messages</td>
<td>to handle</td>
<td>-reacts to a system or user message</td>
</tr>
<tr>
<td>Creating properties and user-defined functions</td>
<td>to set</td>
<td>Defines a script to create or calculate a value for a property or user-defined function</td>
</tr>
<tr>
<td></td>
<td>to get</td>
<td>Defines a script to return the value of a user-defined function or calculated user property</td>
</tr>
</tbody>
</table>

(continued)
OpenScript control structures, continued

<table>
<thead>
<tr>
<th>Type</th>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting target</td>
<td>in &lt;viewer&gt;</td>
<td>Temporarily makes a viewer window the target window for running scripts</td>
</tr>
<tr>
<td>window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printing</td>
<td>start spooler</td>
<td>Routes subsequent print commandsto the current print device</td>
</tr>
<tr>
<td>(spooling)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linking DLLs</td>
<td>linkDLL</td>
<td>Declares functions from a DLL to be called</td>
</tr>
<tr>
<td>Windows message</td>
<td>translateWindowMessage32</td>
<td>Establishes handling of Windows-to-OpenScript message translation</td>
</tr>
</tbody>
</table>

You always begin a control structure with one of the control structures from the table, and close with the word end. The only exception is do, which ends with until <expression>. In between you can put any number of OpenScript statements. You can repeat the name of the control structure after end to make it easier to see where a specific control structure ends, as in this example:

```
step ctr from 1 to pageCount of this book
  flip
end step
```

Examples of control structures

The most common control structures, such as to handle and if/then/else, are extensively illustrated throughout the documentation. This section shows you how to use some of the less common
control structures, such as conditions, do/until, in <viewer>, linkDLL, and while.

For details about to set and to get handlers, see Chapter 5, “Handling messages, events, objects, and properties.” For details about user-defined functions, see “Creating user-defined functions” later in this chapter. For details about translating Windows messages, see Chapter 13, “Using dynamic-link libraries.”

**Looping and testing conditions**

Use a looping control structure to repeat a series of statements. The while control structure tests at the beginning of the loop. By contrast, the do control structure tests at the end, so the loop always executes at least one time. Use the step control structure when you know in advance how many times you want to repeat the statements.

--Uses the while control structure to get just the file name
--from a string that contains a path plus the file name
to get nameOnly fFile
  vOffset = offset("\", fFile)
  while vOffset > 0
    clear chars 1 to vOffset of fFile
    vOffset = offset("\", fFile)
  end while
  return fFile
  --Repeats control structure name for clarity
end nameOnly

--Uses the do control structure to display the cursor
--position in the status bar at Reader level
to handle buttonClick
  if visible of statusBar is false then
    show statusBar

(continued)
do
  caption of statusBar = mousePosition of this window
  until keyState(keyLeftButton) is up
end buttonClick

There are two ways to test conditions in OpenScript. For a simple
test, use if/then, adding an else branch if you want to explicitly define
the statements that should execute otherwise. To test for one of a
series of mutually exclusive possibilities, use the conditions/when/
else control structure. ToolBook tests each condition in turn,
executing the statements that follow the first condition that is true.
As with an if/then control structure, you can add an else branch to the
conditions to indicate the statements that should execute otherwise.

--Uses the conditions control structure to test for several
--possible user responses
to handle buttonClick
  request "Do you want to proceed?" with "Continue" or "Quit"
  or "Restart"
  conditions
    when It is "Continue"
      request "You chose Continue"
    when It is "Quit"
      request "You chose Quit"
    when It is "Restart"
      request "You chose Restart"
    else
      request "You closed without choosing anything"
  end conditions
end buttonClick
Setting the target window

If you are running a script in one viewer but want to affect objects in another, you can use the `in` control structure to temporarily make the second viewer the target window. The statements inside the control structure then run as if they were running in the second viewer, and implicit object references and the generic references `this` and `my` refer to the second viewer. For example, you can use `in` if you want a user to click a button in the current viewer to navigate to a particular page in another viewer.

```plaintext
to handle buttonClick
    show viewer "Topics"
    in viewer "Topics"
        currentPage = "Contents"
    end in
end buttonClick
```

Spooling

Use the `start spooler` control structure to initialize the print spooler. The `print` and `print eject` commands work within this control structure only, and so you must use it to print from a script. For example:

```plaintext
to handle buttonClick
    start spooler --Encloses print statements
    print all pages
    end spooler
end buttonClick
```
Linking to DLLs

You use the linkDLL control structure to initialize and declare a link to a DLL.

```plaintext
-- Link a DLL to call a function that returns a file size
to handle buttonClick
  linkDLL "draw.dll"
    LONG getPenSize(STRING)
  end linkDLL
  request getPenSize("blue")
end buttonClick
```

To determine if a DLL is already linked, you can check the value of the system property sysLinkedDLLs, which contains a list of the DLLs currently linked. For details about linking DLLs, see Chapter 13, “Using dynamic-link libraries.”

Nesting control structures

You can nest all control structures within other control structures; however, you cannot put a start spooler control structure within another start spooler structure. You can nest control structures any number of levels deep.

Interrupting control structures

To interrupt or modify the flow of a control structure, use break and continue inside the structure. Use the break statement to quit a handler without finishing all of the statements in it, or in loops to quit the loop early, such as when an error is detected.

If you use break to quit the handler, control returns to whatever pro-
cess called the current handler. The break to system statement stops execution of all handlers currently running, including any that called the current handler. The following handler uses the break statement to prevent the handler from completing and exiting ToolBook:

to handle buttonClick
  request "Do you want to quit?" with "Continue" or "Quit"
  if It is "Continue" then
    request "You have elected to continue."
    break --Quits handler
  end if
  save changes to this book
  send exit --Exits from ToolBook
end buttonClick

To use break to quit a control structure within a handler (such as step or do), include the name of the control structure after the word break. For example:

step i from 1 to 1000
  --Checks room available on page
  if percentFreeSpace of this page < 10 then
    break step
  else
    ...
  end if --Further statements here
end step --Handler resumes here after break statement

The continue statement is used to skip statements in a control structure (most often step or do/until) and continue directly to the next iteration. For example:

--This handler counts the objects on a page that are not buttons
to handle buttonClick
vTotalItems = 0
--Gets a list of all the objects on the page
itemList = objects of this page
step i from 1 to itemCount(itemList)
  --Gets the next object from the list of objects
  pop itemList
  --Tests to see if the current item is a button
  if object of It is "button" then
    --Skips to the "end step" statement
    continue
  end if
  --Otherwise increments the total object count
  increment vTotalItems
end step
request "total items = " & vTotalItems
end buttonClick

Using functions

Functions are procedures that you use in your script to calculate a value or perform an operation. ToolBook has over 200 built-in functions for arithmetic, statistics, string handling, financial calculations, and other purposes. For example:

--The function "textlineCount" returns the number of lines in a field
headCount = textlineCount(text of field "Attendees")

--The function "keyState" returns "up" or "down" for the
--key value that you request
if keyState(keyShift) is down then
  ...
  --Further statements here
end

For more information on functions, refer to the OpenScript reference
You can also write your own user-defined functions. For details, see “Creating user-defined functions” later in this chapter.

Using parameters

When you call a function, you include parameters for the values used to calculate the return value. For example, the variable vName is the parameter for the uppercase function in this script fragment:

```
vName = "Mary Jones"
get uppercase(vName) —Puts MARY JONES into It
```

Note that the variable vName still contains the mixed-case “Mary Jones” text.

Except for array parameters that use the by reference special term, OpenScript passes parameters by value, copying the value when you pass it in a function. The values of the parameters in the calling handler do not change.

Passing parameters by value can use up a lot of memory, especially when the variable is a large array. This is because ToolBook makes a copy of the variable to use within the function. If you want to pass variables by reference that are not arrays, you must allocate memory and pass a pointer to the memory as a parameter to your function.

For details about using DLL functions, see Chapter 13, “Using dynamic-link libraries.”

For information on passing arrays by reference, see the entry for by reference in the Openscript reference in online Help.
Creating user-defined functions

A user-defined function is a handler you write that calculates a value or runs a procedure and then returns a result. For example, to calculate the same value often, such as cost of goods, you can write the calculation as a user-defined function, and then call the function as needed. User-defined functions are particularly useful when the calculation is complex or when you need to perform the same calculation in different applications.

You can use user-defined functions anywhere that you can use built-in functions. To create a user-defined function, write a to get handler. The handler returns the calculated value using the return statement. For example:

```plaintext
--Defines function name and parameters
to get grossMargin Sales, COGS

--Calculates and returns the results to the calling handler
return Sales - COGS
end
```

You can use several statements of varying kind in a to get handler—commands, messages sent to run other handlers, or other function calls. The to get handler must include a return statement that specifies the value to be returned. The return statement acts as a break for the function—no statements following a return statement are executed.
Naming user-defined functions

You can assign a name to a user-defined function that is similar to (but not exactly like) the name of a built-in function. Names you assign to a user-defined function:

◆ must begin with a letter, an underscore character (_), or a prefix symbol, such as the at symbol (@).
◆ cannot contain spaces or any characters other than letters, numbers, the underscore character, or the prefix symbol.

The following example uses the at symbol (@) to distinguish a user-defined function from a built-in function.

--Calls the built-in function named average
request average(1,2,3,4,5)

--Calls the user-defined function named average
request @average(1,2,3,4,5)

Placing user-defined functions in the object hierarchy

You can place a to get handler anywhere in the object hierarchy. However, it’s good practice to define user-defined functions in the book script because it makes the scripts easier to maintain. If you define functions in the book script of a system book, you can use them with any application and avoid repeating the function definitions in other books. However, the slight overhead of searching up the hierarchy for the function might affect the performance of an application.
Calling user-defined functions

After you define a function, you can call it from any handler the same way you call a built-in function. ToolBook searches the hierarchy for to get handlers as for any message handlers. The following example calls the user-defined function grossMargin( ) created earlier:

to handle buttonClick
  local vSales, vCOGS
  vSales = text of field "Total Sales"
  vCOGS = text of field "Unit Cost" + text of field "Overhead"
  text of field "Gross Margin" of page 3 = grossMargin(vSales, vCOGS)
end

Creating expressions with operators

An expression is any combination of a formula, calculation, comparison, or set of values that results in a single value. You create an expression by linking its elements with an operator, which is a word or symbol that indicates the operation to be performed. For example:

--Multiplies two values
subTotal = vItems * vQty

--Joins three strings into one
greeting = "Dear" && title && lastName

--Divides the values of two functions
average = sum(allItems) / itemCount(allItems)

--Compares two values
if text of field "Amount" > vLimit then …

You can compose expressions from any combination of object references, properties, references to strings or to variables, numbers,
literal values, and other expressions, including:

- **containers** Anything that holds a value, such as variables, properties, the text of a field, or the Command window.

- **functions** References that call a predefined operation and return a value. For details, see “Using functions” earlier in this chapter.

- **literal values** Values entered character by character in a statement. For example:

  text of field "Zip" = "Please enter a 9-digit zip code."

- **constants** Specific values referred to by name, such as pi, which refers to the value 3.141592653589793.

- **expressions with operators** A combination of operators and operands that results in a value. For example:

  - Results in 250 if the current value of svCost is 100
    100 + svCost + 50

- **expressions with strings** References to parts of strings. For example, if the text of field ABC contains *primary colors*, then the following statement refers to the value *primary*:

  word 1 of text of field "ABC"

The value returned by an expression can be a number, character string, or logical value (*true* or *false*).
Operators in ToolBook

You can create expressions using four types of operators: arithmetic, logical, string, or bitwise, as shown in the following tables.

**Arithmetic operators**

Use arithmetic operators to create mathematical expressions.

**Operators for arithmetic expressions**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition. For example: It = 25.3 + vFirst --Puts result into It</td>
</tr>
<tr>
<td>–</td>
<td>Subtraction. For example: It = 25 - 4 --Puts 21 into It</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication. For example: It = 25 * 4 --Puts 100 into It</td>
</tr>
<tr>
<td>/</td>
<td>Division. For example: It = 25 / 4 --Puts 6.25 into It</td>
</tr>
<tr>
<td>div</td>
<td>Division (returns only the integer). For example: It = 25 div 4.5 --Puts 5 into It</td>
</tr>
<tr>
<td>–</td>
<td>Negation. For example: It = -4 + 25 --Puts 21 into It</td>
</tr>
<tr>
<td>^</td>
<td>Exponentiation. For example: It = 2 ^ 4 --Puts 16 into It</td>
</tr>
<tr>
<td>mod</td>
<td>Modulo (returns the remainder). For example: It = 16 mod 5.0 --Puts 1 into It</td>
</tr>
</tbody>
</table>
**Logical operators**

Use a logical operator to evaluate two expressions and return *true* or *false*. Expressions containing dates, currency, or other formatted data can be compared as `<type>` to force ToolBook to convert the data in the comparison to the appropriate format first.

**Operators for logical comparisons**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>= or is</td>
<td>Equal. <em>True</em> if both expressions have same value. For example: &lt;br&gt;It = (25=4) --Puts false into It &lt;br&gt;if color is blue then &lt;br&gt;color = red &lt;br&gt;end</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than. <em>True</em> if expression on left is less than expression on right. For example: &lt;br&gt;if balance &lt; lowLimit then &lt;br&gt;text of field &quot;odWarning&quot; = &quot;Overdraft&quot; &lt;br&gt;end</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to. <em>True</em> if expression on left is less than or equal to expression on right. For example: &lt;br&gt;if text of field &quot;Date&quot; &lt;= sysDate as date &lt;br&gt;request &quot;Too early to process&quot; &lt;br&gt;end</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than. <em>True</em> if expression on left is greater than expression on right. For example: &lt;br&gt;get 25 &gt; 4 --Puts true into It</td>
</tr>
<tr>
<td>Operator</td>
<td>Meaning</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
</tr>
<tr>
<td><code>&gt;=</code></td>
<td>Greater than or equal to. True if expression on left is greater than or equal to expression on right. For example: if vFirst &gt;= vLast then request &quot;Last item is less than first.&quot; end</td>
</tr>
<tr>
<td><code>&lt;&gt;</code> or <code>not</code></td>
<td>Not equal to. True if two expressions are different. For example: if svText &lt;&gt; text of field &quot;Text&quot; then text of field &quot;Text&quot; = svText end</td>
</tr>
<tr>
<td><code>and</code></td>
<td>Boolean And. True if both expressions are true. For example: if text of field &quot;input&quot; &gt; &quot;01/01/94&quot; as date and text of field &quot;refAmount&quot; &lt; 25 then request &quot;The expression is true.&quot; end</td>
</tr>
<tr>
<td><code>or</code></td>
<td>Boolean Or. True if either expression is true. For example: if interest &gt; 10.5 or interest &lt; 9.5 then request &quot;Interest rate is out of range.&quot; end</td>
</tr>
<tr>
<td><code>contains</code></td>
<td>String search. True if expression on right is found in expression on left. For example: if text of field &quot;emperors&quot; contains &quot;Roman&quot; then go to book &quot;c:\lessons\roman.tbk&quot; end</td>
</tr>
</tbody>
</table>

(continued)
<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| **is in** | String search. True if expression on left is found in expression on right. For example:  
  if nameOnly(vName) is in text of field "chooseIndex"  
  request "That index is already open."
| **is not in** | String search. True if expression on left is not found in expression on right. For example:  
  if "Nero" is not in vAnswerText  
  request "Please try again."
| **not** | Not. True if expression on right is false; false if expression on right is true. For example:  
  if not captionShown of mainWindow  
  request "Do you want to personalize this book?"  
  with "Yes" and "No"  
  if it is "Yes"  
  send personalize -User-defined message  
  end if

String comparisons are not case-sensitive, so b is equal to B. If you want to compare values by case, first use the *charToAnsil()* function to convert the values to their ANSI equivalents. The following is a user-defined function that performs a case-sensitive...
comparison on two strings:

to get compareCase string1, string2
    --If a case-insensitive check fails, the strings are different
    if string1 <> string2 then
        return false --Return to calling handler
    end if
    --Compare character-by-character
    step ctr from 1 to charCount(string1)
        if charToAnsi(char ctr of string1) <> \n            charToAnsi(char ctr of string2) then
            return false --Return to calling handler
        end if
    end step
    return true
end compareCase

Text values in comparison expressions are converted to uppercase and then compared according to their position in the ANSI character set. For as <type> comparisons, expressions are compared according to the current values of sysNumberFormat, sysDateFormat, and sysTimeFormat as required by the context.

For details about formats for <type> comparisons, refer to the “format” topic in online Help.
String operators

Use string operators to concatenate (join) two strings into a longer one, or to extract substrings from larger strings. For details about handling text strings, see Chapter 7, “Using variables, values, and text.”

Operators for string evaluations

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;</td>
<td>Concatenates two expressions with no space between them. For example: push (bookPath &amp; &quot;mysysbook.sbk&quot;) onto sysBooks</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>Concatenates two expressions with a space between them. For example: request &quot;The&quot; &amp;&amp; &quot;End&quot; --Displays &quot;The End&quot;</td>
</tr>
<tr>
<td>char(s) or character(s)</td>
<td>One or more contiguous characters of text, including letters, numbers, spaces, punctuation marks, tabs, and other special characters. For example: if char 1 of userResponse is “Y” then send exit end vFirst3 = chars 1 to 3 of fullName</td>
</tr>
<tr>
<td>word or words</td>
<td>One or more contiguous sequences of printable characters separated on each side by a space or a nonprintable character, or by the beginning or end of the expression that includes the word. For example: surname = last word of text of field “FullName”</td>
</tr>
<tr>
<td>item or items</td>
<td>One or more contiguous values in a comma-separated list. For example: xPosition = item 1 of mousePosition of this window yPosition = item 2 of mousePosition of this window</td>
</tr>
</tbody>
</table>
### Operators for string evaluations, continued

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| `textline` or `textlines` | A string of zero or more characters that ends with a carriage return/linefeed (CRLF), or two or more strings separated with CRLFs. For example:  
  ```plaintext
  allLines = text of field "listbox1"
  step ctr from 1 to textLineCount(allLines)
  request textline ctr of allLines
  end
  ``` |

### Bitwise operators

Bitwise operators allow you to perform binary operations on individual bits. They are most useful when you need to read or set the value of a specific bit in a parameter for a DLL function. For example, many Windows DLLs return a single value in which each individual bit designates a particular value. Use numbers to represent the values for bitwise operators.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| `bitAnd` | Performs a bitwise AND operation on two numbers. For example:  
  ```plaintext
  - Displays 2 (binary 11 AND 10 yields 10) 
  ``` |
request 3 bitAnd 2

*bitOr*
Performs a bitwise inclusive OR operation on two numbers. For example:
--Displays 3 (binary 01 OR 10 yields 11)
request 1 bitOr 2

request 3 bitXOr 2

*bitXOr*
Performs a bitwise exclusive OR operation on two numbers. For example:
--Displays 1 (binary 11 XOR 10 yields 01)
request 3 bitXOr 2

*bitNot*
Converts all bits to their opposite values (performs a one’s complement of a number). For example:
--Displays -2 (binary 00000001 NOT yields 11111110)
request bitNot 1

request 144 bitShiftRight 3

*bitShiftRight*
Performs a bitwise shift to the right on a number by a specified number of bits. For example:
--Puts 18 into it (144/2^3)
get 144 bitShiftRight 3 --(10010000 yields 10010)

request 4 bitShiftLeft 3

*bitShiftLeft*
Performs a bitwise shift to the left on a number by a specified number of bits. For example:
--Puts 32 into it (4*2^3)
get 4 bitShiftLeft 3 --(100 becomes 100000)
As an example, the following program calls the DLL function
GetFlags() and uses bitwise operators to determine the type of pro-
cessor in the computer:

to get pType
  local dword Flags
  local retval
  linkDLL "FLAGS.DLL"
  DWORD GetFlags()
  end
  Flags = GetFlags()
  conditions
    when Flags bitAnd 2 <> 0
      retval = "286"
    when Flags bitAnd 4 <> 0
      retval = "386"
    when Flags bitAnd 8 <> 0
      retval = "486"
  end
  return retval
end

The argument operator

You can use a special OpenScript operator called argument to get
the value of a parameter passed to the currently executing handler.
A parameter can consist of more than one item, so argument n and
item n of argList (where n <= the value of argCount) can return
different values.

--Puts value of the 3rd parameter passed into a field
text of field "Name" = argument 3
Precedence of operators

ToolBook evaluates expressions according to the predefined operator precedence shown in the following table. Operators of equivalent precedence are evaluated left-to-right except for the exponentiation expressions, which are evaluated right-to-left. You can force ToolBook to change operator precedence by using parentheses around any expression.

**Operator precedence in OpenScript**

<table>
<thead>
<tr>
<th>Order</th>
<th>Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>()</td>
</tr>
<tr>
<td>1</td>
<td>not, argument, – (negation)</td>
</tr>
<tr>
<td>2</td>
<td>character, word, item, textline (string operators)</td>
</tr>
<tr>
<td>3</td>
<td>bitNot</td>
</tr>
<tr>
<td>4</td>
<td>bitShiftLeft, bitShiftRight</td>
</tr>
<tr>
<td>5</td>
<td>bitAnd</td>
</tr>
<tr>
<td>6</td>
<td>bitOr, bitXOr</td>
</tr>
<tr>
<td>7</td>
<td>^ (exponentiation)</td>
</tr>
<tr>
<td>8</td>
<td>*, /, div, mod</td>
</tr>
<tr>
<td>9</td>
<td>+, – (subtraction)</td>
</tr>
<tr>
<td>10</td>
<td>&amp;, &amp;&amp;</td>
</tr>
<tr>
<td>11</td>
<td>is in, is not in, contains</td>
</tr>
<tr>
<td>12</td>
<td>&lt;, &gt;, &lt;=, &gt;=, =, &lt;&gt; is, is not</td>
</tr>
<tr>
<td>13</td>
<td>and</td>
</tr>
<tr>
<td>14</td>
<td>or</td>
</tr>
</tbody>
</table>
Examples of operator precedence

<table>
<thead>
<tr>
<th>Example</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>request 1 + 20 / 5 * 40 + 2</td>
<td>163</td>
</tr>
<tr>
<td>request (1+20) / (5 * (40 + 2))</td>
<td>.1</td>
</tr>
<tr>
<td>request 3^2*2</td>
<td>18</td>
</tr>
<tr>
<td>request 3*(2*2)+10</td>
<td>91</td>
</tr>
<tr>
<td>request characters 1 to 2 of 1000 + 2000</td>
<td>2010</td>
</tr>
<tr>
<td>request characters 1 to 2 of (1000 + 2000)</td>
<td>30</td>
</tr>
<tr>
<td>request 1 + 1 &amp; 2</td>
<td>22</td>
</tr>
<tr>
<td>request 1 + (1 &amp; 2)</td>
<td>13</td>
</tr>
</tbody>
</table>
Chapter 7

Using variables, values, and text

This chapter describes how you can use individual components of OpenScript programs, including variables, constants, and literal values, and discusses how to use text in your scripts.

Using variables ............................................. 111
Assigning data types to variables ..................... 115
Using arrays .................................................... 119
Working with literal values ............................... 126
Working with constants ................................. 132
Working with character strings ....................... 134
Working with lists ............................................ 139
Referring to colors ........................................... 141
Using variables

A variable is a container you define in a script to store data temporarily. Use a variable any time you are working with data that might change each time you run the script, as this example shows:

```plaintext
to handle buttonClick
    vYearOfBirth = text of field "birthYear" --Stores a property value
    vThisYear = "94" --Stores a literal value
    vAge = vThisYear - vYearOfBirth --Stores a result
    request "This year you will be" && vAge && "years old."
end
```

Variables in OpenScript are like variables in other programming languages, with these exceptions:

- You can declare variables with or without a data type.
- A variable declared without a data type can contain numeric, logical, string, and other values such as dates and times.
- With the exception of arrays, you do not need to declare local variables before you assign a value to them.
- You can define variables as global or local using the local or system lay words.

You can declare variables to be arrays in OpenScript. For details, see “Using arrays” later in this chapter.

Rules for naming variables

When you name a variable, the name:

- must begin with a letter or underscore.
- can contain only alphanumeric characters, underscores, and the at symbol (@) as a prefix.
cannot be an OpenScript keyword (for example, request or fillColor).

To distinguish names of variables from names of properties and OpenScript keywords, use a prefix such as v (variable) or sv (system variable), or use the reserved prefix @:

```
local vTotal --Uses "v" to mark local variable
system svVarName --Uses "sv" to mark system variable
@text = text of field "name" --Uses "@" as prefix to distinguish variable from a property
```

**Note** OpenScript is not case-sensitive, and so the variable names vStudentName and vstudentname are the same.

**Assigning values to variables**

Use set, put, or an equal sign (=) to assign a value to a variable; these commands have the same effect. You can put up to 64 KB of data into a single variable.

If the value is text and has a space in it, you must enclose the text in quotation marks. Your script will work more efficiently if you enclose all text values in quotation marks.

```
firstPlayer = text of field "Player1"
set PrimaryColors to "red,blue,green"
put "$1,000 cash" into prizeMoney --Contains space, requires quotation marks
```

**Using local and system variables**

You can use both local and system variables in handlers. A local variable keeps the value you put into it for the duration of the
handler. A system variable retains its value for the duration of the ToolBook instance. Use a system variable for information that needs to be available to more than one handler—for example, a user’s name, the last keystroke entered, or the value of a property before you change it.

**Note** You must declare system variables in every handler or function that uses them.

### Creating local variables

You do not have to declare local variables; when you assign the first value to a variable, ToolBook both declares and initializes the variable. There is a `local` statement to declare local variables, but it is used primarily to assign data types to variables.

**Tip** To share local variable values between handlers, pass them as parameters.

### Creating system variables

To create a system variable, declare it with the `system` statement. For example, the following `enterPage` handler uses a system variable to determine if the user is navigating to a page for the first time:

```plaintext
to handle enterPage
  system svFirstTime -- Declares a system variable
  if svFirstTime = null then -- Null if this is the first time
    vWelcomeText = "Welcome to the Tutorial."
    text of field "Banner" = vWelcomeText
    svFirstTime = false
  end if
  forward
end enterPage
```
To determine what system variables you have already declared, get the value of the system property `sysSystemVariables`, as in this example:

```
--Displays all current system variables
to handle buttonClick
  if itemCount(sysSystemVariables) > 0
    step ctr from 1 to itemCount(sysSystemVariables)
      request item ctr of sysSystemVariables
    end step
  end if
end buttonClick
```

**Tip** You can also maintain global values in user properties. User properties take less memory and are saved with the book.

**Using reserved variables**

ToolBook maintains certain variables, such as `It`, `argList`, and `argCount`, into which it puts the results of a statement or information about the current handler. You can use the following variables in your scripts. All are treated as local variables within a handler:

- A number of statements, including `ask`, `get`, `pop`, `request`, and `set`, put the results of their actions into the variable `It`. Be sure to copy the value of `It` to another container if you need the value for more than one statement.

- The variable `argList` contains the parameters passed to the current handler. You cannot change the value of this variable.

- The variable `argCount` contains a count of the number of values passed as parameters to the current handler. You cannot change the value of this variable.

For example, in the following handler, the `request` statement returns a user response in the variable `It`. The variable `argList` returns a
Assigning data types to variables

A data type is a format you assign to a variable when you first declare it, such as integer, text, real number, and so on. Assigning data types to variables often makes handlers run faster and use less memory because data is already in the internal (binary) form that ToolBook requires, and in its most efficient format. Assigning a data type to a variable also helps prevent errors because you cannot assign inappropriate data to the variable.

To declare a data type, use the statements local or system with a data type before referencing the variable:

```plaintext
local LONG i
system INT pagesDisplayed, pagesLeft
local COLOR oldFillColor
```

If you do not declare a data type for a variable, ToolBook selects a data type appropriate to the statement in which the variable first appears. ToolBook can change the data type in subsequent statements as necessary, but this can slow your scripts down. If you do declare a data type for a variable, ToolBook assigns the appropriate data type to the variable when you compile the script. When the
handler is running, ToolBook checks that only the correct type of data is assigned to the variable; if not, an error message displays.

**OpenScript data types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>int</td>
<td>16-bit signed integer, range -32768 to 32767</td>
</tr>
<tr>
<td>long</td>
<td>32-bit signed integer, range -2147483648 to 2147483647</td>
</tr>
<tr>
<td>real</td>
<td>64-bit floating point number; ToolBook will accept a long value; all numeric functions and operators that accept real numbers use this type internally</td>
</tr>
<tr>
<td>word</td>
<td>16-bit unsigned integer, range 0 to 65535</td>
</tr>
<tr>
<td>dword</td>
<td>32-bit unsigned integer, range 0 to 4294967295</td>
</tr>
<tr>
<td>string</td>
<td>Character string (Avoid assigning string to data that is more efficiently represented by a different type.)</td>
</tr>
<tr>
<td>logical</td>
<td>True or false</td>
</tr>
<tr>
<td>point</td>
<td>x, y; where x and y are integers (a list of two location values)</td>
</tr>
<tr>
<td>color</td>
<td>List of three non-negative numbers in HLS units</td>
</tr>
<tr>
<td>stack</td>
<td>List of comma-separated items</td>
</tr>
<tr>
<td>date</td>
<td>Date in system format</td>
</tr>
<tr>
<td>time</td>
<td>Time in system format</td>
</tr>
<tr>
<td>page</td>
<td>Explicit reference to a page</td>
</tr>
<tr>
<td>background</td>
<td>Explicit reference to a background</td>
</tr>
<tr>
<td>layer</td>
<td>Explicit reference to a page or background</td>
</tr>
<tr>
<td>graphic</td>
<td>Explicit reference to an object on a page or background</td>
</tr>
<tr>
<td>field</td>
<td>Explicit reference to a field, record field, or combo box</td>
</tr>
<tr>
<td>object</td>
<td>Explicit reference to a book, page, background, object, or graphic</td>
</tr>
<tr>
<td>book</td>
<td>Explicit reference to a book path</td>
</tr>
</tbody>
</table>
**Tip** Use the function `isType()` to determine whether data matches a particular data type. For example:

```plaintext
ask "Enter starting date for report:"
if isType(date, It) then
  vStartDate = It
else
  request "Please enter a date."
end
```

ToolBook initializes the value of an untyped variable or array to `null` when it is declared. ToolBook initializes the value of a typed variable differently depending on the data type, as the following table shows.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Initial value</th>
</tr>
</thead>
<tbody>
<tr>
<td>dword, int, long, real, word</td>
<td>0</td>
</tr>
<tr>
<td>logical</td>
<td>false</td>
</tr>
<tr>
<td>point</td>
<td>0,0</td>
</tr>
<tr>
<td>color</td>
<td>0,0,0</td>
</tr>
<tr>
<td>stack, string</td>
<td>null</td>
</tr>
<tr>
<td>All other types</td>
<td>Consider uninitialized</td>
</tr>
</tbody>
</table>
Choosing the appropriate data type

Your application will run more efficiently if you assign a data type appropriate to how the variable will be used. For example, using the data type string for a logical value uses more memory than necessary. Similarly, using the data type string for a counter in a step statement forces ToolBook to convert the data from a string to a numeric value with each iteration of the loop. The following table shows operations that function most efficiently when you use the suggested data type.

Recommended data types for operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric operations</td>
<td>real</td>
</tr>
<tr>
<td>Text operations</td>
<td>word</td>
</tr>
<tr>
<td>Logical operations</td>
<td>logical</td>
</tr>
<tr>
<td>Step loops</td>
<td>long</td>
</tr>
</tbody>
</table>

Declaring data types for system variables

You can declare a different data type for system variables in different handlers. When you assign a value to the variable, ToolBook converts the data to the appropriate type if possible. Because of this conversion, system variables are slightly less efficient than local variables. Any reference to the variable assumes that the value is of the declared type.
Declaring data types for parameters

If you pass a typed variable as a parameter to another handler, you can declare the data type of parameters in a to handle statement. This results in greater efficiency and type-checking of data passed into a handler. For example:

to handle buttonClick point loc, logical isShift, logical isCtrl
    ...
    --Further statements here
end

Using arrays

An array is a variable configured to work like a list or table of individual elements. For example, if you create a game and want to store the names of the 10 highest-scoring players, it is easier to have a single variable called hiScorers with 10 elements in it than it is to have 10 individual variables called hiScorer1, hiScorer2, hiScorer3, and so on. Or, if you are writing an application to take concert bookings for an auditorium, you can use an array to treat the concert hall as a matrix of rows and seats. Using arrays can help you create smaller and simpler code because arrays organize information accurately and systematically.
You can create one-dimensional arrays and multidimensional arrays of up to 16 dimensions. You can create arrays with a fixed size or size them dynamically as you add and remove elements. In general, use a dynamic array if you do not know in advance how many elements you require, or if the size of the array will change over time. You can have both fixed and dynamic arrays in a single handler, but you cannot mix fixed and dynamic dimensions in the same array. For example, you cannot use the following line of code:

```javascript
local logical seat[32][ ]
```

Handlers often run faster if you use fixed rather than dynamic arrays. However, because dynamic arrays do not claim a predefined
amount of memory, they sometimes work better under low memory conditions.

**Declaring an array**

To declare an array, indicate the dimensions of the array in the *local* or *system* statement. To declare an array that is dynamically sized, use null values for the number of elements. ToolBook generally runs faster if you assign a data type to the array.

```plaintext
local hiScorer[10] --Declares array of 10 elements only
local logical seats[32][80] --Declares fixed-size array, 32 rows by 80
                   --columns; each element is true or false
system users[]       --Declares 1-dimensional dynamic array
local playerScores[][] --Declares 2-dimensional dynamic array
```

The index number of an array begins at one (not zero, as in some systems).

**Setting and getting values in arrays**

You can assign values to elements of an array and read their values as you would any other variable:

```plaintext
auditorium[3][16] = true          --Fills one element of the array
if auditorium[5][10] is true
   request "That seat is booked."
end
```

To quickly assign values to all elements at once, use the *fill* command, which assigns a single value to the entire array, or assigns elements one-by-one. If you assign a data type to the array, be sure that the data type of the *fill* expression matches the array's.
For example:

```plaintext
local int barrel[5]
fill barrel with 4 --Assigns the value of 4 to all 5 elements
--of array “barrel”
```

You can also use `in ... order` with the `fill` command to assign individual units of text—lines, items, words, or characters—to elements in an array. For example, the `fill` statement in the following example assigns each line of a field to an element in an array:

```plaintext
local vHiScorers[]
fill vHiScorers with text of field “hiScore” in [textline] order
```

**Figure 2 Assigning text to an array**

You can use up to four text operators (*char, item, textline, and word*) to subdivide text. Each operator you specify breaks the text into smaller components and assigns them to another dimension of the array. The number of text operators you use must match the array’s dimensions, and the array must be large enough to accept all text components, or ToolBook displays an error message. If the array is larger than the number of text components, the `fill` command leaves the existing contents of the unused elements as they were.
For example, if you are filling a two-dimensional array, you can assign text lines to one dimension and words to another. The following example script results in the array illustrated in Figure 3:

```plaintext
sampleText = "To be or not to be," & CRLF & "that is the question"
local myArray[2][6]
fill myArray with sampleText in [textline][word] order
```

![Figure 3](image.png)

**Assigning text units to an array in textline and word order**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[1] To be or not to be,</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[2] that is the question</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can assign the elements of one array to another using the equal sign or the *set* or *put* command. The arrays must match in dimension and data type.

```plaintext
local array1[100]
local array2[100]
fill array1 with "a"  --Puts "a" into all elements of array1
array2 = array1  --Puts contents of array1 into array2
```

You cannot assign an array to a container that is not an array. For example, you cannot assign an array to the Command window.

**Sizing arrays**

When you declare an array, keep the following in mind:

- You can declare up to 65,536 elements in each dimension.
- An array can have up to 16 dimensions.
Array size is limited by only the amount of available memory.

**Getting an array's size**

To determine an array's dimensions, use the `dimensions` function. Knowing an array's dimensions is useful if you need to step through the array element by element. For example:

```plaintext
-- Use the value of "dimensions" to set a multiple dimension array
local myArray [5][4][3][2]
vMyDimensions = dimensions(myArray) -- vMyDimensions contains "5,4,3,2"
-- Copies all the elements of an array into a text field with
-- CRLF between elements
to get arrayToTextlines pArray[]
  local vTextlines
  get dimensions(pArray) -- Puts the size of the array into It
  step i from 1 to It
    textline i of vTextlines = pArray[i]
  end step
  return vTextlines
end arrayToTextlines
```

**Passing arrays as parameters**

You can pass an array variable as a parameter, as long as the called handler is written to accept an array for that parameter. To pass an array as a parameter, specify it the same way you would any variable. For example:
local vAlphabet[26]
get sortArray(vAlphabet)

In the called handler, you indicate an array by including a set of
brackets for each dimension in the handler's opening statement.
However, when working with dynamic arrays, you do not need to
indicate the size of each dimension, only the number of dimensions,
as in the following example:

--This handler accepts two arrays
to handle modifyArrays array1[], array2[][]

In the following example, a dynamic array is passed as a parameter,
modified, and passed back to the original routine.

--This is the calling handler
to handle buttonClick
do local vAlphabet[]
   local vInvertedAlphabet[]
   --(fill vAlphabet [] here)
   vInvertedAlphabet = invertArray ( vAlphabet )
   --(further processing here)
done

--The called handler flips the array upside down;
--the array must be declared in the parameter list
to get invertArray fixed vPassedArray[]
--A second array used temporarily in this handler
do local vTempArray[]
   myDim = dimensions(vPassedArray)
   step i from 1 to myDim
   --Inverts highest and lowest index numbers
   end
index = \text{abs}((i-myDim)-1)
\text{vTempArray}[\text{index}] = \text{vPassedArray}[i]
end step
return \text{vTempArray}
end invertArray

\textbf{Note} By default, arrays are passed by value, which means that ToolBook makes a copy of the array and any changes you make are not reflected in the calling handler. However, with arrays you can use the \textit{by reference} special term to indicate that ToolBook should pass only a pointer to the original array. This is faster and uses less memory, but if you change an array in a called handler, it is changed in the calling handler.

\textbf{Assigning arrays as user properties}

To preserve the values in an array between ToolBook sessions, you can assign them to user properties just as you can ordinary variables. You can retrieve an array stored in a user property by assigning it to an array of the same dimensions. For example:

\begin{verbatim}
myUserProp of this page = \text{vMyArray}
\text{vMyArray} = \text{myUserProp of this page}
\end{verbatim}

\textbf{Working with literal values}

A literal value is a value you assign to a variable or use in an expression. For example:

\begin{verbatim}
vStartingValue = 0 -- A value assigned to a variable
vGreeting = "Dear" && \text{vName} -- A literal value in an expression
\end{verbatim}
Assigning literal values to variables with data types

If you assign a literal value to a variable that has been declared with a data type, the literal value must match the data type for that variable. If you try to assign a value to a variable that does not match the data type of that variable, ToolBook will not compile the script. For example:

```plaintext
local int vHighScore  --Declares an integer type
vHighScore = "1000"    --Succeeds because "1000" is an integer
vHighScore = "abc"     --Will not compile, "abc" is not an integer
```

Assigning literal values to untyped variables

When you assign a value to a variable that was not declared with a data type, ToolBook determines the data type for the value based on how you are using the value. Depending on the context, ToolBook interprets a value as a string, numeric value, logical (Boolean) value, time, date, list, color, or point in page units or pixels. For example:

```plaintext
show group "palmTree" at "100,100"    --100,100 is a point in page units
text of field "Total" = sum(100,100)   --100,100 is a list
```

You can take advantage of the ToolBook ability to change the data type of a value as needed to use the same data in different ways. For example, you can use numbers as strings, as the following example shows:

```plaintext
vYear = 1957
request chars 3 to 4 of vYear       --Displays "57"
request vYear + 30                   --Displays "1987"
```
Specifying numeric values

When you specify numeric values, use only the following characters:

- Numeric characters 1, 2, 3, 4, 5, 6, 7, 8, 9, and 0
- Decimal sign defined by sysDecimal, such as a period or a comma
- Negative and positive operators (– and +)
- Scientific notation exponentiation symbol (E or e)
- Currency sign defined by sysCurrency, such as $
- Percent sign (%)

If you use any other characters, ToolBook treats the value as a string. For example, ToolBook considers dates in the format mm/dd/yy strings. If you include decimals when setting the value of a property that requires integers, ToolBook rounds to the nearest integer. For example, if you set an object’s layer property to 3.75, ToolBook rounds the number to 4.

Use the round() function to round a numeric value to a whole number or to a number with a specific number of decimal places. For example:

\[ x = 1.2345 / .333333 \]
\[ \text{request round}(x, -4) \quad \text{--Rounds result to 4 decimal places} \]

You can format numbers, dates, and times to display correct characters and to ensure that ToolBook recognizes the value as a number, date, or time. For details about formatting numbers, dates, and times, see Chapter 8, “Writing common scripts.”
Additional information is located in the online Help topics sysDateformat, sysNumberformat, and sysTimeformat.

**Specifying string values**

Use string values for text when (for example) you want to assign captions or text to objects. You can use any combination of characters for a string value, including alphabetic characters, numbers, punctuation, and spaces. If you use a string value that contains a space, you must enclose the value in quotation marks. However, even if the value does not contain a space, it’s wise to enclose it in quotation marks. ToolBook will run faster if it does not have to determine whether the literal value is actually a variable. In addition, you are less likely to cause bugs by accidentally using the name of an existing variable. For example:

```plaintext
--No space so quotation marks not essential
vMessage = Welcome

--Runs faster with quotation marks
vMessage = "Welcome"

--Requires quotation marks because of spaces
vMessage = "Welcome to the tutorial."
```

**Logical (Boolean) values**

Use true and false for logical (Boolean) values. Setting the value of an object property to true or false is often equivalent to turning an attribute on or off. For example:

```plaintext
sysUseWindowsColors = true
```
Specifying page units and pixels

You use page units and pixels to specify values for screen coordinates for different types of objects. Use page units with graphic objects to specify an object’s bounds and vertices, the location of an object relative to the upper-left corner of the page, or the destination or distance to move an object with the move command:

```
--Moves button down and right by 1 inch
move button ID 0 by 1440,1440
```

There are 1440 page units per inch, or about 57 per millimeter. However, the number of pixels per page unit depends on the display device. Use the system property sysPageUnitsPerPixel to determine how many page units there are per pixel for the current display device. To convert page units for different display devices, use the displayAspect() function.

Use pixels to specify the location or movement of viewers or palettes. For example:

```
--Sets maximum size of a viewer to 1/2 size of a VGA monitor
maximumSize of viewer "Index" = 320,240
```

If you include decimals when specifying page units or pixels, ToolBook rounds to the nearest integer.

Specifying hexadecimal, octal, and binary values

You can enter hex values using the prefix 0X (zero plus x, not case-sensitive), as in the following example:

```
to handle keyChar key
  vQuestion = 0x3F
  if key = vQuestion then
```
request "Do you wish to display Help?" with "Yes" or "Cancel"
if It is "Yes" then
    ... --Further statements here
else
    forward
    end if
else
    forward
    end if
end if

To format numeric values as hexadecimal, octal, or binary for display, use the format command with a prefix to indicate the base, as the following table shows.

**Prefixes for specifying numeric values**

<table>
<thead>
<tr>
<th>Base</th>
<th>Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>hex</td>
<td>@h</td>
</tr>
<tr>
<td>octal</td>
<td>@o</td>
</tr>
<tr>
<td>binary</td>
<td>@b</td>
</tr>
<tr>
<td>decimal</td>
<td>@d</td>
</tr>
</tbody>
</table>

The at symbol (@) must appear as the first character of the format
string. For example:

```plaintext
vNumber = 10
format vNumber as "@h00"  -- Hex conversion
request vNumber            -- Displays "0A"

vNumber = 10
format vNumber as "@b#"   -- Binary conversion
request vNumber            -- Displays "1010"

vNumber = 10
format vNumber as "@o00"  -- Octal conversion
request vNumber            -- Displays "12"
```

For details on formatting characters, see the “Format” topic (format command) in online Help.

### Working with constants

Constants are words that represent other values, often numbers, to make the values easier to read and enter. You can use these types of constants in OpenScript.

#### Types of constants used in OpenScript

<table>
<thead>
<tr>
<th>Constant type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (HLS or RGB values)</td>
<td>red, green, blue</td>
</tr>
<tr>
<td>Control characters and punctuation</td>
<td>quote, tab, space, CRLF, EOF</td>
</tr>
<tr>
<td>Keystrokes</td>
<td>keyA, keyUpArrow, keyLeftButton, keySlash</td>
</tr>
<tr>
<td>Mathematical expressions</td>
<td>pi</td>
</tr>
</tbody>
</table>

132
The following examples illustrate constants:

```plaintext
my fillColor = green
--Uses CRLF as constant
text of field "Address" = vAddress & CRLF & vCity
--Uses keyRightButton as constant
if keyState(keyRightButton) is "down" then
    ...
--Further statements here
end
```

For a complete list of constants, refer to the “Color constants (table)” topic in online Help.

For details about the HLS and RGB values used in color constants, see “Referring to colors” later in this chapter.

**About keystroke constants**

OpenScript includes keystroke constants that are numeric equivalents for all keyboard keys and mouse actions (left-button and right-button clicks). Examples of keystroke constants include:

```plaintext
keyA, keyB, keyLeftButton, keyTab, keyF1, keyNumpad1, keyUpArrow, keyHome, keyNumLock
```

Use the keystroke constants with the `keyState()` function to determine whether the user has pressed a specific key or mouse button.

For example:

```plaintext
--This handler displays the unique ID of the object under the
--cursor while the left mouse button is held down
handle buttonDown
    while keyState(keyLeftButton) is down
```
Working with character strings

A character string, or string, is any combination of alphabetic, numeric, punctuation, and control characters that you assign to a variable, assign as the property of an object, or use in an expression. For example:

ask "Enter your complete address, including country"

**Note** For details about working with lists, see “Working with lists” later in this chapter.

Using string operators in expressions

To refer to part of a string, use one of the string operators `char`, `item`, `textline`, or `word`:

- `item 1 of newNames` -- Gets one item out of a list in a variable
- `char 2 of word 3 of textline 4 of text of field "Note" of \ page 27 of book "home.tbk"

You can identify part of a string, or a substring, using an absolute number (as shown above) or using a keyword to indicate its position: `first`, `last`, `middle` (or `mid`), `second`, `third`, `fourth`, up to `tenth`. For example:

- `third character of vAlphabet` -- Gets "C" from a local variable
last item of vNames  --Gets last item in a local variable

For details about string operators, see Chapter 6, “Creating an OpenScript statement.”

**Tip** Whenever possible, use the *char* operator to refer to part of a string because it executes much faster than *word* or *textline*.

### Using a range

To identify a range within a string, use the keyword *to*. For example:

```
vIntro = words 1 to 3 of text of field “Preamble of Constitution”
```

This statement sets the variable *vIntro* to *We, the people*, including the commas.

### Converting between strings and other data types

When you use string operators with data in untyped variables, ToolBook automatically converts the data to a string. For example:

```
x = (1000*2)
vFirstChar = first character of x  --Returns ”2”
```

You can also use strings as numbers in expressions. In the following expression, ToolBook converts the text of a field into a number:

```
request (word 1 of text of field "Tax Rate" of page 7) * vAmount
```
You can produce a list by joining strings with a comma and then assigning the string to a variable:

```
vAlphabet = "A,B,C,D,E"
```

You can use the list commands (`pop`, `push`, `clear`, `get`, `put`, and `set`) to manipulate lists.

**Note** You can convert between strings, numbers, and other data types only if the data is stored in variables that were not declared using data types.

## Inserting or replacing text in strings

You can use string specifiers to replace text or to insert text into a string, as the table on the next page shows. The new value does not have to be the same size as the old value.

### String specifiers for inserting or replacing strings

<table>
<thead>
<tr>
<th>String specifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>into</code></td>
<td>Replaces a string</td>
</tr>
<tr>
<td><code>before</code></td>
<td>Inserts text in front of another string</td>
</tr>
<tr>
<td><code>after</code></td>
<td>Inserts text behind another string</td>
</tr>
</tbody>
</table>

For example:

--To replace the first word of a string with a phrase
word 1 of textline 2 of text of field "Habitat" = "Large shady trees"

--To insert the word "shady" after the first word, and move any other words to the right
put "shady" after word 1 of textline 2 of text of field "Habitat"
Working with textlines

The string operator `textline` returns a line of text, but does not return the carriage return/line feed (CRLF) that delimits the line. If you insert a new textline before or after an existing textline, use the constant `CRLF` to include a carriage return/linefeed with the new textline. For example:

```
--To start a new line and insert the specified string
put CRLF & "average annual rainfall: 40 inches" after \n    textline 3 of text of field "Habitat"
```

If you need to manipulate the text of a field, put the text into a variable first. Extracting data from a variable is faster than extracting it from properties of an object. For example:

```
vTextOffield = text of field "Introduction"
step ctr from 1 to wordCount(vTextOffield)
    request word ctr of vTextOffield
end
```

Selecting text in a field or list box

To select a string within the text of a field, use the `select` command:

```
select words 2 to 5 of text of field "Instructions"
```

When text is selected, you can act on it by referring to the `selectedText` system property:

```
select word 1 of text of field "Instructions"
strokeColor of selectedText = red  --Sets text to red
```
The system property `selectedTextState` returns a list of information (such as the offset within a field) about the currently selected text.

To determine what lines have been selected in a list box, use the field’s `selectedTextlines` property. You can also use `selectedTextlines` to select particular lines from within a handler to set, for example, default values in a list box. The property `selectedTextlines` contains a list of one or more line numbers representing the selected lines. For example:

--This handler is in a button (not in the script of the list box)  
--and displays the text of lines that have been clicked in a list box to handle buttonClick
     vTextOffield = text of field "listbox1" 
     vSelectionList = selectedTextlines of field "listbox1" 
     step ctr from 1 to itemCount(vSelectionList) 
        vNextLineNo = item ctr of vSelectionList 
        vNextLine = textline vNextLineNo of vTextOffield 
         request vNextLine 
     end step
end buttonClick

**Functions used with strings**

You can use the following OpenScript functions to refer to or act on specific parts of a string:

`ansiToChar()`, `lowercase()`, `uppercase()`
charCount()  offset()  wordCount()
charToAnsi()  textFromPoint()
itemCount()  textlineCount()

For example, the following statement puts a list of all but the first three finalists into a variable:

vConsolation = items 4 to itemCount(vFinalists) of vFinalists

When manipulating text in a field, improve processing speed by putting the text into a variable and performing the required operations on the variable. String functions are especially useful for such operations. For example:

--To find out if any character in a field is not a number
--vTxt is a local variable
vTxt = text of field "RefValues" of this background
step i from 1 to charCount(vTxt)
   if character i of vTxt is not in "0123456789"
      return false
   end if
end step

**Working with lists**

A list, or stack, is a series of items separated by commas. Lists are a good way to maintain data that consists of a series, such as names, especially if the number of items changes often. You can also use lists to store a series of items temporarily without having to create separate variables for each item.
ToolBook has special commands and functions that work with lists, and often requires parameters to be passed as lists (such as page units or color values). You can refer to each element of a list using the keyword item:

\[
v\text{Names} = \text{"Amelia,Molly,Isabel,Roxanne"}
\]

get item 2 of vNames --Puts the name "Molly" into It

Use the commands push and pop to treat a list as a first-in-last-out stack. Push adds an item (including the comma delimiter) to the front of a container; pop removes it. For example:

\[
\text{local vGrades} --\text{Initializes to null}
\]

push "A" onto vGrades
push "B" onto vGrades --vGrades now contains "B,A"
--Puts "B" into the variable It (vGrades now contains only "A")
pop vGrades
pop vGrades into vLastItem --Puts "A" into vLastItem

You can use push to position items at a specific place in the stack:

push "dog" onto item 5 of vAnimals
push "cat" after item 5 of vAnimals

When you refer to items in a list, you can put a working copy of the list into a variable and pop items from the variable until it is null rather than use a step control structure to iterate through the original list. For example:

\[
\text{system svSysPositions}
\]

local vObjWinner, vMyList --Puts value of system variable into a local variable
push svSysPositions onto vMyList
step i from 1 to itemCount(vMyList) --Checks each item in the list
\]

pop vMyList
if i <> It
Referring to colors

A color in ToolBook is specified by a list of three numbers, representing either RGB (red, green, and blue) or HLS (hue, lightness, and saturation) units. You can set colors directly using these values or use predefined color constants for some colors such as red, blue, black, and white. You can also set a property for objects that causes them to use the Windows system colors.

You can set colors in OpenScript using either RGB or HLS units. To set a color using RGB units, set the rgbFill or rgbStroke properties of an object; to use HLS units, set the fillColor and strokeColor property. There is no difference in the result, so use the color system that you are most comfortable with. You can alternate RGB and HLS units in the same application, and even use RGB units one time and HLS units another time for the same object.

Specify RGB values as follows:

- Red values range from 0 to 255, with 0 representing 0 percent red and 255 representing 100 percent red. Pure red in RGB values is represented by 255,0,0.
- Green values range from 0 to 255, with 0 representing 0 percent green and 255 representing 100 percent green. Pure green in RGB values is represented by 0,255,0.
- Blue values range from 0 to 255, with 0 representing 0 percent
blue and 255 representing 100 percent blue. Pure blue in RGB values is represented by 0,0,255.

White in RGB units is created by combining 100 percent red, green, and blue and is represented by 255,255,255. Black is created by combining 0 percent red, green, and blue and is represented by 0,0,0.

Specify HLS values as follows:

* Hue values range from 0 to 360, corresponding to the angle on a color wheel. For pure colors, 0° is red, 60° is yellow, 120° is green, 180° is cyan, 240° is blue, and 300° is magenta. Intermediate angles represent intermediate colors. 0° and 360° are equivalent.

* Lightness values range from 0 to 100, with 0 representing 0 percent lightness (black) and 100 representing 100 percent lightness (white).

* Saturation values range from 0 to 100, with 0 representing 0 percent saturation (gray) and 100 representing 100 percent saturation (pure color).

```plaintext
-- Display in sequence all colors available on the current display
-- (in HLS units)
to handle buttonClick
    step vHue from 0 to 360
    my fillColor = vHue,50,100
end step
end buttonClick
```

Note: You can get the RGB and HLS values of a color by using the Color dialog box.
Referring to color constants

You can use 10 ToolBook color constants to refer to solid colors—black, blue, cyan, green, magenta, red, yellow, white, gray, and lightGray. Each constant is equivalent to the three numeric values that constitute either the HLS or RGB values for that color. ToolBook assigns the correct values depending on whether you are assigning the color to a property that uses HLS or RGB values. For example:

- `my fillColor = green` -- Sets to 120,50,100 (HLS)
- `rgbFill of rectangle "patch" = green` -- Sets to 0,255,0 (RGB)
- `my strokeColor = 0.50,100` -- Red (HLS)

Using Windows system colors

To color an object using the Windows-defined colors for that object type, set the object’s useWindowsColors property to true. This overrides the current settings for strokeColor and fillColor, but preserves these values. If you later set the value of useWindowsColors to false, ToolBook reverts to the values in strokeColor and fillColor.
Chapter 8

Writing common scripts

When creating ToolBook applications, you have the option to write OpenScript programs to accomplish many common tasks, such as moving between pages, checking for errors, saving changes to applications, and creating libraries of routines to use in different applications. This chapter describes how to accomplish these tasks using OpenScript.

Designing navigation ......................... 145
Checking for results and errors ............... 153
Creating scripts in a running application .... 155
Saving changes to applications ............... 159
Creating libraries of handlers using system books ... 162
Initializing an application .................... 167
Setting startup properties for ToolBook ....... 175
Designing navigation

Applications commonly have buttons or hotwords that you click to navigate to other pages of your books. To move to a particular page, use the go or send commands in the script of a button or hotword. You can also navigate to a page relative to the current page (send next, send previous) or to an absolute location in the book. When possible, navigate to a page by name, so you do not have to change the script if you reorder the pages:

--Examples of navigating using relative locations
send next --Goes to the next page
send previous page --Goes to the previous page

--Examples of navigating using absolute locations
send to page 1
send to page 1 of this background

--Script for a "Contents" button
to handle buttonClick
  go to page "Contents"
end

If the user is already on the last page of the book when the go next page command is executed, ToolBook automatically navigates to the first page of the book. You can create a handler that prevents ToolBook from wrapping from the last to the first page:

to handle buttonClick
  if pageNumber of this page < pageCount of this book then
    go next page
  else
    request "This is the last page."
  end if
end buttonClick
Using a variable as the name of a page

To create a flexible navigation system in your book, you can use a variable to pass the name of a page. For example, if you want a user to be able to click a hotword to display a page that defines the hotword, put the definition on a page named after the hotword and use a handler such as the following to navigate to the definition:

```
--Place this handler in a book script
to handle buttonClick
  if object of target is "hotword"
    go to page(text of target)
  end if
end if
end buttonClick
```

Initializing pages and objects when navigating

Typically, you need to set up pages so that they are in a predictable state each time they are displayed. Types of initialization you might need include:

- setting the focus to a specific button or field.
- building menus for specific pages or backgrounds.
- running animation and special effects related to changing pages.

When you navigate from page to page, ToolBook sends leave-event and enter-event messages to the affected pages and, if necessary, to the backgrounds. You can write handlers for these messages to initialize or clean up pages as you navigate to or from them.

ToolBook sends leave-event and enter-event messages in this order:

- `leaveField`, `leaveCombobox`, or `leaveButton` sent only at Reader level
- `leavePage` sent always
- `leaveBackground` sent if necessary
**enterBackground**  
**enterPage**  
**enterField, enterCombobox, or enterButton**

**sent if necessary**  
**sent always**  
**sent only at Reader level**

**Placing scripts that initialize pages**

In most cases, the best way to initialize a page is to set it to its original state in the **leavePage** handler for that page, or in the **enterPage** handler for the next page.

Set **lockScreen** or **sysLockScreen** to **true** in the **leavePage** handler to prevent a user from seeing the cleanup actions. Use **lockScreen** to prevent updates to a page in a viewer, or **sysLockScreen** to prevent updates to any page. (**LockScreen** and **sysLockScreen** are automatically set back to **false** when ToolBook returns to an idle state.) For example:

```
to handle leavePage
  sysLockScreen = true    --Prevents screen updates
  --The following three lines restore the page to a predictable state
  move ellipse "animate1" to 100,100
  text of field "Student" = null    --Makes student’s name null
  selectedTextlines of field "MoreInfo" = null
  forward
end
```

Where you choose to place these handlers depends on whether you want the action to affect all pages in a book, all pages that share a background, or only a specific page. You can place handlers for **enterBackground** and **enterPage** messages in book, background, and page scripts.
**Initializing an object automatically**

You can create objects that respond automatically to enter-event and leave-event messages by using a notify handler. The advantage is that you do not need to change the scripts for the page or book because the object can automatically be notified for `enterPage` and `leavePage` messages. For example, the following notify handler for the `enterPage` message initializes a page by disabling the Next button if the user is on the last page:

```plaintext
notifyBefore enterPage
    if pageNumber of this page = pageCount of this book then
        enabled of button "Next" = false
    else
        enabled of button "Next" = true
    end if
end enterPage
```

For more information about notify handlers, see “Creating self-contained objects using notify handlers” in Chapter 5, “Handling messages, events, objects, and properties.”

**Using `sysHistory` to maintain a list of pages**

Each time the user navigates from a page in the main window (not in a viewer), ToolBook adds the `uniqueName` of that page to the front of the system property `sysHistory`. To return to the last page...
visited, send the message back, or use the command go to item 1 of sysHistory. Both methods use sysHistory to determine what page to visit next.

**Note** Using the go or send back command adds the name of the page you are leaving to sysHistory, so that repeated send back or go commands flip back and forth between two pages.

**Figure 1** ToolBook adds pages to sysHistory as a user navigates

Manipulate sysHistory as you would any list, adding pages, displaying them, or removing them as required by your application. For example:

```--Puts each item from sysHistory item into a variable to handle buttonClick pageListing = null step ctr from 1 to itemCount(sysHistory)```
--Checks for duplicates
if item ctr of sysHistory is not in pageListing then
    put item ctr of sysHistory & CRLF after pageListing
end if
end step
--Puts the contents of the variable into a list box field
text of field "Already done" = pageListing
end buttonClick

Preventing ToolBook from updating sysHistory

To prevent ToolBook from adding pages to sysHistory, set the system property sysHistoryRecord to false. This restricts the user from navigating using the send back command. You can also navigate to a page in your script, such as an index page, but hide the navigation from the user.

Flipping pages automatically

You can use the flip command to move from page to page automatically. This command is useful if you are writing self-running demonstrations or tutorials, or if you are creating an animation sequence by moving rapidly from page to page. For example:

-- This handler flips through all pages in a book,
-- pausing two seconds at each page
to handle enterBook
done = false
while done is not true
   flip 1
   pause 2 seconds
-- Quits when user holds the left mouse button for a few seconds
if keyState(keyLeftButton) is "down" then
    request "Do you wish to quit?" with "Yes" or "No"
    if It is "Yes" then
        done = true
    end if
end if
end while
send exit  --Quits ToolBook
forward
end enterBook

Note While the pause command is executing, no mouse clicks or keystrokes are processed; therefore, use pause to create a delay only when you are sure a user will not want to click objects or enter characters from the keyboard while the system is paused.

As an optimization technique, you can also flip through all pages in a book to preload them into memory. For example:

--This handler preloads all the pages from a book into memory to handle enterBook
    sysLockScreen = true  --Prevents pages from displaying
    flip all  --Flips through all pages
    sysLockScreen = false
    forward
end

Restricting navigation with the skipNavigation property

You can prevent users from navigating to a page by setting its skipNavigation property. For example, in a tutorial application, you can set skipNavigation to true for the contents page so that if users move through the lesson page by page, they skip that page.

If the skipNavigation property of a page is set to true, you can navigate
to it using explicit statements, such as go to page “topics”, send back, go to previous page, or go to next page. Implicit statements, such as send next, send previous, send first, send last, or flip will skip the page.

For details about skipNavigation, refer to the entry for skipNavigation in the Openscript reference in online Help.

Creating transition effects

When you navigate to another page, you can use the transition command, or the fxDissolve, fxWipe, or fxZoom commands, to have ToolBook display a transition effect—such as fading or wiping—before displaying the next page. For example, if you are displaying bitmaps, you can use transition commands to fade to black between pages as this example shows:

```
--This example shows a gradual dissolve to the next page
to handle buttonClick
    transition "dissolve slow" to next page
end

--This illustrates fading to black, then splitting to the next page
to handle buttonClick
    transition "fade slow" to black
    transition "split horizontal fast" to next page
end
```

**Note** The transition command ignores any skipNavigation command set for a page.
For details about transitions, refer to the entries for \textit{fxDissolve}, \textit{fxWipe}, \textit{fxZoom}, and \textit{transition} in the OpenScript reference in online Help.

\section*{Checking for results and errors}

You can determine whether ToolBook successfully completed statements in your scripts by checking the values of the variables \texttt{sysError} (error message text) and \texttt{sysErrorNumber} (an error number only). ToolBook puts values into these variables if a statement results in an error. In addition, some statements such as \texttt{request} and \texttt{ask} set these variables to indicate whether a user clicked Cancel in a message box.

\textbf{Note} You should check the number in \texttt{sysErrorNumber} rather than the text in \texttt{sysError} if you intend to translate your application into another language, such as German or French.

In the following example, if ToolBook cannot complete the \texttt{go} command, \texttt{sysError} is set to \textit{Cannot find page "Index"} and \texttt{sysErrorNumber} is set to 8012:

\begin{verbatim}
sysSuspend = false --Turns off execution-suspended messages
go to page "Index" --If there is no such page, there is an error
request sysErrorNumber && sysError
--Shows how you can detect whether the user clicked "Cancel"
--In the message box displayed by the ask command
ask "Enter name"
if sysError = "cancel" then
  --User pressed the "Cancel" button instead of entering a value
  ...
end
\end{verbatim}
In general, ToolBook sets `sysError` to `null` and `sysErrorNumber` to zero or `null` if a statement is successful. (The `request` and `ask` commands set `sysError` to `ok` instead of `null`).

**Scope of system error values**

The values in `sysError` and `sysErrorNumber` persist between handlers. To ensure that you do not inadvertently read values put into these variables by earlier statements, clear the variables at the beginning of your script:

```plaintext
clear sysError
sysErrorNumber = 0
```

Because these two variables are reset often by various commands, copy their values to other variables immediately after the command you are checking if you want to examine the value later.

**Handling errors in your scripts**

If ToolBook cannot continue executing your script, it generates an error and displays the Execution Suspended message. To handle fatal errors as part of your application, you can suppress the display of this message. Handling errors in your script is useful when you want to create your own error messages, or when you are trying to force an error, such as when validating user input.

To suppress the Execution Suspended message, set `sysSuspend` to `false`. ToolBook will ignore any errors and instead load error values into `sysError` and `sysErrorNumber`. You can then check the values of these variables as part of your script. To be sure that ToolBook continues to monitor errors, set `sysSuspend` back to `true` as
soon as possible. For example:

```openscript
--This handler is a user-defined function to validate a date
to get validateDate userInput
    returnValue = true  --Default return value
    --Clear residual value in error variable
    sysErrorNumber = 0
    --Disable default error checking
    sysSuspend = false
    format date userInput from "m/d/y"  --Try to generate an error
    --Enable error checking right away
    sysSuspend = true
    if sysErrorNumber is 8050 then
        returnValue = false  --The date was not valid
    end if
    return returnValue
end
```

For details about how to use the options in the Execution Suspended message, see Chapter 14, “Debugging OpenScript programs.”

## Creating scripts in a running application

You can create scripts in your application while it is running to add scripts to objects at Reader level, or to include information such as the name of a property to display. You can create scripts at run time in the following ways:

- Use an `execute` statement to create and run one or more complete OpenScript statements. For example:

```openscript
execute "move button myButton by 500,500;
    move field myField by 200,200"
```
◆ Use the evaluate function to get the value of an expression while the script is running. For example:

\[ x = \text{evaluate}(y \text{ bitOr } 4) \]

◆ Set the script property of an object to add a new script to it.

Note Creating scripts at run time is a powerful feature of ToolBook. However, because there is some performance overhead, we recommend that you create scripts at run time only when absolutely necessary.

**Constructing statements at run time**

Use an `execute` statement to construct and run OpenScript statements while the application is running. For example:

```plaintext
-- This script gets the text property of a record field and
-- runs the text as a script
myScript = text of recordField "Script"
execute myScript
```

When creating statements to be run with the `execute` command, use these guidelines:

◆ Statements following `execute` run as if they are part of the script in which the `execute` statement appears. Variables in the `execute` statement act as local variables to the handler as a whole.

◆ You cannot include a `break to system` command in the `execute` statement.
It can be more difficult to track errors in an `execute` statement because the ToolBook Debugger identifies the `execute` statement itself as the location of the problem.

ToolBook recompiles the code following the `execute` command each time the statement runs, so there is some performance overhead. Do not use `execute` inside a loop because the overhead of recompiling is compounded at each iteration of the loop.

**Evaluating expressions**

To evaluate expressions while an application is running, use the `evaluate` function. This function allows you to construct an expression—for example, the name of a property or a mathematical expression—and get its value while the application is running. For example:

```plaintext
--Asks user for an object and a property and displays the value
--of the requested property
to handle buttonClick
    ask "Examine what object? (use this format: object <identifier>)"
    if sysError = "cancel" then
        break
    end if
    vObject = It
    ask "What property do you want to see?"
    if sysError = "cancel" then
        break
    end if
    vProp = It && "of" && vObject
    request evaluate(vProp)
end buttonClick
```

The following example combines the `execute` and `evaluate` commands in a script that copies all of the user properties of one object to another.
object. This example is a good illustration of the use of these statements, as there is no other way to accomplish this task.

to handle copyProps fromObject, toObject
--Get the list of userProperties from source object
uProps = userProperties of fromObject
step i from 1 to itemCount(uProps)
  pop uProps into curProp
  --Get the value of property in curProp
  curPropVal = evaluate(curProp && "of" && fromObject)
  --Construct the execute string
  ex = curProp && "of" && toObject && "=" &&
       quote & curPropVal & quote
  request ex --Display for debugging to see if
             --it looks valid
  execute ex
  end step
end copyProps

Evaluating the names of messages

If you need to evaluate the name of a message for use with the send command, do not use the evaluate function. Instead, place the name of the message in parentheses. For example, the following handler gets the text of a field and sends it as a message. If no parentheses surrounded it, ToolBook would send the literal value it instead of the contents of the variable.
to handle buttonClick
  get text of field "message"
  send (It)
end

**Setting the script property of an object**

Because the script of an object is a property, you can set it and get it like any other property. Set an object's script property to build scripts at runtime and send messages to run them.

The following example shows how you can use a record field to enter scripts for testing. First, create a record field called “Script”. Then, create a button and enter the following as its script:

to handle buttonClick
  local temporaryScript
  temporaryScript = text of recordField "SCRIPT"
  --The next two statements put a handler control structure
  --around the script
  put "to handle runMyScript" & CRLF before temporaryScript
  put CRLF & "end" after temporaryScript
  script of recordField "SCRIPT" = temporaryScript
  send runMyScript to recordfield "SCRIPT" of this background
end

**Saving changes to applications**

You can save changes to the current application at any point using the *save* or *save as* commands. You can also control whether ToolBook saves changes when a user closes the book.
Saving changes explicitly

Use the `save` command to save the current changes to a book:

```
save changes to this book
save changes to book "mysysbook.sbk"
```

To save the application under another name, use the `save as` command:

```
to handle buttonClick
    ask "Enter the name you want to save under:"
    if sysError is not "cancel" then
        overWrite = true
        save as It, overWrite
    end if
end buttonClick
```

**Tip** When you use the `save` command, ToolBook simply adds changes to the end of the file. When you use the `save as` command, ToolBook compacts the book to its most efficient size before saving it. Use `save as` periodically to ensure that your book runs optimally.

Saving changes when a book closes

You can control whether ToolBook saves changes when a user closes a book by setting the properties `saveOnClose` and `sysChangesDB`. By setting these properties, you can also determine whether ToolBook prompts the user before saving changes.

Set `saveOnClose` to one of the values listed in the table on the following page. The `saveOnClose` property is persistent, retaining its setting when you reopen the book.
Values for the `saveOnClose` property

<table>
<thead>
<tr>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Save changes before closing.</td>
</tr>
<tr>
<td>No</td>
<td>Don’t save changes before closing.</td>
</tr>
<tr>
<td>Ask</td>
<td>Display the “Save current changes?” message before closing.</td>
</tr>
<tr>
<td>System</td>
<td>Don’t save changes; display a message according to the setting in <code>sysChangesDB</code>. This is the default value.</td>
</tr>
</tbody>
</table>

Note ToolBook closes a book when you open or start a new book, exit ToolBook, or close a viewer displaying a page from the book.

Setting `sysChangesDB` to suppress messages

If the value of `saveOnClose` is `system`, ToolBook uses the value of `sysChangesDB` to determine whether to prompt the user to save changes when closing the book. If `sysChangesDB` is `true` (the default), ToolBook displays the “Save current changes?” message. If `sysChangesDB` is `false`, ToolBook closes the book without displaying any messages.

Important If `sysChangesDB` is set to `false` and `saveOnClose` is set to `system`, ToolBook closes the current book and discards unsaved changes without warning.

The value of the `sysChangesDB` property applies to the current ToolBook instance, even across books. However, it is set to its default value of `true` when you start your next instance of ToolBook.
Creating libraries of handlers using system books

A system book is any book that you add to the sysbooks property of the current book. You can use system books as libraries to store handlers, such as user-defined functions, for use with multiple applications.

Creating a system book

To create a system book, start a new book, and then place the handlers you want to share between books into the book script of the new book. Save the system book as you would any book. By convention, system books are saved with the extension .sbk (instead of .tbk), but you can use any file extension.

You can edit the script of a system book directly using the edit command in the Command window of any book:

```
edit script of book "c:\sysbooks\animate.sbk"
```

Adding a system book to the current book

To use a system book, add its name, including the extension, to the sysBooks property of the current book:

```
push "c:\sysbooks\animate.sbk" onto sysBooks
```

**Important** Always use push or a similar command to add books to sysBooks. Simply setting sysBooks to a new value overwrites its contents, potentially removing system books already defined for the
application. For details about how to set *sysBooks* without overwriting its contents, see the next topic.

The book script of the system book becomes part of the object hierarchy for the current book. If a message is not handled in the current book, ToolBook searches for a corresponding handler in the book script of the system book. Only the book script of the system book becomes part of the object hierarchy, although handlers in the system book script can redirect messages by sending them to other objects in the system book.

You can add as many system books as you require to the *sysBooks* property. ToolBook searches for handlers in system books in the order the books appear in the *sysBooks* property.

When ToolBook adds the name of a system book to the *sysBooks* property, it sends a *linkSysBook* notification message to the book just linked. You can write a handler for this message in the system book to run any statements that the system book requires for initialization. For example, if the system book uses a DLL function, you can write a handler for the *linkSysBook* message to link the DLL.

ToolBook sends an *unlinkSysBook* message when you remove a system book. You can write a handler for that message to unlink DLLs, clear variables, or perform other cleanup activities.

**Note** Do not forward the *linkSysBook* and *unlinkSysBook* messages from a system book, or other system books may rerun their handlers for these messages.
Loading a system book when starting an application

To make a system book available when you first start an application, write an enterBook handler for the application that loads sysBooks. The system book is then immediately available to the application, and the application can send messages to the system book for further initialization. For example:

```up
    to handle enterBook
        push "c:\mybooks\messages.sbk" onto sysBooks
        forward
    end
```

You can define default system books in your Inst60.ini file by setting the value of the System Books entry in the Startup Options section.

If you have defined startup system books, be sure that any system book you want to add is not already in the System Books entry.

```up
    -- Requests a system book to be added to startup system books
    to handle enterBook
        send addToSysBooks "mybook.sbk" to this book
        forward
    end
```

```up
    -- Adds a book to sysBooks if it isn't already there
    to handle addToSysBooks newBook
        if newBook is not in sysBooks then
            push newBook onto sysBooks
        end if
    end addToSysBooks
```
Removing a system book

You can remove one book from the *sysBooks* property and leave the others intact. For example:

```plaintext
to handle removeSysbook fBookName
    step i from 1 to itemcount(sysBooks)
    --The partial-string comparison in the next line
    --ignores the path
    if (fBookName is in item i of sysBooks)
        clear item i of sysBooks
        break step
    end if
end step
end removeSysbook
```

Writing handlers for the system book

You should write handlers for a system book that are as generic as possible for multiple applications. For example, always forward built-in messages that you are handling, such as *enterBook*, unless you are writing a system book handler to trap a particular message. When writing system book handlers, keep these points in mind:

◆ If you handle enter-event messages (*enterBook*, *enterPage*) and leave-event messages (*leaveBook*, *leavePage*), always forward them. If there are multiple system books in the hierarchy, each system book can initialize or clean up in response to these messages.

◆ If you link a DLL function in a system book, always assign a unique alias to the function so there is no conflict if another
system book (or book handler) prototypes that function differently. For details about assigning aliases to DLL functions, see Chapter 13, “Using dynamic-link libraries.”

When a handler in a system book is running, the context for the keyword *this* is the current page of the target window. For example, if the main window is the target window, then *this book* refers to the book open in the main window. Or, if a viewer displaying a page from a system book is the target window, then *this page* refers to the page from the system book and *this book* refers to the system book.

The keywords *my* and *self* always refer to the object whose script is currently executing—in this case, the system book.

**About system books and performance**

ToolBook opens system books only when looking for a handler, and so the number of system books you specify does not affect ToolBook performance. However, performance can slow if ToolBook has to open and search many system books. To keep your scripts running as quickly as possible, specify only the system books you really need and make sure they contain only necessary handlers. Put the most heavily used system books at the front of *sysBooks*.

To minimize the number of handlers in the hierarchy, keep only essential handlers in the book script of the system book. If you have handlers for user-defined functions or for messages that are unique to that system book, put them into page scripts of the system book, and then forward the message to those pages. For example:
--This handler must be in the hierarchy, so it belongs
--in the book script of the system book
to handle enterBook
--Forwards a user-defined message to a page in this system book
  send initializeMe to page 1 of self
  forward
end

--This script (in the script of page 1 of the system book)
--is not in the object hierarchy
to handle initializeMe
--Further statements here
end

If you need to call a function in a system book only occasionally,
you can avoid putting it into sysBooks and call it directly instead:

get nextMultimediaDevice("videodisc") of book "mmutils.sbk"

**Initializing an application**

Initializing an application is the process of running scripts when the
user starts the application. During initialization, you can:

- establish the opening screen of the application. For example,
  show an opening screen by displaying a viewer that contains
  a page with a logo or other opening artwork.

- start the application at Reader level. Send the reader message
to initialize menus and present the application to the user, ready
to run.
❖ declare and initialize system variables. For example, prompt for a password at initialization and then store a security level in a system variable for later use.

❖ set system properties. For example, set sysDrawDirect or sysFontFace so that objects are created in styles you customarily use.

❖ define menu items. For example, add a menu item for a custom development tool to the Author-level menu when ToolBook is initializing.

❖ link DLLs. For details about linking DLLs, see Chapter 13, “Using dynamic-link libraries.”

❖ specify system books. For example, add a system book to handle messages from a custom menu. For details about system books, see “Creating libraries of handlers using system books” earlier in this chapter.

❖ set the focus. For example, set the focus property to a specific button or field to prepare the application for data entry.

❖ define the main window size and location. For details, see “Defining window size and position” later in this chapter.

The following sections describe how to write handlers for initialization, streamline the initialization process, initialize separately for Reader and Author levels, position a window during initialization, and restore ToolBook to its default state.
Writing handlers for initialization

ToolBook sends three enter-event messages for which you can write initialization handlers: `enterSystem`, `enterApplication`, and `enterBook`. You can use these messages to write initialization handlers for ToolBook as a whole, the primary book in an application, or additional books in an application, respectively.

Using `enterSystem`

ToolBook sends the `enterSystem` message when a new instance of ToolBook starts. Write handlers for this message to establish conditions that are true for ToolBook as a whole, no matter what book you are running, including initializing system properties, linking DLLs, loading system books, or customizing Author level by adding menu items.

To use this message, put a handler for it in a startup system book or in the script of a book you specify in the command line when you start ToolBook.

You can determine whether the user included a file name or other information when starting ToolBook by checking the value of the `<cmdLine>` parameter for the `enterSystem` message. You can use this parameter to define command-line switches for your application. For example:

```
--Initializes ToolBook in different states depending on the
--command-line switch the user started with
to handle enterSystem cmdLine
```
if "/a" in cmdLine then --Begin at Author level
  send author
end if
if "/r" in cmdLine then --Begin at Reader level
  send reader
end if
if "/co" in cmdLine --Begin with Color Tray visible
  visible of colorTray = true
end if
forward
end enterSystem

Note  You can establish default values for a number of system properties by setting startup system properties. For details, see “Setting startup properties for ToolBook” later in this chapter.

Using enterApplication

An enterApplication message is sent when a book opens in the main window and just before ToolBook displays a page from that book in the main window. Use this message to write handlers for initializing the application, such as declaring and initializing application-specific system variables, customizing the Reader-level menu, showing an opening screen, setting the focus, and hiding or showing objects.

ToolBook sends the enterApplication message to the page displayed in the main window. You can put a handler for this message in the script of the opening page of the book or anywhere further up in the object hierarchy.
Using enterBook

ToolBook sends an enterBook message when a book is opened in any viewer and just before it displays a page, whether in the main window or in a viewer. Use the enterBook message to write handlers that initialize a book by itself—regardless of whether it is the main book in an application—such as choosing text to display based on the current language set, changing the size of the background depending on the current display device, and setting colors depending on the colors in the main window.

The difference between enterApplication and enterBook is that ToolBook sends the enterApplication message only when a page of a new book is displayed in the main window. For example, if you display a page from a book in a viewer other than the main window, ToolBook sends an enterBook message to that book, but not an enterApplication message. Therefore, if ToolBook sends an enterApplication message when you open a book, it will also send an enterBook message.

ToolBook sends the enterApplication and enterBook messages to a book the first time it displays a page from that book, but it does not send these messages if you get a property from another book or edit a script from another book without displaying one of its pages.

ToolBook closes the book and sends leave-event messages (leaveApplication, leaveBook) when no more pages from a book are being displayed. If a book is closed but you reopen it to display one of its pages, ToolBook sends an enterApplication message (if you display the page in the main window) and an enterBook message again.
Streamlining the \textit{enterApplication} handler

Because ToolBook does not display the starting page of an application until it finishes executing the \textit{enterApplication} handler, limit the \textit{enterApplication} handler of a book to statements that determine the look and actions for an application. To streamline the \textit{enterApplication} handler and speed display of the first page of the application, follow these guidelines:

\begin{itemize}
  \item If a DLL or system variable is used only in a few places in the application, link the DLL or initialize the variable lower in the hierarchy, closer to where it is used.
  \item Move statements to an \textit{enterPage} or \textit{firstIdle} handler, if possible. The first page displays before the \textit{enterPage} message is sent. To ensure that the process of displaying the page is complete, run media, such as an opening animation, in a \textit{firstIdle} handler. Leave only the statements in the \textit{enterApplication} handler that must run before ToolBook displays the first page.
\end{itemize}

Initializing Reader and Author levels differently

You can initialize Reader and Author levels differently. At Reader level, you can set up the application so that a user can perform specific tasks—for example, data entry—right away. At Author level, you can set up custom tools for application development and set default values for system properties. To start the application at Reader level, send a \textit{reader} message from the \textit{enterApplication} handler.
To initialize each level differently, create handlers for the *reader* and *author* messages. By programming these tasks into *reader* and *author* handlers, you ensure that they are accomplished every time a user switches between levels in the application. For example:

```lisp
  to handle reader
    hide menuBar
    hide scrollBar
    send sizeToPage
    clear sysBooks
    sysChangesDB = false
    forward
    focus = field "Quantity"
  end

  to handle author
    show menuBar
    send sizeToPage
    show scrollBar
    push "dev1.tbk" onto sysBooks  -- Adds a system book
    sysChangesDB = true
    sysLevel = author            -- Or "forward"
  end

You can also control the working state at Author level by specifying the values for startup system properties in the Tb100.ini file, rather than in individual scripts. For details, see “Setting startup properties for ToolBook” later in this chapter.
Defining window size and position

By default, when a user first opens a book, the main window is centered and just large enough to display the starting page of the book. You can change the page size and both the size and location of the main window for a ToolBook instance.

◆ To change the page size, set the book’s size property, or set the page size in the Book Properties dialog box.

◆ To change the size of the main window so that it fits a new page size, send the sizeToPage message. Send this message directly after you change the page size from a script. This message is sent automatically when a book is first opened. Switching working levels and hiding and showing the menu bar also change the page size slightly.

◆ To change the position of the main window, set its position property. These statements align two open instances of ToolBook on a VGA screen:

```plaintext
position of mainWindow = 0,0
executeRemote "set position of mainWindow to 240,0"
application "ToolBook" topic "book2.tbk"
```

◆ To change both the size and position of the main window, set its bounds property. This statement displays a page so that it covers the entire screen on a 1024-by-768 VGA monitor:

```plaintext
bounds of mainWindow = 0,0,1024,768
```
Setting startup properties for ToolBook

Default values for certain ToolBook system properties are established by settings in the Tb100.ini file. You can get or set the settings in this file by changing the values of the startup system properties in any script. Examples of startup system properties include:

◆ **startupBook** The name of the book that opens automatically when a user runs ToolBook.

◆ **startupReaderRightClick** A property that determines whether—by default—shortcut menus will appear at Reader level when a user right-clicks an object.

For a complete list of startup system properties, refer to the “Startup system properties” topic in online Help.
Chapter 9

Handling user events

This chapter discusses how to work with events that a user generates by clicking a mouse button or typing at the keyboard, and how to modify the ToolBook default responses to these events.

Handling mouse events ........................................... 177
Handling keyboard events ....................................... 188
Handling mouse events

When a user presses or releases a mouse button, or moves the mouse pointer over an object, ToolBook sends mouse-event messages. By writing handlers that respond to mouse-event messages, you can define what occurs in your application when a user clicks a button, field, or other object. For example, you can write a mouse-event handler that navigates between pages or triggers an animation. You can test for and respond to the following:

- Which mouse button has been clicked
- Whether the user has released the mouse button
- Whether the user has pressed a mouse button and is holding it down
- What object the pointer is over
- What object the user has clicked
- What line of a list box or field the insertion point is in when the user clicks the mouse

ToolBook also sends mouse-event messages when a user presses keys as a substitute for mouse clicks. For example, ToolBook sends a buttonClick message if the user presses the SPACEBAR while the focus is in a button, which is equivalent to clicking the button.
Handling mouse-event messages

You can write handlers for any of these mouse-event messages:

- `buttonDown`
- `mouseEnter`
- `buttonUp`
- `mouseLeave`
- `buttonClick`
- `rightButtonDown`
- `buttonDoubleClick`
- `rightButtonUp`
- `buttonStillDown`
- `rightButtonDoubleClick`

If you want to define how an object responds when clicked, write a handler for the `buttonClick` message. However, you can better control the reaction of an object to a click by writing handlers for a:

- `buttonDown` message, sent when the user presses the left mouse button.
- `buttonUp` message, sent when the user releases the left mouse button.

For example, you can write a handler for the `buttonDown` message to create animation sequences that run only when the mouse button is held down.

ToolBook does not send the `buttonClick` message if the user clicks an object but moves the mouse pointer off the object before releasing the mouse button. Therefore, write a handler for the `buttonUp` message if you want the handler to run no matter where the pointer is when the mouse button is released. For example, you can use the `buttonUp` message in a page script so the user can click anywhere on the page to stop an OLE object from playing.

If the user holds the mouse button down, ToolBook sends continuous `buttonStillDown` messages until the button is released.
For example:

--This handler moves the target object across the screen as long
--as the user holds the left mouse button down

```
to handle buttonStillDown
    move self by -75.0
    --If the object reaches the left edge, move it back to the right
    if item 1 of bounds of self < 0 then
        move self to 7000, item 2 of bounds of self
    end if
end buttonStillDown
```

When a user clicks the mouse button, ToolBook can generate other messages as well, depending on what object is clicked and how its properties are set. For example, if the user clicks a field, the `activated` property of the field determines which messages are sent. If the `activated` property is `true`, then the field gets the usual mouse messages. If the `activated` property is `false`, then normal mouse messages are not sent, but other messages, such as `enterField`, might be sent.

**Note** If the `fieldType` of a field is set to `singleSelect` or `multiSelect`, then the `activated` property is ignored and normal mouse messages—and other messages, such as `enterField`—are sent to the field.

### Using mouse-event message parameters

ToolBook sends three parameters with mouse-event messages:

- The location of the mouse pointer in page units at the time the
user generates the mouse event

- A logical value (true or false) indicating whether the user held down the SHIFT key while clicking
- A logical value (true or false) indicating whether the user held down the CTRL key while clicking

You can include parameter variables in mouse-event handlers to make use of the values that ToolBook passes with the messages. For example:

```message = null
if shift is true then
    message = message && "with the shift key"
end if
if ctrl is true
    message = message && "with the ctrl key"
end if
request "You clicked at" && loc && message
```

Note: If a user does not click a button object but instead presses an access key, the SPACEBAR, or the ENTER key, ToolBook sends a `buttonClick` message, but the `<location>` parameter does not return the pointer position. Instead, it returns the value –1,–1.

**Displaying shortcut menus at Reader level**

When you right-click an object at Author level, ToolBook displays the shortcut menu for that object. You can have ToolBook display
shortcut menus at Reader level as well by setting the system property `sysReaderRightClick` to `true`. Displaying shortcut menus at Reader level makes it easy for you to change object properties while you are running or testing the application.

When a user right-clicks an object at Reader level (or in an `alwaysReader` viewer), ToolBook sends a `rightButtonDown` message to that object. If the `rightButtonDown` message reaches the system, ToolBook checks the value of `sysReaderRightClick`. If the property is `true`, ToolBook displays the shortcut menu for the target object. If the property is `false`, ToolBook does nothing.

**Note** If there is a `rightButtonDown` handler in the hierarchy between the object and the system, the message will get to the system only if the handler includes a `forward` command. An effective way to prevent users from accessing shortcut menus at Reader level (or in an `alwaysReader` viewer) is to use a `rightButtonDown` handler that does not include a `forward` command.

You can toggle the value of `sysReaderRightClick` by selecting Show right-click menus at Reader level in the Options dialog box, which is accessed from the View menu at Author level. The default value of `sysReaderRightClick` is specified by the `startupReaderRightClick` property; the default is `false`.

### Determining the position of the mouse pointer

You can use the position of the mouse pointer as user input. For example, if your application displays a pop-up menu, you can display the menu according to the pointer position. You can find the
location of the pointer:

◆ at the moment you are testing.
◆ when a mouse event, such as a click, occurs.

The position of the pointer is indicated by a list of two numbers in page units. For example, 1440,1440 indicates that the pointer is one inch below and to the right of the upper-left window border.

To determine where the pointer is in the current viewer, use the `mousePosition` window property. For example:

```plaintext
--Place this handler in the book script to display a graphic
--(group of objects) that follows the pointer around the screen
--when the user moves the mouse, imitating the Mouse Trails setting
--in the Windows Control Panel
to handle idle
  system INT svOldX, svOldY
  newX = item 1 of mousePosition of this window
  newY = item 2 of mousePosition of this window
  if (newX = oldX) and (newY = oldY) then
    hide group "arrow"    --No motion, hides the graphic
  else
    show group "arrow"    --Shows the graphic and moves it
    move group "arrow" to newX+50,newY+200
  end if
  oldX = newX
  oldY = newY
end idle
```

To move the pointer to a new location, set `mousePosition` to a new value:

```plaintext
mousePosition of this window = 1440,1440
```

You can also use the `<location>` parameter of mouse-event messages to determine the position of the pointer at the time the mouse-event
message is sent. For example:

--Put this handler in a page script
to handle buttonClick location
   request "You clicked at" && location
end

**Determining what the mouse pointer is over**

You can determine what object is under the mouse pointer when the user moves the mouse or clicks an object. For example, you can display a message in the status bar as the user moves the pointer over objects in your application. You can determine:

◆ what object the user has clicked.
◆ what object the user has moved the pointer over.

To determine what object a user has clicked, check the *target* property in a mouse-event handler, which contains the *uniqueName* of the clicked object. For example:

--Shows what object was clicked; place this handler in a book script
to handle buttonClick
   request "you clicked" && target
end

As a user moves the pointer over objects, ToolBook sends *mouseEnter* and *mouseLeave* messages to the objects when the pointer crosses their boundaries. As this example shows, you can write handlers for these messages at the page level and use the *target* property to determine what object the pointer is over.

--Displays the name of the object under the pointer in the status bar
-- as the user moves the pointer around the page

to handle mouseEnter
  if visible of statusBar is false then
    show statusBar
  end if
  caption of statusBar = target
end mouseEnter

-- Clears the status bar as the pointer leaves an object's bounds

to handle mouseLeave
  clear caption of statusBar
end

**Tip** When a user presses and holds the mouse button, *mouseEnter* and *mouseLeave* messages are not sent.

If you need to determine what object is under the pointer while a handler that is not a mouse-event handler is running, use the *objectFromPoint()* function, as shown on the following page.

-- This handler in the book script displays (in the status bar) the
-- name of the object under the pointer when the application is idle

to handle idle
  system oldObj -- Stores name of previous object
  if visible of statusBar is false then
    show statusBar
  end if
currentPos = mousePosition of this window
newObj = objectFromPoint(currentPos)
if oldObj is not newObj then
caption of statusBar = newObj
oldObj = newObj
end if
end idle

Determining and setting the location of the insertion point

You can determine the location of an insertion point in an editable field, set the location of the insertion point, and determine what text is next to the insertion point.

To get the location of an insertion point in an editable field, use the system property `caretLocation`, which returns a list of two numbers containing the textline and column location of the insertion point. For example:

"-- Displays location of the insertion point in a field called messages
-- when user leaves the current field; place this handler in the
-- script of a nonactivated (editable) field
to handle leaveField
   text of field "messages" = caretLocation
end"

To set the location of the insertion point, set `caretLocation` to a new value:

caretLocation = It

To determine what text is next to the insertion point in a field, record field, list box, or combo box, use the `textFromPoint()` function. This function returns a list of two numbers: one represents the textline number, and the other the character offset of the insertion
point. You can use the textline number returned by `textFromPoint()` with the `textline` operator to get the text of the line that the user clicked. For example:

```--Script for a list box that shows what line was clicked to handle buttonClick loc
   lineNumber = item 1 of textFromPoint(loc)
   chosenItem = textline lineNumber of text of field "listBox"
request chosenItem
end```

**Testing for mouse clicks within a script**

To respond to mouse events, you usually write handlers that respond to specific messages such as `buttonClick`. However, sometimes you need to test for mouse clicks or other mouse behavior in a handler for a nonmouse event. For example, you might start specific behavior when the user presses the mouse button, continue it while the mouse button stays down, and stop when the user releases the button.

You can use the `keyState()` function within a handler to determine whether a left or right mouse button is up or down. In the following handler from a game application, the “paddle” displayed on the screen moves either right or left, depending on which mouse button is down.

```--Place this handler in the page script to handle buttonStillDown if keyState(keyRightButton) is "down"```
Changing the mouse pointer

You can change the shape of the mouse pointer to alert a user to the current state of the system. For example, many applications use an hourglass to indicate activity in process and a crosshair for drawing. You can change the pointer by setting the value of `sysCursor`:

```
to handle sortPages
    saveCursor = sysCursor  --Saves current pointer
    sysCursor = 4  --Sets pointer to hourglass
    sort pages 1 to pageCount of this book by \ ascending number text of recordField "postcode"
    sysCursor = saveCursor  --Restores previous pointer
end
```

```
sysCursor = 14  --Sets pointer to a big arrow
```

For a complete list of the pointer types you can use, refer to the entry for `sysCursor` in the OpenScript reference in online Help.

You can also create a graphic pointer by assigning the value of an imported resource to `sysCursor`:

```
sysCursor = cursor "hand"
```
Handling keyboard events

By writing handlers for keyboard events, you can determine what keyboard keys the user has pressed and disable or change them, or route them to another object. For example, if the user enters a password in a record field, you can capture the characters as the user types them and display asterisks in their place.

About keyboard events and messages

Each time a user presses a key, including keys such as SHIFT and CTRL, ToolBook sends `keyDown` and `keyUp` messages. When a user presses a printable character, ToolBook also sends a `keyChar` message. With these messages, ToolBook sends the parameters: `<keyCode>`, `<isShift>`, and `<isCtrl>` to indicate which key was pressed and whether SHIFT and CTRL were also pressed. For example, the following handler displays keys in the status bar as they are typed:

```plaintext
to handle keyChar keyCode, isShift, isCtrl
    if visible of statusBar is false then
        show statusBar
    end if
    message = "key = " && keyCode
    if isShift is true then
        put space & "plus Shift" after message
    end if
    if isCtrl is true then
        put space & "plus Ctrl" after message
    end if
    caption of statusBar = message
    forward --Passes the keystroke to ToolBook
end keyChar
```
If the focus is in a field, combo box, or button when the user presses a key, ToolBook sends a keyboard-event message to the object. If the focus is not in a field, combo box, or button, ToolBook sends a keyboard-event message to the page. However, if a user presses an access key, or presses the SPACEBAR when the focus is in a button, ToolBook sends a `buttonClick` message instead of a keyboard-event message.

If the focus is in a field or combo box when a keyboard event occurs, the default response of ToolBook is to display the corresponding character. Otherwise, the default response is to do nothing, with these exceptions:

- If a user presses a menu accelerator key such as ALT+ARROW KEY (to navigate pages), CTRL+S (to save the current book), or F12 (to display the status bar at Reader level), ToolBook sends the corresponding menu-event message.
- If a user presses TAB, ToolBook moves the focus to the object on the next layer.

If you want to capture the effects of these keys, write handlers for the appropriate messages. For example, to disable the ALT+ARROW KEY combinations, write handlers for the `next` and `previous` messages.

**Note** You can define custom behavior for characters that are not associated with a menu item or button. For details, see “Defining access keys and custom behavior” later in this chapter.

When the user tabs between buttons and fields, the focus moves;
the target of the `KeyDown` message is the first object, and the target of the `KeyUp` message is the second object. Therefore, be sure to test which object has the focus when using a `KeyDown` or `KeyUp` handler.

**Tip** Typing in a field slows down if ToolBook has to call keyboard-event handlers before displaying characters. If you have a keyboard-event handler in a page script, typing will slow down for all objects on that page. Place handlers for keyboard-event messages as low as possible in the object hierarchy to affect the fewest number of objects.

### Deciding which keyboard-event message to handle

Whether you write handlers for the `keyChar` message or for the `KeyDown` and `KeyUp` messages depends on how much detail you need about what keys the user has pressed. These messages differ in:

- **what information is provided in the `<keyCode>` parameter that ToolBook sends with the keyboard-event message.**
- **the sequence in which the messages are sent.**

As a rule, use the `keyChar` message to write handlers that react to letters and numbers that a user types. Use `KeyDown` and `KeyUp` to write handlers that react to control, movement, or function keys, or that distinguish between when the user pressed and released the key.

### About values for the `<keyCode>` parameter

You can determine what key was pressed by checking the value of the `<keyCode>` parameter for a keyboard-event message. However,
ToolBook sends different `<keyCode>` values for the `keyChar` message and the `keyDown` and `keyUp` messages. For the `keyChar` message, the `<keyCode>` parameter:

- returns the ANSI value of the key the user pressed. For example, if the user types a lowercase `t`, the `keyCode` parameter for the `keyChar` message is 116; for an uppercase `T`, the value is 84.
- is not sent for keys that have no ANSI value, including control keys such as SHIFT, movement keys such as HOME, and status keys such as NUM LOCK. However, some control keys such as TAB and ENTER do have ANSI values, which `keyChar` returns.
- does not distinguish numbers on the number pad from those on the top row of the keyboard.

For the `keyDown` and `keyUp` messages, the `<keyCode>` parameter:

- returns values for control, movement, function, and status keys. For example, the `<keyCode>` value for SHIFT is 16; for the left arrow, 37; for F8, 119; and for NUM LOCK, 144.
- does not distinguish uppercase from lowercase values. For example, the `<keyCode>` value in a `keyDown` handler is 84 for both uppercase and lowercase `T`. However, you can distinguish uppercase from lowercase using the `<isShift>` parameter of the message, unless the CAPS LOCK key is on. You use the `get keystate (keyCapital)` command to determine if the CAPS LOCK key is on.
◆ returns an OpenScript constant value. For example, if the user types `t`, the value of the `keyCode` parameter for the `keyDown` message is `84`, and the value for a comma is `188`.

◆ distinguishes numbers on the number pad from those on the keyboard's top row. For example, the `<keyCode>` value in a `keyDown` handler for `5` on the number pad is `101`; for `5` on the top row, the value is `53`.

The following handler for a `keyDown` event converts the text of a field or record field to all uppercase when the user presses `SHIFT+F3`. Because the handler depends on detecting a function key, you cannot trap this key combination in a `keyChar` handler:

```plaintext
--Place this handler in a book
to handle keyDown key, isShift, isControl
   if object of target is not in "field,recordfield,listbox" then
      break
   end if
   if key is keyF3 and isShift is true
      text of target = uppercase(text of target)
   end if
   forward
end keyDown
```

For a list of ANSI values and key constant integers, refer to the “ANSI values” and “Key constants” topics in online Help.
About the sequence of keyboard-event messages

ToolBook sends the `keyDown` message when the user presses a key, and the `keyUp` message when the user releases it, so you can use these messages to write handlers that react separately to each portion of a keystroke. By contrast, ToolBook sends the `keyChar` message when the user presses a key, so you can use it to write handlers that react to complete keystrokes.

The following table shows the sequence of messages ToolBook sends when a user types `Shift+T`.

**Order of keyboard-event messages sent for a single keystroke**

<table>
<thead>
<tr>
<th>Action</th>
<th>Messages sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIFT pressed</td>
<td><code>keyDown 16</code>, <code>true</code>, <code>false</code></td>
</tr>
<tr>
<td>T key pressed</td>
<td><code>keyDown 84</code>, <code>true</code>, <code>false</code></td>
</tr>
<tr>
<td></td>
<td><code>keyChar 84</code>, <code>true</code>, <code>false</code></td>
</tr>
<tr>
<td>T key released</td>
<td><code>keyUp 84</code>, <code>true</code>, <code>false</code></td>
</tr>
<tr>
<td>SHIFT released</td>
<td><code>keyUp 16</code>, <code>false</code>, <code>false</code></td>
</tr>
</tbody>
</table>

PC keyboards are auto-repeating, so when a user holds down a key, ToolBook repeatedly sends `keyDown` and `keyChar` messages followed by a single `keyUp` message when the user releases the key.
Checking for keystrokes with an OpenScript statement

Ordinarily, if you want your application to respond when a user presses a key, you write handlers for the `keyDown`, `keyChar`, and `keyUp` messages. However, to check for keystrokes in a handler for a different event (such as a `buttonClick` event), use the `keyState()` function. For example:

```java
--This handler flips all pages in a book until the user presses
--Esc or clicks the left mouse button
to handle buttonClick
do
    flip
    until keyState(keyEscape) is "down" \
    or keyState(keyLeftButton) is "down"
end
```

Sending keyboard-event messages from a script

You can emulate keyboard activity by sending a keyboard-event message from a script. For example, in tutorial or demonstration applications, you can send keystrokes if the user wants to watch the lesson without typing.

To emulate keyboard activity, send the `keyChar` message. You don’t have to use the ANSI value for the `<keyCode>` parameter. Instead you can:

- use the `charToAnsi()` function. For example, to send a `keyChar` message for an uppercase `T`:

  ```java
  send keyChar charToAnsi("T"):true, false
  ```
substitute the OpenScript key constant for the character. For example, instead of typing `send keyChar 84, true, false` in a script, type:

```
send keyChar keyT, true, false
```

If the values of `<isShift>` and `<isCtrl>` conflict with the value of `<keyCode>` when you send a message with these parameters, ToolBook handles the message based on the value of `<keyCode>`. For example, the statement `send keyChar charTo Ansi("T"), false, false` inserts an uppercase “T” in the field that has the focus, even though the `<isShift>` parameter is `false`. If you omit the `<isShift>` and `<isCtrl>` parameters when sending a keyboard-event message, ToolBook assumes the parameters are `false`.

### Defining access keys and custom behavior

You can define access keys for your applications that allow users to access a menu, menu item, or button by pressing the ALT key plus another character. You specify the character to be used by placing an ampersand (&) before it in the menu, menu item, or button name. For menus and menu items, you specify this character using the `setMenuName()` and `setMenuItemName()` functions. For buttons, you specify this character using the `caption` property.

You can also define custom behavior for characters not already reserved by ToolBook. To define custom behavior for characters, write a handler for the `keyMnemonic` message and include a parameter to receive the ANSI value of the key pressed with the ALT key.
The handler in the following example defines ALT+PLUS SIGN and ALT+MINUS SIGN as controls to change the brightness of a background color.

--Uses ALT+PLUS SIGN and ALT+MINUS SIGN to lighten and darken the background
--color; place this handler in a book script to handle keyMnemonic keyCode
conditions
  when keyCode = 61 --PLUS SIGN
    vColor = fillColor of this background
    if item 2 of vColor <= 95 then --Must be < 100
      increment item 2 of vColor by 5 --Sets lightness
      fillColor of this background = vColor
    end if
  when keyCode = 45 --MINUS SIGN
    vColor = fillColor of this background
    if item 2 of vColor >= 5 then --Must be > zero
      decrement item 2 of vColor by 5
      fillColor of this background = vColor
    end if
  else
    forward
  end conditions
end keyMnemonic
Discarding pending keystrokes and mouse events

Users sometimes press keys or click the mouse while waiting for a process to finish. For example, if a user clicks a button to start an animation sequence but there is a short delay before it begins, the user might click the button again thinking that the first click did not work. ToolBook stores these extra keystrokes or mouse clicks and sends them when the process is finished. However, you can throw away extra keystrokes and mouse clicks so that they do not interfere with the application by using the `flushMessageQueue()` function. For example:

```plaintext
to handle buttonClick
    send runAnimation --Runs an animation sequence
    get flushMessageQueue() --Throws away pending keystrokes
end
```
Chapter 10

Managing data

Many applications involve data-management tasks such as formatting dates and similar data, validating user input, reading and writing files, and sorting and searching pages. This chapter describes how you can use OpenScript for these tasks.

- Formatting data .................................................. 199
- Validating data .................................................... 203
- Reading and writing to files ................................. 208
- Searching pages .................................................. 213
- Sorting pages ...................................................... 215
Formatting data

If you work with dates, times, and decimal or currency numbers, you can format the data to specify exactly how it should appear. Setting the format for these types of data allows you to:

◆ display the data in your choice of output formats. For example, you can display dates in a format such as Jan 1, 1993, or in another format.

◆ calculate correctly by converting the data to a format suitable for doing math. For example, you can strip all currency punctuation from a number before adding to it.

◆ compare values correctly by putting them into a consistent format.

Formatting data for output

Use the format command to convert dates, times, or numbers to a different format for display, as in this example:

```plaintext
totalValue = "2000000"
format number totalValue as "$0,0.00"
request totalValue -- Displays "$2,000,000.00"
```

For dates and times you must include the from clause with the existing format in the format command so that ToolBook can correctly interpret the date and time to be reformatted:

```plaintext
today = "31 December 07"
format date today as "mm/dd/yy" from "d M yy"
request today -- Displays "12/31/07"
```
The values of \textit{sysDate} and \textit{sysTime}, and the values of any variables declared with the \textit{date} or \textit{time} data types, are formatted automatically using the formats in \textit{sysDateFormat} and \textit{sysTimeFormat}:

\begin{verbatim}
sysTimeFormat = "h24:min"
request sysTime --Displays "18:00" (no seconds)
local date today
sysDateFormat = "m/d/y"
today = "9/30/07"
sysDateFormat = "M d, y"
request today --Displays "September 30, 2007"
\end{verbatim}

**Formatting data for calculating**

Convert numbers, dates, and times to a suitable format before attempting to use them in calculations.

**Formatting numbers for calculations**

Format numbers as \textit{null} before calculating. This converts the \textit{sysDecimal} character to a period and removes:

\begin{itemize}
  \item leading and trailing spaces.
  \item percent signs (%).
  \item the \textit{sysCurrency} character.
  \item the \textit{sysThousand} character.
\end{itemize}

Formatting a number as \textit{null} does not strip any other characters, so avoid using other characters for display. Commas are not valid.
in arithmetic calculations, but ToolBook can delete a comma from a number only if the comma is the value of `sysDecimal`, `sysThousand`, or `sysCurrency`. The following example illustrates how `format` is used before calculating:

```plaintext
vTotal = "$1,500.00"
format number vTotal as null       --Strips punctuation
vTax = vTotal * .15
format number vTax as "$0.00.00"
request vTax       --Displays "$225.00"
```

### Formatting dates and times for calculations

For arithmetic involving dates or times, use the `seconds` format. This formats a date as the absolute number of seconds from January 1, 1970, and a time as the number of seconds since midnight. Each day has 86,400 seconds, so you can add and subtract days as a multiple of this value:

```plaintext
--This example shows you how to add 30 days to today's date
local date dueDate
local date today
sysDateFormat = "seconds"       --Formats dates as seconds
today = sysDate                 --Puts today's date into the
                                --variable today
dueDate = today + (30 * 86400)  --Adds 30 days to the date
sysDateFormat = "m/d/y"         --Formats the date for output
request dueDate
```
For some date arithmetic, it is easier to use the string format of a date instead of formatting it as *seconds*, as long as you can exactly predict the format of the string. For example, using string operators with a date is often easier when you want to add a month to a date rather than exactly 30 days. In the example below, the date is formatted using a comma as a delimiter, making it easy to extract the month and then increment it.

```plaintext
sysDateFormat = "m,d,y"  -- Allows date to be a list
today = sysDate         -- Declares today as a date
thisMonth = item 1 of today -- Gets only the month value
thisYear = item 3 of today  -- Gets the year value
increment thisMonth     -- Increments the month
if thisMonth > 12 then
  thisMonth = 1
  increment thisYear   -- Adjusts if the month was December
end
dueDate = thisMonth & "." & item 2 of today & "." & thisYear
          -- Changes format back to slashes
format date dueDate as "m/d/y" from "m,d,y"
request dueDate
```

**Formatting data for comparisons**

Before you compare the values of dates, times, and numbers, you must make sure that the values to be compared are in the same format. Use the *as* clause in an *if* statement to establish the correct format for comparisons. For example:

```plaintext
-- Works if the string in record field "dueDate" matches
-- the format in sysDateFormat
dueDate = text of recordField "dueDate"
if sysDate > dueDate as date then
  request "Overdue!"
end
```
If you are comparing two values that ToolBook considers dates (`sysDate` and variables that are typed as `date`), ToolBook formats the dates using `sysDateFormat` and then does a character-by-character comparison between the two. As a result, you can compare any two dates, even if they were entered in different formats. For example:

```plaintext
local date vDate
local date vDate2
sysDateFormat = "m/d/y"  --Entered using one format
vDate = "4/18/97"  --Changes the format of all "date" data types
sysDateFormat = "M d, y"
vDate2 = "April 18, 1997"  --Entered using a different format
if vDate = vDate2 then  --Because both are dates the comparison returns true
    request "same!"
end
```

### Validating data

To prevent a user from entering inaccurate or incomplete information, you can write handlers that test for such errors and then help the user correct them. The general steps for data validation are:

1. Get the value that the user entered.
2. Test that the value is valid.
3. Respond to the user. For example, report errors.
4. If the data was invalid, reset the focus to the field where the user entered data, erase the invalid value, or otherwise make sure that the invalid entry is taken care of.
 Generally, the best time to check data is immediately after it is entered. Therefore, you usually validate data in `leaveField` or `leaveRecordField` handlers.

**Checking what the user entered**

ToolBook provides two general validation functions for checking values, `isType` and `isObject`. For example, you can check whether a user has entered an integer with statements such as these:

```plaintext
ask "Enter a number:"
if isType(int, It) is false
    request "Please enter an integer value."
end
```

For more specific checks, you must check for the exact values or types that you require. The following list provides some possibilities:

- **To check for dates:**
  ```plaintext
  if isType(date, text of self) is false then
      --Further statements here to specify action
  end
  ```
  
  **Note** For details about formatting dates, see “Formatting data” earlier in this chapter.

- **To check for one of several possible values:**
  ```plaintext
  get my text
  if It is not in "Monday, Tuesday, Thursday"
      --Further statements here to specify action
  end
  ```
To check for a specific number of characters or items:

```plaintext
get charCount(text of recordField "Amount" of page ID 3)
if It is not > 2 then
  --Further statements here to specify action
end

get itemCount(newPosition)
if It is not 2 then
  --Further statements here to specify action
end
```

To check whether a character, word, or textline is valid:

```plaintext
if textline 3 of recordField "City" is "Seattle"
  --Further statements here to specify action
end
```

**Using `sysError` for validation**

If you cannot check an exact value or data type, you can validate a user entry by attempting to use it in a predictable way, and then checking whether you generated an error. For example, if your application prompts the user to navigate to a particular page, your handler can attempt to go to the page that the user specifies and check whether ToolBook generates an error. If there is an error, your handler can indicate that the specified page is invalid.
To hide errors from the user, set `sysSuspend` to `false` before checking the data (but be sure to set it back to `true` as soon as possible). For example:

```
to handle buttonClick
    targetPage = text of field "where"
    clear sysError --Initialize to null
    sysSuspend = false
    go to page targetPage
    sysSuspend = true
    if sysError is not null then
        request "No such page number."
    end if
end buttonClick
```

**Responding to the user**

To inform the user of an error or to prompt for a correct response, use the `request` or `ask` command, as shown in the following example:

```
to handle leaveField
    get text of target
    if it is not null and isType(int,it) is false
        beep 1
        request "Please enter an integer value." with OK
    end if
    forward
end leaveField
```

When you display a dialog box with the `ask` or `request` command, it receives the focus. When the user closes the dialog box, the ToolBook default response is to set the focus to the last object that
had it before the dialog box was displayed—usually the field where the error occurred.

If you put data validation statements in `leaveField` or `leaveRecordField` handlers, it is a good idea to allow users a graceful way to leave the field without supplying correct data. To allow users to continue without fixing errors, set `sysSuspendMessages` to `true` so that you do not trigger the `leaveField` handler again, set the focus manually to another object or to `null`, and then set `sysSuspendMessages` back to `false`. For example:

```plaintext
to handle leaveField
  get text of target
  if isType(int,It) is false
    beep 1
    request "Please enter an integer value." with "OK" or "Cancel"
    if It is Cancel
      sysSuspendMessages = true
      focus = null
      sysSuspendMessages = false
      --Break to the end of this handler
      break
    end if
    --Break out of all handlers on the stack and hand
    --control back to the ToolBook system code
    break to system
  end if
  forward
end leaveField
```

You can also restore the field to the value it had before the user changed it. To do this, put the value of the field in a system variable or user property in an `enterField` handler. After validating the data, set the field to this value if the user chooses not to fix an entry error.
Reading and writing to files

OpenScript provides a number of commands that allow you to read and write directly to operating system files. You use these commands for writing custom import and export programs, or writing data out to disk to save memory. The OpenScript commands for reading and writing to files are:

- `createFile`  
- `seekFile`  
- `openFile`  
- `writeFile`  
- `readFile`  
- `closeFile`

Before you read or write to a file, you must open it. When you are finished with the file, you must close it to save pending data to disk and free memory and other system resources. For example:

```plaintext
to handle buttonClick
  vFileName = "c:\autoexec.bat"
  openFile vFileName
  readFile vFileName to EOF
  text of field "DOS File" = It
  closeFile vFileName
end
```

You can open up to 10 files in each instance of ToolBook.

Creating a new file

To create a new file, use the `createFile` command:

`createFile "myfile.txt"`
The `createFile` command both creates and opens the file, so you do not need to run a separate `openFile` command. If the file name you use matches an existing file, ToolBook overwrites the existing file.

**Tip** To avoid overwriting an existing file, verify that the file name is not in use by opening the file. If you get an error, the file does not exist, so you are free to use that name.

### Reading from a file

Using the `readFile` command, you can read a fixed number of characters from a file, or you can read through the file to a particular character, known as a delimiter. The syntax is:

```plaintext
readFile <file name> for <count>
readFile <file name> to <delimiter>
```

where `count` is the number of characters to read and `delimiter` is a character to which you want to read.

Delimiters can include any single character, including the constants `CR, EOF, LF, or quote`. The `readFile` command returns the data it has read in the variable `It`. This example shows how to read through a file in 40-character increments:

```plaintext
to handle buttonClick
  clear sysError
  fileName = "c:\temp\fixed.txt"
  openFile fileName
  --Checks if the file exists and was opened successfully
  if sysError is not null then
    request sysError
    break
```
When you read from a file, ToolBook maintains a pointer to your current location in the file. If you scan forward to a delimiter, ToolBook positions the pointer one character beyond the delimiter so that the delimiter is not included in the next string of data that is read. By default, the next `readFile` command will start from where the previous one left off. To reposition the file pointer, use the `seekFile` command. For details on the `seekFile` command, see “Moving to a set position within the file” later in this chapter.

**Writing to a file**

After you have opened a file, you can update it with the `writeFile` command. By default, the `writeFile` command appends data to the end of the file. For example:

```plaintext
-- This handler updates a log file every time the book is opened
to handle enterBook
clear sysError
fileName = "books.log"
openFile fileName
-- Checks that the file name exists and can be opened
```
If `sysError` is not null then
    -- If the file doesn't exist, create it (which also opens it)
    createFile fileName
end if
logEntry = name of this book & "," & sysDate & "," & sysTime & CRLF
writeFile logEntry to fileName
closeFile fileName
forward
end enterBook

If you want to write to a point before the end of the file, use `seekFile` to set the pointer to a particular position within the file. For details, see the next section, “Moving to a set position within the file.”

**Moving to a set position within the file**

Use the `seekFile` command to set the current position in the file you want to read or write to. For example, the following handler reads 40-character records from a file using `seekFile` to set the pointer to the appropriate position:

-- This script reads any record from a fixed-length ASCII file
to handle buttonClick
clear sysError
fileName = "C:\temp\fixed.txt"
openFile fileName
-- Checks that the file exists and was opened successfully
if sysError is not null then
    request sysError
    break
end if
recordLength = 40
done = false    -- Used as flag to quit the loop
-- Loops until user enters null as the record number
do
    -- Prompts the user to identify the record to read
    ask "What record number?"
    if It is null then
        done = true    -- Set quit flag to true
    else
        if IsType(int,It) then    -- Check for numeric input
            offset = (It-1) * recordLength
            seekFile fileName for offset from beginning
            readFile fileName for recordLength
            request It
        end if
    end if
end if
until done is true
closeFile fileName
end buttonClick

The seekFile command uses the variable It to return the position to which it has moved. To determine where the pointer is located, use statements such as these:

seekFile fileName for 0 from current    -- Does not move, but sets It
request It

To force the pointer to the end of the file (for example, to make sure that data is written to the end of the file), use this statement:

seekFile fileName for 0 from end
Searching pages

You can use the OpenScript search command to find text in a book, starting with the field or record field that currently has the focus. For example, the following statements search every visible field and record field on the current page:

```plaintext
--To search without displaying the ToolBook Search dialog box
to handle search
  clear sysError
  focus = null
  ask "Enter the text you want to search for:"
  searchText = It  --Set local variable to search string
                  --specified by user
  search page for searchText
  if sysError is not null
    request "Search text not found."
  end if
end search

Note ToolBook always skips list boxes and combo boxes when searching.

If a button has the focus, the search starts with the first field that follows the button in the layer order. To ensure that the search starts with the first field or record field on the current background, set focus to null before searching.

To search every field and record field of every page and background, use the statement search for searchText without specifying page, as in the example above. To search for the next occurrence of the search string, use search again. For faster searches, use excluding background, or specify the record fields you want to search.

search excluding background for searchText
search in recordField "Name", recordField "Middle Name" for searchText

When ToolBook finds matching text, it navigates to the page that contains that text. If the field can be edited, the text is selected.

search for searchText
if sysError is null
   --System property contains the selected text
   get selectedText
   --Further statements here to manipulate the found text
end

To search hidden fields, use locateOnly with the search command. For details, see the next section, “Searching without changing pages.”

**Searching without changing pages**

By default, when ToolBook finds text during a search, it navigates to the page where the text is and highlights the text. If you do not want to navigate to another page or select the found text, use locateOnly with the search command. This causes ToolBook to set the variable It to a value that shows where the text was found, rather than navigate to the page. The value in It is a comma-separated list containing the field ID, and the character positions of the beginning and ending letters that match the search text. For example:

search excluding background for searchText locateOnly
if It is null
    request quote & searchText & quote & "could not be found."
else
    -- Show where the text was found
    request "Found" & quote & searchText & \
    quote & "in" & item 1 of It
end

? For details about the search command, refer to the OpenScript reference in online Help.

**Sorting pages**

You can sort pages using the Sort Pages command on the Tools menu or the OpenScript sort command. The Sort Pages command is limited to sorting by record fields, but the sort command can sort pages by any expression that can be evaluated in the context of a page—for example, page name or page ID. You can also specify a range of pages with an expression—for example, page 5 to pageCount of this book:

to handle buttonClick
    sort pages 1 to pageCount of this book by text name of this page
end

You can specify multiple sort criteria, separated by commas. ToolBook sorts pages by the first criterion, the second criterion, and so on until all criteria are met.
The following example sorts a range of pages by two criteria:

```
to handle buttonClick
    sysCursor = 4      --Hourglass
    sort pages 2 to pageCount of this book by \\
        ascending text text of recordField "priority". \\
        ascending date text of recordField "Date Due"
    sysCursor = 1
end
```
Chapter 11

Using special effects

You can use OpenScript to include special effects such as animation, sound, and drag-and-drop behavior in your application. This chapter provides information on each of these techniques.

- Animating objects ........................................ 218
- Adding drag-and-drop behavior ....................... 232
- Creating sound effects .................................. 249
**Animating objects**

To animate objects, you change their position, size, or shape, or you display a changing set of pictures that give the illusion of motion. Use these techniques to animate objects:

- Move an object using the *move* command.
- Resize or change the shape of an object by changing its *size* property.
- Simultaneously move and resize an object by changing its *bounds* property.
- Change the shape and position of a draw object (such as a line or polygon) by changing its *vertices* property.
- Show and hide a series of objects in a stack, each of which is a slight variation on the same image.
- Flip pages, each of which contains a slightly different view of the same image.
Figure 1 Two techniques for animating objects in ToolBook

...or by flipping pages to show changing views.
Creating animation by moving objects

Use the move command to change the location of an object. You can move the object to specific locations on the page, or you can move it by a certain number of page units relative to its current location. If the location you indicate is outside the current window, the object will move off the screen and not be visible, but will still be available and respond to messages.

For example, the following handler for a draw object bounces the object off the bottom edge of the window. The exact value by which to adjust the bottom edge of the window depends on the shape of the object you want to bounce.

to handle buttonClick
    send sizeToPage --Sets window size
    bottomEdge = (item 2 of size of this book) - 700
    originalPos = item 2 of my bounds --Where object is now
    changeInPos = 100 --How much to move each time
    do
        move self by 0, changeInPos
        newBounds = my bounds
        if item 2 of newBounds > bottomEdge then
            changeInPos = -100 --Change object direction
        end if
    until item 2 of newBounds <= originalPos
end buttonClick
Changing the shape of an object

You reshape or resize an object by setting its bounds property, which changes the shape of its bounding box.

**Figure 2** Changing the shape of an object by setting its *bounds* property
For example, the following script changes the bounds of an object so that the object appears squashed before bouncing up again:

```lissajous
to handle buttonClick
    vMyBounds = my bounds
    -- Squash down the top
    step ctr from (item 2 of vMyBounds) to /
        (item 4 of vMyBounds) by 100
        item 2 of my bounds = ctr
    end step
    -- Bounce back up
    step ctr from (item 4 of vMyBounds) to /
        (item 2 of vMyBounds) by -100
        item 2 of my bounds = ctr
    end step
end buttonClick
```

You can make an object grow or shrink by moving the location of the upper-left or lower-right corners of its bounding box. The following handler causes an object to grow equally in all directions by changing the coordinates of its bounding box by an equal amount in each direction. The handler makes the changes to a local variable and sets the `bounds` properties to the value of the variable so that all four coordinates are updated simultaneously:

```lissajous
to handle buttonClick
    step ctr from 1 to 15
        vMyBounds = my bounds
        decrement item 1 of vMyBounds by 100
        decrement item 2 of vMyBounds by 100
        increment item 3 of vMyBounds by 100
        increment item 4 of vMyBounds by 100
        my bounds = vMyBounds
    end step
end buttonClick
```
Animating lines and curves by changing vertices

You can animate angled and curved lines by changing their vertices. This technique is useful to create graphs or move waves along a line. For example, the following handler changes a line into a zigzag, a straight line, and then a zigzag again:

to handle buttonClick
  zigZag = "400,3000,1200,2000,2000,3000,3300,1800"
  straight = "500,2500,1200,2500,2000,2500,2800,2500"
  move angledLine "ZigZag" to 500,2500
  vertices of angledLine "ZigZag" = zigZag
  pause 50
  vertices of angledLine "ZigZag" = straight
  pause 50
  vertices of angledLine "ZigZag" = zigZag
end

Figure 3 Changing lines or curves by setting their vertices properties
**Tip** To manipulate angled or curved lines, you must always provide the correct number of vertices. If necessary, use the function `itemCount` to determine how many points an object has.

**Creating animation by flipping pages**

To create animation that involves complex graphics such as bitmaps, you can place different views of the graphic on different pages and then move through the pages rapidly using the `flip` command. This is similar to the cel animation used to make cartoons.

**Figure 4 Creating the illusion of motion by flipping pages**

Create the illusion of motion by flipping rapidly through pages that each show a different view of an object.

For example, this handler uses the technique illustrated above:

```
handler buttonClick
  flip 3 pages
end
```
**Tip** You can use a viewer to flip pages for an animation sequence while displaying another page in the main window. This can be useful in a tutorial or demonstration application.

To make the animation sequence run smoother, preload the pages into memory to eliminate delay while ToolBook finds and loads the pages. To preload pages, set `lockScreen` (for a single viewer) or `sysLockScreen` (for all viewers) to `true` to prevent anything from showing on the screen, flip through the pages, and then set `lockScreen` or `sysLockScreen` back to `false`.

The following handlers illustrate this technique. The `enterBook` handler defines a system variable called `svFirstTime` that is set to `true` the first time the book is opened. When ToolBook enters the background of the page that contains the animation, an `enterBackground` handler checks to see if this is the first time the book has been opened. If it is, the handler flips the pages.

```
to handle enterBook
    --Creates flag to check in enterBackground handler
    system svFirstTime
    svFirstTime = true
    forward
end

to handle enterBackground
    system svFirstTime          --Checks flag set in enterBook
    if svFirstTime is true
        sysLockScreen = true     --Freezes screen
        flip 3 pages
        sysLockScreen = false    --Unfreezes screen
    end if
    forward
end enterBackground
```
Optimizing animations that flip pages

To increase the speed of page-flipping animation:

✦ Build the sequence of images on the same background. Changing backgrounds takes extra time.

✦ Keep page size as small as possible so that ToolBook has less to display and can display pages faster.

✦ Keep the number of objects on the pages to a minimum.

✦ Set the system variable `sysHistoryRecord` to `false` so that ToolBook does not keep a record of each page visited.

✦ Set the system variable `sysSuspendMessages` to `true`, which avoids the overhead of `enterPage`, `enterField`, or `enterButton` messages.

If the screen seems to flicker when animated objects move, the `drawDirect` property of each object is set to `true`. To help eliminate flicker, set `drawDirect` to `false` for animated objects.
Creating animations by showing and hiding objects

You can animate an object by creating a series of objects that are each a variation on that object, and then showing and hiding the variations one by one.

Figure 5  Animating an object by showing and hiding a series of objects

For example, the following handler shows a succession of six objects by first showing one and then hiding the previous one.

to handle buttonClick
step ctr from 1 to 6
if ctr < 6 then
    show ellipse (ctr + 1) -- Shows next view
end if
hide ellipse ctr -- Hides the current one
Creating handlers for animation

To start an animation, you must trigger it with an event. Events that you can use to trigger animation sequences include:

- **Button-click events** (*buttonClick, buttonUp*) Use a button-click event to set off an animation sequence that should occur under the control of the user.

- **Enter events** (*enterPage, enterBook*) Use an enter event to trigger an animation sequence that starts automatically when the user opens a book or navigates to a page.

- **Idle event** (*idle*) Use an idle event to create animation that runs continuously, but that can be interrupted when the user interacts with other objects on the page.

- **Timer events** (*timerStart, timerNotify*) Use a timer event to trigger an animation sequence that starts automatically after a specified period of time.

When you design a handler to trigger an animation sequence, consider how the animation will run in the application. If the animation sequence is completely contained in a handler, the user will not be able to interrupt the sequence unless the handler also checks for an ESC key or a button click.

If you use an *enterPage* or *enterBackground* handler to trigger an animation sequence, the sequence will run each time the user...
navigates to the page. This might annoy users as they move from page to page, especially if the animation is lengthy. To prevent an animation sequence from running each time a user enters a page or background, build in conditions. For example, create a condition that runs the animation only the first time the user enters the page or background.

**Linking animation to an idle handler**

You can use an *idle* handler to run an animation sequence whenever a user is not working with an object on the current page. For example, you can have an animated corporate logo that changes as long as the user is not clicking the mouse or typing characters.

If you run animation sequences from an *idle* handler, be sure not to run the complete animation each time the handler is called, or no time will be left for other events to occur. One way to design animation for an *idle* handler is to put each step of the animation process in a single execution of the *idle* handler, and to keep the execution time of each step as short as possible. That way, ToolBook can check between each *idle* handler execution to see if there are any pending messages, such as button clicks or menu selections.

The handler for an animation sequence can store its current state in a user property or system variable, so the next time ToolBook sends an *idle* message, the handler can continue from that point in
the animation sequence. For example:

```plaintext
--Hides and shows an object to animate it; each time the handler
--is called, it hides and shows one view of the object

to handle idle
  system ctr
  if ctr = null then
    ctr = 1
  end if
  if ctr < 6
    show ellipse (ctr + 1)
    hide ellipse ctr
    increment ctr
  else
    ctr = 1
    show ellipse "1"
    hide ellipse "6"
  end if
  pause 10 --Delay animation for 1/10 second
  forward
end idle
```

### Initializing and cleaning up animation sequences

When you run an animated sequence, you should initialize and clean up the sequence properly. For example:

- Place an object at a known location before starting an animation sequence that moves it.
- Show the proper starting view of an object that has multiple views, hiding the other views.
- Set the bounds of an object to their proper size before changing them to show the object growing or shrinking.
You can handle initialization and cleanup tasks in the handler that runs the animation sequence. However, if you want an entire page to be displayed correctly when the user navigates to it, place the initialization in an `enterPage` or `enterBackground` handler. You can also use an `enterPage` handler to perform any cleanup tasks on the page you are leaving, or you can write a `leavePage` handler that restores the page to its normal state before the user moves to the next page.

**Controlling animation speed**

If the animation effect you are creating runs too quickly, you can slow it down using a `pause` statement between portions of the animation sequence. For example:

```plaintext
to handle buttonClick
    step ctr from 1 to pageCount of this book
    flip
    pause 5 ticks
end step
end
```

Note that if the delay between the stages in an animation sequence is too great, it will appear jerky.

**Creating smoother animations**

A number of factors control how smoothly an object moves, changes shape, or redraws. Use these guidelines:

- Large jumps in location make the motion of an object appear jerky.
Setting the `drawDirect` property of an object to `false` reduces the flicker caused by redrawing directly on the screen.

The simpler the object, the smoother the motion. For example, a single rectangle moves more smoothly than a group of objects.

Transparent objects and objects with rounded corners display more slowly than other objects.

The viewer you use to display an animation sequence should use at least one image buffer. If the animation sequence also changes objects on the background, it should use two image buffers.

## Adding drag-and-drop behavior

In ToolBook, you can define a special effect called drag-and-drop for your applications. With drag-and-drop, you can click an object (called the source object), drag an image representing the source object to another location, and release the image on another object (called the destination object).

While you are dragging, a drag image (usually an icon) moves around the screen to show where the mouse pointer is. If you drag the image over an object that cannot be a destination object, a no-drop image (often a circle with a line through it) appears.

For example, in Figure 6 on the following page, the playing piece of a backgammon game is the source object and each triangle is a destination object. When a player clicks and drags a game piece, ToolBook displays a drag image to indicate where the piece moves. When the player releases the mouse, the application moves the game piece to its new location. If the player tries to drag outside the game area, ToolBook displays a no-drop image to indicate that the user is not allowed to drop a piece in that location.
In ToolBook, you can use drag-and-drop behavior to create a mouse-driven visual interface for many tasks and actions. Some uses might be to drag:

- items to a wastebasket to delete them.
- symbols onto a calendar to represent appointments, birthdays, or reminder alarms.
- game pieces around a board, as in a chess or card game.

ToolBook simplifies defining drag-and-drop behavior by including special properties and messages. When a user drags an object,
ToolBook automatically displays the correct image (drag or no-drop), sends notification that a drag operation has begun or ended, and identifies the source and destination objects.

During a drag-and-drop operation, ToolBook does not actually change anything in your application—for example, it does not move an object as you drag it. You must write a handler to define what happens when the mouse button is released, such as deleting the source object, moving it, or changing its color.

You can drag any object that you can place on a page, including pictures or paint objects that you have imported. ToolBook allows you to drag objects within a viewer or from one viewer to another. You cannot drag a page, background, or book, although pages can be destination objects.

**Defining basic drag-and-drop behavior**

To define drag-and-drop behavior, you must:

- identify the source object. When a user clicks the source object, ToolBook initiates the drag-and-drop operation.
- identify at least one destination object so that there is a place to drop the source object. The destination object can be the page itself.
- write a handler for an `endDrag` message to define what happens when a user releases the drag image over a destination object.

You can also initiate drag behavior using the OpenScript `drag` command. This gives you the flexibility to trigger a drag operation using an event other than clicking the source object, or to drag
objects that cannot be clicked, such as groups. For details, see “Using the *drag command*” later in this chapter.

**Identifying source and destination objects**

You can identify the source object for a drag-and-drop operation by setting its `defaultAllowDrag` property to `true`. Right-click the object, choose Drag & Drop from the shortcut menu to display the Drag & Drop dialog box, and then select Allow Drag. When this property is `true`, ToolBook initiates drag-and-drop behavior whenever the user clicks the object.

To identify a destination object, set its `defaultAllowDrop` property to `true` by checking Allow Drop in the Drag & Drop dialog box of the object. When this property is `true`, ToolBook sends an `endDrag` message to the object when the user drops it. If the `defaultAllowDrop` property is `false`, ToolBook displays the no-drop image when the user moves the drag image over the object, and sends no messages if the user releases the mouse button over the object.

You can also determine conditionally whether objects can be source or destination objects. For example, in a chess game, you can determine whether squares on the chessboard can be destination objects depending on what piece the player is moving. To create source and destination objects conditionally, write handlers for the `allowDrag` and `allowDrop` messages. For details, see “Specifying source and destination objects conditionally” later in this chapter.

**Creating an endDrag handler**

If the user releases the mouse button while the drag image is over a destination object, ToolBook sends an `endDrag` message to the
source object. Write a handler for this message to define the result of the drag-and-drop operation. For example, in a chess application, if the user releases the drag image over a square, an `endDrag` handler moves the game piece and defines related behavior, such as removing other game pieces from the board.

To illustrate drag-and-drop behavior, create an application that allows a user to delete objects at Reader level by dragging the objects to a wastebasket graphic. Create an object named "wastebasket" and set its `defaultAllowDrop` property to `true`. Then, create a number of additional objects and set their `defaultAllowDrag` properties to `true`. Put the following handler in the script of the page or book:

```plaintext
to handle endDrag destinationObject, loc, targetWindow
    if destinationObject is not null then
        if name of destinationObject is "wastebasket" then
            clear target  --Deletes the source object
        end if
    end if
end if
end endDrag
```

ToolBook passes the `uniqueName` of the destination object to the `endDrag` handler, along with the location of the drag image relative to the viewer in which the object is dropped. These two parameters allow you to identify which object receives the drop and where the drag image is when the mouse button is released. If the user releases the mouse button over an object that will not accept a drop, the `<destination object>` parameter is `null`. In an `endDrag` handler, `target` refers to the original source object.
OpenScript elements for drag-and-drop operations

The following tables specify properties, commands, and event messages that relate to drag-and-drop behavior.

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>defaultAllowDrag</td>
<td>Specifies whether an object can be dragged</td>
</tr>
<tr>
<td>dragImage</td>
<td>Image (icon, cursor, or bitmap) displayed during a drag operation when the object under the cursor can accept a drop</td>
</tr>
<tr>
<td>noDropImage</td>
<td>Image (icon, cursor, or bitmap) displayed during a drag-and-drop operation when the object under the cursor will not accept a drop</td>
</tr>
<tr>
<td>defaultAllowDrop</td>
<td>Specifies whether an object that is the destination of a drop can accept the drop</td>
</tr>
</tbody>
</table>
### Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>drag</td>
<td>Starts drag-and-drop behavior from within a script as if the user had initiated it with the mouse. The drag can be confined within a specified rectangular area</td>
</tr>
</tbody>
</table>

### Event messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>beginDrag</td>
<td>Sent to the dragged object when a drag event begins</td>
</tr>
<tr>
<td>endDrag</td>
<td>Sent to the dragged object when the mouse button is released; signals the end of a drag event</td>
</tr>
<tr>
<td>enterDrop</td>
<td>Sent to an object if its defaultAllowDrop property is true or if an allowDrop handler returns true when the mouse cursor enters its bounds during drag mode</td>
</tr>
<tr>
<td>leaveDrop</td>
<td>Sent to a destination object when the mouse cursor leaves its bounds during drag mode</td>
</tr>
<tr>
<td>objectDropped</td>
<td>Sent to a destination object when a dragged object is released over its bounds</td>
</tr>
<tr>
<td>stillOverDrop</td>
<td>Sent to the destination object continuously during a drag event when it is positioned under the drag image; similar to buttonStillDown</td>
</tr>
<tr>
<td>allowDrag</td>
<td>Sent to the source object to determine whether that object can be dragged; if a to get allowDrag handler for this message is not found, ToolBook checks the defaultAllowDrag property of the source object</td>
</tr>
<tr>
<td>allowDrop</td>
<td>Sent to the destination object to determine if the object will accept the drop; if a to get allowDrop handler is not found, ToolBook checks the defaultAllowDrop property of the object</td>
</tr>
</tbody>
</table>
Properties of objects

<table>
<thead>
<tr>
<th>Object</th>
<th>Drag-and-drop properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>All draw objects and hotwords</td>
<td>defaultAllowDrag, defaultAllowDrop, dragImage, noDropImage</td>
</tr>
<tr>
<td>Group</td>
<td>dragImage, noDropImage</td>
</tr>
<tr>
<td>Page</td>
<td>defaultAllowDrop</td>
</tr>
<tr>
<td>Background</td>
<td>none</td>
</tr>
<tr>
<td>Book</td>
<td>none</td>
</tr>
<tr>
<td>Viewer</td>
<td>none</td>
</tr>
</tbody>
</table>

Specifying source and destination objects conditionally

Instead of relying on the defaultAllowDrag and defaultAllowDrop properties, you can add case-by-case control over whether an object can be dragged or will allow a drop. For example, in a game application you might prohibit a drop on a square if the player is trying to make an illegal move. To define a source object conditionally, write a to get handler for the allowDrag message. To define a destination object, write a to get handler for the allowDrop message.

When the user clicks an object, ToolBook sends an allowDrag message to the target object.
If the `allowDrag` handler returns `true`, ToolBook begins a drag-and-drop operation.

If the `allowDrag` handler returns `false`, the object cannot be dragged and ToolBook sends a `buttonClick` message.

If there is no `allowDrag` handler in the hierarchy of the object, ToolBook uses the value of the `defaultAllowDrag` property of the object to determine whether to begin a drag-and-drop operation.

The following example shows how to use a `to get` handler to determine whether an object can be dragged:

```plaintext
--This handler allows an object to be dragged if the user is an administration user, as determined elsewhere in the application;
--place this handler in the script of the source object
to get allowDrag
   system userLevel --System variable set elsewhere
   if userLevel is "Admin"
     return true
   else
     return false
   end if
end allowDrag
```
You can also use a *to get* handler to determine whether an object will allow a drop. When the user moves the drag image over an object, ToolBook sends an *allowDrop* message to the object. If there is a *to get* handler for the *allowDrop* message and it returns *true*, the object can be a destination object. If the *to get* handler returns *false*, the object cannot be a destination object and ToolBook displays the no-drop image. If there is no *to get* handler for the *allowDrop* message in the hierarchy of the object, ToolBook checks the value of the *defaultAllowDrop* property of the object. For example:

```plaintext
-- This handler allows a drop if the source object is named reportList;
-- place this handler in the script of the destination object
to get allowDrop sourceObject
    if name of sourceObject contains "reportList" then
        return true
    else
        return false
    end if
end allowDrop
```

**Using the *drag* command**

Use the *drag* command to begin a drag operation from within OpenScript. This command is the equivalent of clicking the source object—the drag image appears and the *beginDrag* message is sent to the source object. From that point the user can move the mouse to drag the source object.

The drag operation ends when a user clicks the left mouse button—that is, when the next *buttonUp* message is sent. Use the *drag* command to initiate a drag operation for objects that cannot be
clicked directly, such as groups, or to trigger the drag operation using an event other than \textit{buttonDown}. For example:

```
--Handler that begins a drag operation when a user clicks the right mouse button to handle rightButtonDown
drag paintObject "alarmClock"
end
```

You can constrain the area in which the drag operation takes place, but only if you use the \texttt{drag} command. To constrain a drag-and-drop operation, add the keyword \texttt{within} and a list of four integers in page units that define the area. For example:

```
--Stays in upper-left corner
drag rectangle "colorBar" within "1000,1000,4000,4000"
```

**Forcing an object to accept a drop (silent dragging)**

Silent dragging works independently of the \texttt{allowDrop} and \texttt{defaultAllowDrop} values of the destination object. For example, you might have an application such as a clip art window from which the user can drag images. In this case, you want to allow the source object to be dropped on a destination object regardless of what the \texttt{defaultAllowDrop} property of the destination object is or what an \texttt{allowDrop} handler returns.

During silent dragging, ToolBook does not send \texttt{allowDrop}, \texttt{enterDrop}, or \texttt{leaveDrop} messages. ToolBook still sends the
beginDrag and endDrag messages to the source object, and always displays the drag image.

You can initiate silent dragging only by using the OpenScript drag command and adding the keyword silently to the drag command. For example:

```
drag picture "artClip" silently
```

For details, refer to the entries for allowDrag, allowDrop, beginDrag, defaultAllowDrag, defaultAllowDrop, and enterDrop in the OpenScript reference in online Help.

**Working with mouse-event messages for drag-and-drop operations**

During a drag-and-drop operation, ToolBook sends drag-and-drop messages instead of the usual mouse or button messages. For example, when the user clicks a source object, ToolBook sends a beginDrag message instead of a buttonDown message. The following table shows the sequence of messages sent for a drag-and-drop operation.
### Order in which drag-and-drop messages are sent

<table>
<thead>
<tr>
<th>Event</th>
<th>Message</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>User clicks an object</td>
<td>allowDrag</td>
<td>Source object</td>
</tr>
<tr>
<td>User has clicked object with allowDrag returning true or defaultAllowDrag set to true</td>
<td>beginDrag</td>
<td>Source object</td>
</tr>
<tr>
<td>Mouse cursor enters bounds of a destination object</td>
<td>allowDrop, then enterDrop</td>
<td>Object under drag image</td>
</tr>
<tr>
<td>Mouse cursor is over a destination object</td>
<td>stillOverDrop</td>
<td>Object under drag image</td>
</tr>
<tr>
<td>Mouse cursor leaves destination object</td>
<td>leaveDrop</td>
<td>Object under drag image</td>
</tr>
<tr>
<td>Mouse button is released over destination object</td>
<td>objectDropped</td>
<td>Destination object</td>
</tr>
<tr>
<td></td>
<td>endDrag</td>
<td>Source object</td>
</tr>
</tbody>
</table>

The user can bypass drag-and-drop behavior for an object by double-clicking the object. This prevents ToolBook from initiating a drag-and-drop operation. Instead, ToolBook sends a buttonDoubleClick message, followed by the normal buttonStillDown messages if the user holds down the mouse button, followed by single buttonClick and buttonUp messages.

Because ToolBook still sends buttonStillDown, buttonClick, and buttonUp messages when the user double-clicks the object, you do not have to change any scripts that handle these messages. A handler for buttonClick or buttonUp still runs, but only if the user double-clicks the object. The only message that is not sent for a draggable object is the buttonDown message.
Testing the start of a drag operation

If you need to initialize variables or properties, or perform other operations when a drag-and-drop operation begins, write a handler for the `beginDrag` message. For example, you can store the current state of the position, color, and so on of the object in system variables when the drag operation begins so you can compare them to changed values later when the `endDrag` message is sent.

Changing drag and no-drop images

You can change the images that ToolBook displays when you drag an object or cross over an object that will not accept a drop. To use a custom drag or no-drop image, assign an imported cursor, icon, or bitmap resource to the `dragImage` and `noDropImage` properties using the Drag & Drop dialog box of the object. Or, use OpenScript statements such as these:

```
dragImage of field "list" = icon ID 101
noDropImage of field "list" = icon ID 102
```

If you set the `dragImage` or `noDropImage` property to `null` or choose None for these settings in the Drag & Drop dialog box of the object, ToolBook uses the default drag and no-drop images.

**Figure 7 Default drag and no-drop images**

```
Default drag image  Default no-drop image
```

245
Dragging between Reader and Author levels

The behavior of objects dragged between viewers at Author and Reader levels is the same. For example, you can drag clip art from one viewer at Reader level into another at Author level.

Dragging fields

As with other objects, you can define drag-and-drop behavior for fields, list boxes, and combo boxes by setting the `allowDrag` property to `true` or by writing an `allowDrag` handler. However, if you do so, you change the ToolBook default response to the left mouse button click, which is to highlight a line in a list box, select an item in the drop-down list of a combo box, or move the insertion point in an editable field.

To retain the ToolBook default behavior for a left mouse button click, you can set `allowDrag` to `false` or return `false` from an `allowDrag` handler and trigger the drag behavior using a different event. In a list box, you can set `allowDrag` to `false` and use a handler for the `buttonDown` message to execute the `drag` command. When you click a line in the list box, the highlight moves and a drag event begins. For example:

```%

to handle buttonDown
    drag target
end
%
```

You can also use a `to get allowDrag` handler to determine the state
of a field and start a drag operation accordingly. For example, an allowDrag handler for an editable field can return true if there is selected text; if no text is selected, the allowDrag handler returns false, which retains the ToolBook default editing behavior in the field.

For details about using the drag command, see “Using the drag command” earlier in this chapter.

**Dragging groups**

If a user clicks a draggable object in a group, ToolBook starts a drag operation for that individual object, not for the group. You can assign a drag image to a group, but groups do not have defaultAllowDrag or defaultAllowDrop properties, nor does ToolBook ever send them allowDrag or allowDrop messages.

If you want to drag a group, use the OpenScript drag command. You can trigger the drag command using any event, such as the buttonDown event. For example, put this handler into the script of the group to initiate dragging when the user clicks anywhere in the group:

```
to handle buttonDown
    drag self
end
```

However, if the defaultAllowDrag property for the component of the group that receives the buttonDown message is true, the drag-and-drop behavior of that component takes priority for the group. If you want to create a group that you can drag but that also includes independently draggable objects, put a to get allowDrag handler in the group script. Be sure there is not already an allowDrag handler in the script of the component object that is clicked. This handler
can then determine whether the drag operation applies to the component or to the group. The group itself will not be the target for an allowDrag message, but the allowDrag message will pass up the hierarchy to the group.

For example, you can create a button palette by grouping a number of buttons on top of a rectangle while leaving some space between the buttons where you can click with the mouse. You can then click the buttons to get their drag behavior, or between the buttons (but still within the group) to initiate the drag behavior of the group.

**Figure 8** Dragging individual objects or an entire group

Use a handler such as the following in the group script:

to get allowDrag
    if target contains "button" then
        return true
    else
        drag group "buttonPalette" --Use the name you have assigned
        return true
    end if
end allowDrag
Creating sound effects

You can create sound effects in ToolBook by incorporating sound files or using the beep command. For example:

to handle buttonClick
    if pageNumber of this page < pageCount of this book then
go next page
    else
        beep 1 --Specify number of times to beep
        request "Last page."
    end if
end buttonClick

If your computer has a sound card and the appropriate media control interface (MCI) sound driver installed, you can play wave-audio (WAV) files. For example, you can add recorded sound to your books for extended sound effects or short voiceovers. To play wave-audio files, use the playSound() function:

to handle buttonClick
    get playSound("c:\windows\chimes.wav")
    request It
end

The playSound() function has an optional second parameter, <wait>, that determines whether ToolBook waits for the sound to complete before continuing with the next command in the handler. If the value of <wait> is false (the default), ToolBook returns immediately, and the sound plays asynchronously. For example, you can launch a voiceover that will play while the handler continues. If the value of <wait> is true, ToolBook suspends the handler until the sound has finished.

The playSound() function returns true immediately if the wave-audio
file is available; otherwise, it returns false. For example:

--Asks user which sound file to play and then plays it
ask "What sound do you want to play?"
--Returns immediately because the wait parameter is false
get playSound(It,false)
if not It
    request "File not found."
end

To stop the sound while it is playing, call playSound( ) and pass it null:

to handle buttonClick
    get playSound("toolbook\samples\dbeat1.wav",false)
    pause 2 seconds
    get playSound(null) --Stops the sound file
end

Note The playSound( ) function works best with wave-audio files smaller than 100 KB.
Chapter 12

Using dynamic data exchange

With dynamic data exchange (DDE), you can add the capabilities of other Windows applications to ToolBook. You can exchange information with another Windows application, or even control other applications from within ToolBook. This chapter describes how to use DDE with ToolBook.

About dynamic data exchange ...................... 252
Using ToolBook as a client .......................... 254
Using ToolBook as a server ......................... 261
About dynamic data exchange

Dynamic data exchange (DDE) is a Windows communications protocol that you can use to exchange data between Windows applications or to execute commands in other Windows applications. DDE integrates Windows applications so that they can use each other’s features.

A DDE conversation consists of two or more applications passing Windows messages back and forth. The client application initiates the conversation, and the server application responds to the requests of the client.

The client initiates a conversation with the server by addressing it by its server name. For example, the ToolBook server name is ToolBook. The client can also specify a topic, which is either a general classification of data that the two applications will exchange, or a server file name. In general, a typical DDE conversation goes like this:

1. The client initiates a conversation.
2. The server responds.
3. The client and server exchange data or execute commands. For example:
   - The client requests data from the server and the server sends data.
   - The client sends data to the server without the server requesting it.
   - The client requests that the server execute a command.
4. The conversation is terminated by either the client or server.
Both applications must support DDE to exchange information, and both must be open before the exchange can begin. In a DDE conversation, the same application can be both client and server. For example, one instance of ToolBook can talk to another instance of ToolBook.

If you are using DDE to return data, each exchange between a client and server sends and receives a single piece of information. For example, you can use DDE to remotely set the text of a field, but not to set the text of a whole collection of fields at once.

For details about DDE, refer to the Microsoft Windows SDK. For details about the server and topic names of an application, refer to the documentation for the application.

Using dynamic data exchange with ToolBook

In ToolBook, DDE is built into a set of OpenScript messages: closeRemote, executeRemote, getRemote, keepRemote, remoteCommand, remoteGet, remoteSet, and setRemote. To use DDE, you need a copy of the program you want to exchange data with, and you need to know what DDE syntax the program expects.

For details about OpenScript DDE commands and messages, refer to their entries in the OpenScript reference in online Help.
You can use the OpenScript DDE commands to exchange text data with other DDE-enabled applications or other ToolBook applications. Figure 1 on the following page shows how OpenScript commands are automatically translated into DDE messages.

**Note** Some applications can establish permanent data links using WM_DDE ADVISE and WM_DDE UNADVISE messages. These DDE messages have no effect in ToolBook because ToolBook cannot establish permanent data links.

### Using ToolBook as a client

When ToolBook is the DDE client, you use the `getRemote`, `setRemote`, and `executeRemote` commands to exchange data with and execute commands in the server application. For example, you can use Microsoft Excel for mathematical functions and data maintenance, and access that data from ToolBook. You can also use DDE to make changes to the Excel spreadsheet or execute Excel commands from within ToolBook.

In general, to use ToolBook as a DDE client:

1. Open the server application with the `run` command.
2. Exchange data with and execute commands in the server application using the `getRemote`, `setRemote`, and `executeRemote` commands.
3 Determine the success of each DDE request by checking the value of the `sysError` property.

4 If necessary, keep the DDE channel open with the `keepRemote` command, or explicitly close it with the `closeRemote` command.

The following sections go into more detail about each step.

**Opening the server application**

To open the server application, use the OpenScript `run` command, specifying the application and file name. Include the full path of the application if it is not in your DOS path. If you do not want to see the application on the screen when you run it, use the keyword `minimized` with the `run` command. In the same handler, call the `yieldApp()` function to ensure that the application is initialized and ready to receive DDE commands. For example:

```plaintext
--Put this handler in the book script to handle enterBook
run "excel.exe budget.xls" minimized
get yieldApp()

--Statements here to handle errors if Excel is not running
--Statements here to handle the DDE conversation
forward
dend enterBook
```

For details about the `yieldApp()` function, refer to the OpenScript reference in online Help.
If the server application is already running, executing a `run` command will usually start a second instance of the application. To check whether the application is already running, send it a DDE command and examine the value of `sysError`. For details, see “Checking for errors” later in this chapter.

**Exchanging data and executing commands in the server application**

You use the `getRemote`, `setRemote`, and `executeRemote` commands to exchange data with and execute commands in a DDE server application.

To request an item from a server application, use `getRemote` and specify the item, server application, and topic. For example:

```
--Requests Excel data stored in a range named Regional_Totals
--Excel returns tab-delimited text in the Windows CF_TEXT format
to handle buttonClick
    getRemote "Regional_Totals" application "excel" topic "regions.xls"
    put It into text of field "summary"
end
```

To set an item in a server application, use `setRemote` and specify the value to give the item, the server application, and the server topic. For example:

```
--ToolBook is DDE "middle man" between WinWord and Excel
to handle buttonClick
    getRemote "StockPrices" application "excel" topic "portfolio.xls"
    put CRLF & text of field "old prices" after It
```
--In the next statement, "prices" is a WinWord bookmark  
setRemote "prices" to It application "winword" topic "annlrept.doc"
end

To execute commands in the server application, use executeRemote  
and specify the commands, the server application, and the server topic. For example:

--Size and move the Excel window with Excel macro commands  
--The square brackets are required by Excel  
executeRemote "[app.restore()][app.size(481,190)][app.move(1,172)]" \  
    application "excel" topic "system"

Checking DDE commands before sending them

Because DDE commands often involve long strings that can be  
difficult to get right, you can build the DDE command out of shorter,  
more manageable pieces, preview it with the request command, and  
then run it with the execute command. For example:

--Builds a DDE command out of individual pieces to handle buttonClick  
ddeCommand = "executeRemote" --DDE command to be run  
ddeParameters = null --Parameter string for the command  
put "[app.restore()]" after ddeParameters  
put "[app.size(481,190)]" after ddeParameters  
put "[app.move(1,172)]" after ddeParameters  
ddeTopic = "application excel topic system"  
ddeExecute = ddeCommand && ddeParameters && ddeTopic  
request ddeExecute --Previews the command  
execute ddeExecute --Runs the command  
request sysError
end
Checking for errors

After executing a DDE command, immediately check the value of `sysError` to determine whether the command was successful. If the first item of `sysError` contains something other than OK, then the DDE command failed. Most failed commands are caused by incorrect syntax for the server application in the `<command>` parameter. The possible `sysError` values resulting from a DDE command are:

- **OK**: The application responded to the request. (For `getRemote` and `setRemote`, the requested data is put into `It`.)
- **Failed: Busy** The application responded but was occupied and failed to perform the requested action.
- **Failed: Denied** The application responded but could not or would not satisfy the request.
- **Failed: Memory Error** ToolBook did not have enough global or local memory to generate the request or accept a response.
- **Failed: Interrupted** The application responded, but the connection was broken before the application acknowledged the command.
- **Failed: No Server** No application responded to the request.

You should include statements in your scripts to respond to errors based on the value of `sysError`. For example:

```lisp
--This handler checks to see whether a ToolBook application
--is running by testing its response to a DDE query
to get isRunning bookName --Is the requested book running?
getRemote "this book" application "toolbook" topic bookName
if item 1 of sysError is "OK" --Check sysError
  return true
else
  return false --Failed to respond
end
end
```
Keeping the DDE channel open

By default, a DDE channel remains open until ToolBook is no longer executing a handler or command; when the handler is finished, ToolBook automatically closes the DDE channel. Each time you run the `getRemote`, `setRemote`, and `executeRemote` commands, ToolBook:

- initializes the server application.
- gets data, sets a data value, or executes a command in the server.
- terminates the DDE communication.

To keep the DDE channel open after ToolBook has executed all handlers or commands, use the `keepRemote` and `closeRemote` commands. If you use the `keepRemote` command, you eliminate the need to initialize the server application and terminate the DDE conversation, making the scripts more efficient. The `keepRemote` command can go anywhere in a handler that runs DDE commands. When you finish with the server application, use the `closeRemote` command to end the DDE communication.

For example, the following script keeps a DDE conversation open while the user remains on the page and closes it when the user navigates to another page. The content of the status field is updated whenever a script executes `send updateStatus`.

```plaintext
--Put these handlers in the page script
to handle enterPage
  keepRemote application "ToolBook" topic "myapp.tbk"
  send updateStatus  --Initializes status field
  forward
end
```
to handle updateStatus
    getRemote "text of field "user name"" application "ToolBook" topic "myapp.tbk"
    if item 1 of sysError is "OK"
        text of field "Status" = It
    else
        request "Could not establish DDE link."
    end if
end if
end updateStatus

to handle leavePage
    closeRemote application "ToolBook" topic "myapp.tbk"
    forward
end

**Tips for using DDE with ToolBook**

When working with DDE in ToolBook, remember that:

- DDE conversations are associated with an instance, not a book. If you have the same book open in two instances of ToolBook, only the most recently active instance will respond to a DDE request.
- An open but inactive DDE conversation does not consume local memory.
- The maximum number of DDE conversations possible is limited by system resources. If system resources are exhausted, an out-of-memory error occurs.
Using ToolBook as a server

ToolBook responds as a DDE server to any Windows application that sends the Windows DDE messages \text{Tm\_DDE\_REQUEST}, \text{Tm\_DDE\_POKE, or Tm\_DDE\_EXECUTE. (If these DDE requests originate in another instance of ToolBook, they are sent by the getRemote, setRemote, and executeRemote commands.)}

For example, if you are running ToolBook and have the book Sample.tbk open, you can send this command from a second instance of ToolBook:

\begin{verbatim}
getRemote "text of field Index of page 1" application \\
"ToolBook" topic "sample.tbk"
\end{verbatim}

The first instance of ToolBook—the one currently running the Sample.tbk book—will respond as if you had run this command from the Command window in that instance:

\begin{verbatim}
get text of field "Index" of page 1
\end{verbatim}

When ToolBook is acting as a DDE server, it responds to the \text{Tm\_DDE\_REQUEST message as if the message is an OpenScript get command. Similarly, ToolBook responds to the \text{Tm\_DDE\_POKE message with a set command, and to the \text{Tm\_DDE\_EXECUTE message with an execute command. In all cases, ToolBook runs DDE messages as if they have been run in the Command window, so the context of the commands is the current page.}
**Controlling the ToolBook response to DDE requests**

If you want to control how a particular ToolBook book responds to DDE requests, you can create `remoteGet`, `remoteSet`, or `remoteCommand` handlers. These handlers are called when another Windows application sends WM_DDE_REQUEST, WM_DDE_POKE, or WM_DDE_EXECUTE messages, respectively. Using these handlers allows you to restrict access to a book that is accessed using the DDE channel or to create custom DDE-only behavior in a book. For example:

```plaintext
--Prevents another application from changing
--a value with the DDE WM_DDE_POKE message
to handle remoteSet
    request "You cannot change values using DDE."
    & CRLF & "Book:" && name of this book
end
```

Handlers that respond to DDE-event messages must forward the messages so that ToolBook can execute the command, or ToolBook returns *Failed: Denied* to the client. Alternatively, you can include a `respondRemote` statement to define a custom response to the DDE request. For example, the following handlers turn off the book as a DDE server altogether:

```plaintext
--Place in a book script
to handle remoteGet
    respondRemote "Failed: Denied"
end

to handle remoteSet
    respondRemote "Failed: Denied"
end
```
to handle remoteCommand
  respondRemote "Failed: Denied"
end

**Note** You should use only one `respondRemote` command in each handler, because ToolBook ignores any other `respondRemote` commands after the first one in that handler.

Handlers for OpenScript DDE-event messages are usually placed in the book script so that the response to a DDE message is the same regardless of which page is displayed.

### Extending DDE-event handlers

The DDE-event messages `remoteGet`, `remoteSet`, and `remoteExecute` include a `<command>` parameter that contains the text of the command sent by the DDE client.

For example:

```plaintext
--This handler displays the text of a WM_DDE_REQUEST command
to handle remoteGet command
  request command
    forward
  end

You can use the `<command>` parameter to receive additional information that was passed with the DDE event messages. For example, you can create a `remoteGet` handler that returns not just the value of a property, but the value of a system variable as well. The client sends a request such as this:

getRemote "system myVar" application "ToolBook" topic "myapp.tbk"

The `remoteGet` handler in the server evaluates the request, looking for the word `system` as the first word of the request string. If the
first word is *system*, the second word is the name of the variable to return. The handler uses `execute` to declare the system variable, and then `evaluate` to get its value:

```plaintext
to handle remoteGet command
    if word 1 of command is "system" --Request for system variable
        execute command --Declares variable
        It = evaluate(word 2 of command) --Sets it to the value of the --system variable
        respondRemote "OK" --Sets sysError value
    else
        forward
    end if
end
```

For details about using the `execute` and `evaluate` commands, refer to their entries in the OpenScript reference in online Help, and see Chapter 8, “Writing common scripts.”
Chapter 13

Using dynamic-link libraries

Dynamic-link libraries (DLLs) contain functions to which you can link an application at run time to perform particular tasks not supported in OpenScript. Windows itself is composed of DLLs, which can be called from OpenScript to perform low-level tasks and interact with other applications.

This chapter describes how to use DLLs to extend the functionality available to your application. This chapter also explains how to connect to the Windows messaging system from OpenScript. In addition, if you are writing DLLs for ToolBook, the last topic in this chapter discusses special features you can use to make your DLLs more powerful.
About DLLs

You can extend the power of ToolBook by linking your applications to 32-bit dynamic-link libraries (DLLs). DLLs are executable files containing functions that can be linked dynamically (on demand) by an application (linkDLL), and then called to perform useful tasks, such as getting file and device information from Windows. You need to know the function names and their parameter types. You should also know as much as possible about what the functions do.

Windows itself is composed of DLLs. The following DLL modules provide the most commonly used components of the application programming interface (API) used by all Windows applications to interact with the system. You can access these API functions from OpenScript as well:

- **KERNEL32.DLL** Windows operating system basic functions, such as memory allocation, file I/O, and resource management
- **USER32.DLL** Windows user interface functions
- **GDI32.DLL** Windows graphic display functions

Many suppliers of development tools provide their products as DLLs that you can call from your ToolBook scripts. You can also write your own DLLs to enhance your applications using C, C++ or another language that supports creating DLLs. For details about how to call the DLLs supplied with another product, refer to the documentation that came with the product.
DLLs and ToolBook

Using a DLL in ToolBook is a two-step process:

1. Link the DLL to make it available to your application.
2. Call functions in the DLL from your script.

The `linkDLL` control structure tells ToolBook which library you want to link to, which functions you want to access in the library, and the data types for their parameters and return values. For example:

```plaintext
linkDLL "draw.dll"
    --Declares a function that returns a long data type
    --and the parameters being passed are strings
    LONG getPenSize(STRING, STRING)
end
```

For details, see “Specifying data types for DLL functions” later in this chapter.

After you have linked and declared a DLL function, you call it from a script using the same syntax as OpenScript functions. For example, the following script uses the `getPenSize()` function:

```plaintext
err = getPenSize("p3", "Transparent")
if err is not 1
    request "Invalid pen"
end
```

The value returned by this particular function represents an error code. A value of 1 indicates success; any other number indicates an error. This strategy is common for indicating errors in DLL calls. It is good programming practice to always check the return values of DLL calls for errors.
Because they always return a value, DLL functions are called the same way as OpenScript functions, even though some DLL functions may look more like commands. For example, the following handler calls the `setCurrentDay()` function:

to handle buttonClick
  get setCurrentDay("Friday")
  if It is not 1
    request "Error setting day as" & & It
  end if
end buttonClick

The sections that follow provide more information about how to use DLLs.

**Linking and declaring DLL functions**

ToolBook can link to 32-bit DLLs. The `linkDLL` control structure uses this syntax:

```
linkDLL <dll name>
  <return type>[[<alias name>=]<function name>
  ([<parameter type list>])
end [linkDLL]
```

The `<dll name>` parameter is the name of the DLL file; for example, `Kernel32.dll`. If the file extension of the DLL is `.exe`, you can omit the extension, but you must specify other file name extensions, such as `.dll` or `.drv`. 
ToolBook puts the name of linked DLLs into a list in the `sysLinkedDLLs` system property. Each item in the list is the full path name of a linked DLL. You can use the list in the `sysLinkedDLLs` property to verify that a DLL is linked:

```plaintext
to handle buttonClick
    dllFileName = "draw.dll"
    if dllFileName is not in sysLinkedDLLs then
        linkDLL dllFileName
        LONG getPenSize(STRING, STRING)
        end linkDLL
    end if
    ... --Further statements here
end buttonClick
```

**Note** You can also use the `DLLfunctions( )` function to return a list of functions linked in a DLL.

To link Windows libraries, specify the module name rather than the file name to ensure that your scripts perform properly on systems where these modules can have different file names. Module names are KERNEL32, USER32, GDI32, and DISPLAY32. For example, to link to memory allocation functions in Windows, you would use this `linkDLL` statement:

```plaintext
linkDLL "kernel32"
```
Aliasing function names

When you link to a DLL, you usually specify the function as it is named in the DLL. Sometimes, however, you might need to create an alias for a function. Typical situations in which you might want to use an alias are:

- when the DLL function name is the same as a ToolBook keyword.
- when the name of the function is not descriptive.
- in the rare case when you need to simultaneously link the same function with two different sets of data type declarations.

For example, you must use an alias when a DLL function name conflicts with the name of an OpenScript command or function. The following example establishes `winOpenFile` as the alias for the `openFile` DLL function in KERNEL32, because `openFile` is an OpenScript command:

```
linkDLL "kernel32" --Do not specify .exe
  LONG winOpenFile = openFile(STRING,POINTER32,DWORD)
end
```

Some Windows DLLs export functions by a number, called an ordinal, instead of a name. You can create an alias to refer to the export ordinal reference of a function when declaring the function in a `linkDLL` statement. The following example establishes the alias `localFunction` for a function based on its ordinal reference of 7:

```
linkDLL "local.dll"
  WORD localFunction = 7(WORD, INT)
end
```
**Where to link a DLL**

You can link a DLL at any time before you call it. Typically, your `enterApplication` or `linkSysbook` handler will contain the `linkDLL` statements so that the functions are available when the book is opened. Each link to a function takes both time and memory; therefore, declare only the functions you need from a DLL.

If you link a DLL more than once, the new function declaration replaces any previous declarations for that function, unless they have different aliases. The only impact on your application when you relink a DLL is the time it takes to execute.

**Tip** When you debug an application, you will sometimes find it necessary to relink the DLLs or alter their declarations. To make this task easier, group your `linkDLL` structures in their own handler:

```plaintext
to handle linkAppDLLs
   ... --Link functions here
end
```

Then, put a `send linkAppDLLs` statement in your `enterApplication` handler.

**Specifying data types for DLL functions**

You must specify the number and type of arguments for each function in your `linkDLL` control structure.

DLLs are most commonly documented by their C data types. The following tables provide ToolBook translations for common data types in DLLs.
# Data types for DLL function parameters

<table>
<thead>
<tr>
<th>Windows C data type</th>
<th>linkDLL parameter type</th>
<th>linkDLL return type</th>
</tr>
</thead>
<tbody>
<tr>
<td>int</td>
<td>INT</td>
<td>INT</td>
</tr>
<tr>
<td>BOOL</td>
<td>INT</td>
<td>INT</td>
</tr>
<tr>
<td>void †</td>
<td>&lt;none&gt;</td>
<td>INT</td>
</tr>
<tr>
<td>unsigned char, BYTE</td>
<td>BYTE</td>
<td>BYTE</td>
</tr>
<tr>
<td>UINT, unsigned int, WORD</td>
<td>WORD</td>
<td>WORD</td>
</tr>
<tr>
<td>HANDLE, HWND, HBMP, HDC, and so on</td>
<td>WORD</td>
<td>WORD</td>
</tr>
<tr>
<td>long</td>
<td>LONG</td>
<td>LONG</td>
</tr>
<tr>
<td>unsigned long</td>
<td>DWORD</td>
<td>DWORD</td>
</tr>
<tr>
<td>FLOAT</td>
<td>FLOAT</td>
<td>FLOAT</td>
</tr>
<tr>
<td>DOUBLE</td>
<td>DOUBLE</td>
<td>DOUBLE</td>
</tr>
</tbody>
</table>

† The return type of a void C function requires the INT return type in OpenScript. This is because when you call a function in OpenScript, you use the get command, which requires a return value. The void type in C actually returns an INT as well.

**Note** Some of the declarations for function return values in the table above differ from the declarations for parameters. ToolBook cannot verify that the information passed to and from DLLs is of the correct data type, and so incorrect declarations can result in unpredictable behavior or cause Windows to crash. If you encounter problems using a DLL, verify your function declarations as a first debugging step.
String data types

<table>
<thead>
<tr>
<th>Windows C data type</th>
<th>linkDLL parameter type</th>
<th>linkDLL return type</th>
</tr>
</thead>
<tbody>
<tr>
<td>VOID FAR *, CHAR FAR *, LPSTR, LPCSTR, or POINTER (Using the ToolBook string return protocol)†</td>
<td>STRING</td>
<td>POINTER</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STRING</td>
</tr>
</tbody>
</table>

† For details, see “Strings as return values” later in this chapter.

Boolean values

The BOOL data type indicates an integer that should have the value of 0 to indicate false or 1 to indicate true. Declare BOOL functions and parameters as INT and use values of 1 or 0 (not OpenScript true or false).

The void data type

The void data type in C means two different things. As a return type, it means that the function returns an integer, which is ignored. As a parameter type, it means that no parameters should be passed. For example:

--The function declared in C
void updateEntry(void)

--The same function declared in your linkDLL statement
int updateEntry()

**Note** Do not confuse the *void* data type with declarations such as *void FAR* *, which are pointers.

**Passing strings as parameters**

Working with the string data type in your DLL function, you can pass constant strings, declare string buffers, and return string values to ToolBook. The following sections provide details.

**Constant strings**

If a DLL function requires string data for input only—that is, it does not change the value of the string—you declare the parameter as *STRING* and pass either a ToolBook constant (a string in quotes) or a ToolBook property or variable.

When passing a string parameter from ToolBook, you can pass an empty string to a DLL by using a pair of quotation marks (" "). Because all strings are passed as long pointers, ToolBook passes the quotation marks as a long pointer to a null string, not a null pointer. However, if you pass a value of *null*, ToolBook will give a *null* pointer to the DLL.

**String buffers**

If the function you are linking to modifies a string or returns data in a buffer, declare the data type as *POINTER* rather than *STRING* and pass a pointer to Windows memory.
Strings as return values

There are two formats for returning string information to ToolBook from a DLL. You use one format with functions that return a LPSTR (long pointer to a string), and another with functions that return a value declared as a string.

Note This discussion applies only to the return value of the DLL, not to the data types for the parameter.

If a function returns a LPSTR or a CHAR FAR *, declare it as returning a POINTER and use the OpenScript `pointerString()` function to convert the value to a ToolBook data type. You can declare this type of function as shown in the following example:

```plaintext
linkDLL "sample.dll"
    POINTER funcGivesLPSTR()
end
```

Then, call the DLL function and use the OpenScript `pointerString()` function to convert the global pointer to a ToolBook string, as in the following example:

```plaintext
get funcGivesLPSTR()
vStringVar = pointerString(0,It)
```

You use a different format with functions that return a value as a string. For return values, ToolBook reserves the STRING data type as a special protocol that includes both the string data and error information to be placed in `sysError`.

DLLs you specifically design to work with ToolBook use functions with return values declared as strings.

For technical details about this protocol, see “Writing DLLs to use with ToolBook” later in this chapter.
Allocating Windows memory

If your DLL requires you to pass arguments by reference—that is, pass a pointer to them—or to pass buffers, you need to allocate Windows memory and pass the pointer to that memory.

ToolBook provides the OpenScript function `getMemBlock()` , which allocates memory for use, and `freeMemBlock()` , which frees memory you have finished using. You should always free memory buffers when you are finished with them so that the memory is available for other uses. However, if you want to maintain a buffer over a period of time, you can store the pointer in a system variable:

Accessing memory with `pointer<type>()` functions

OpenScript includes a set of `pointer<type>()` functions to copy data between the ToolBook variable and the Windows global memory. Each of the following `pointer<type>()` functions corresponds to a data type; you can use them to either set or get data within a buffer.

- `pointerByte()`  
- `pointerFloat()`  
- `pointerPointer()`  
- `pointerDouble()`  
- `pointerInt()`  
- `pointerString()`  
- `pointerDword()`  
- `pointerLong()`  
- `pointerWord()`

The general syntax of the `pointer<type>` function is:

`pointer<data type>(<offset>,<pointer>[,<set value>])`

Where:

- `<data type>` is the portion of the function name that identifies the type of the data to be copied by the function. The function you choose depends on the type of data you expect the function to return. The data type name corresponds to C data types, as listed in the table on the following page.
### Data types for values passed by reference

<table>
<thead>
<tr>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAR</td>
<td>8-bit signed value</td>
</tr>
<tr>
<td>BYTE</td>
<td>8-bit unsigned value (unsigned char)</td>
</tr>
<tr>
<td>SHORT</td>
<td>16-bit signed value</td>
</tr>
<tr>
<td>WORD</td>
<td>16-bit unsigned value (unsigned short)</td>
</tr>
<tr>
<td>LONG</td>
<td>32-bit signed value</td>
</tr>
<tr>
<td>DWORD</td>
<td>32-bit unsigned value (unsigned long)</td>
</tr>
<tr>
<td>INT</td>
<td>Depends on environment: 32-bit signed value in 32-bit Windows</td>
</tr>
<tr>
<td>FLOAT</td>
<td>32-bit Microsoft-format floating point value</td>
</tr>
<tr>
<td>DOUBLE</td>
<td>64-bit IEEE†-format floating point value</td>
</tr>
<tr>
<td>STRING</td>
<td>NULL-terminated array of 8-bit unsigned values interpreted as characters</td>
</tr>
<tr>
<td>POINTER</td>
<td>32-bit</td>
</tr>
</tbody>
</table>

† Institute of Electrical and Electronics Engineers

◆ `<offset>` is the number of bytes offset into the buffer pointed to by `<pointer>`.  

**Note** If you attempt to set a value that has an `<offset>` outside the buffer, you might generate a general protection fault.  

◆ `<pointer>` is the Windows memory block you wish to access. This parameter can be a pointer to any valid memory location without regard to the data type of its contents.  

◆ `<set value>` is a value of a type that matches `<data type>`. If no `<set value>` is supplied, ToolBook returns the current value. If a value is supplied, the function fills in the memory location
pointed to by the `<pointer>` plus `<offset>` with `<set value>`. This parameter is optional.

**A `pointer<type>()` example**

The following example uses the OpenScript pointer<type>() functions to manipulate database records. It shows C declarations for two data retrieval functions in an imaginary database DLL called MyBase.dll. Each function takes three parameters: a record number (lRecord), a field number (lField), and a data value of type long passed as a pointer. The return value, an integer, is an error code:

```c
SHORT getData(LONG lRecord, SHORT nField, LONG* lpValue);
SHORT setData(LONG lRecord, SHORT nField, LONG * lpValue);
```

In OpenScript, declare these functions in this way:

```openscript
linkDLL "mybase.dll"
    short getData(long, short, pointer)
    short setData(long, short, pointer)
end
```

To get or set a value from this database, first use a pointer allocation function to copy the data from memory to a ToolBook variable, and then manipulate it as you would any other variable:

```openscript
--Sets up variables for what data to retrieve
vRecord = 10       --Get the 10th record
vField = 4         --Get the 4th field in record
vPointer = getMemBlock(4)    --Longs are 4 bytes
--Gets a value from the database, returns its memory location in--vPointer; the return value of the function is an error codeget getData(vRecord, vField, vPointer)
```
--Copies data from memory to OpenScript using pointerLong()
set vLongValue to pointerLong(0,vPointer)

The ToolBook variable vLongValue now holds the value from the database record. To set data using pointerLong(), change the value of the OpenScript variable, and then put the data back in the database using the setData() DLL function:

increment vLongValue --Changes the data
--Copies value to the memory buffer
get pointerLong(0, vPointer, vLongValue)
get setData(vRecord, vField, vPointer) --Writes it to database
get freeMemBlock(vPointer) --Frees memory

Calling Windows API functions

You can link the Windows modules KERNEL32.DLL, GDI32.DLL, and USER32.DLL to call their functions just as you do other DLLs.

For details about Windows API function names and the parameters they take, refer to:

◆ the Guide to Programming, which is included in the Microsoft Windows SDK.

◆ any of the wide variety of books on Windows API programming available commercially.
Translating Windows messages in ToolBook

This section contains information that assumes you have some knowledge of the Windows messaging system.

**Important** Translating some messages can cause applications to stop responding to user actions. Be sure to save your work frequently when experimenting with message translation, and test your scripts thoroughly.

Like ToolBook, Windows is an event-driven messaging environment; when a user performs an action, Windows sends a message to the current window. When you use ToolBook, Windows sends the message to ToolBook, and ToolBook in turn converts this Windows message into the OpenScript message that you are familiar with. For example, the Windows message WM_LBUTTONDOWN becomes `buttonDown` in ToolBook, and WM_CHAR becomes `keyChar`.

For the most part, you can handle a Windows message using its OpenScript equivalent. However, you might want to handle Windows messages that have no ToolBook equivalent. You can use `translateWindowMessage` in your scripts to receive and respond directly to Windows messages.

The `translateWindowMessage` command causes ToolBook to translate the Windows message into an OpenScript message. Your script can then respond to almost any Windows messages for any running application, even non-ToolBook applications.

When you translate a message, you substitute your handler for the ToolBook default response to the message. For example, if you translate the Windows message WM_LBUTTONDOWN, your handler is called whenever a user clicks the left mouse button down. Your handler determines the response to the message.
As with any message, you can forward Windows messages up the object hierarchy. If the message reaches the ToolBook system, it triggers the ToolBook default response to the message. If you want to handle the message before ToolBook does, you forward the message after processing it. If you want ToolBook to respond first, you forward the message, and then process it. If you want to substitute your response altogether for the ToolBook response, you can process the message without forwarding it. Some Windows messages (such as WM_MOUSEACTIVATE) require a return value, and translateWindowMessage supports this as well.

As a simple example, the following script translates the Windows message WM_WININICHANGE (message number 0xFF) into a ToolBook user-defined message, winIniChanged. Translating this Windows message allows you to write scripts that are notified when there is any change to the Win.ini file:

```
translateWindowMessage for windowHandle of mainWindow
--0x001A = WM_WININICHANGE
--Indicates that Win.ini has been changed
on 0x001A send winIniChanged
end
```

The general steps for working with Windows messages are:

1. Establish Windows-to-OpenScript message translation with the translateWindowMessage control structure.
2. Handle the OpenScript message with a to handle or to get handler.
3. Cancel message translation with the untranslateWindowMessage or untranslateAllWindowMessages command.
Establishing translation of Windows messages

The `translateWindowMessage` control structure establishes the Windows-to-OpenScript message translation. For messages that send a ToolBook message, the syntax is:

```plaintext
translateWindowMessage [for <winHandle>]
  on <winMsg> send <tbkMsg> [to <tbkObj>]
end [translateWindowMessage]
```

The `<winHandle>` parameter is the handle of the window receiving the message. For ToolBook applications, it is either the `clientHandle` of a viewer, which receives most user input and redraw messages, or the `windowHandle` of a viewer, which receives application messages. For non-ToolBook applications, you need to supply the appropriate handle. The default value is the ToolBook main window, `windowHandle of mainWindow`.

The `<winMsg>` parameter is the message number for the Windows message to be translated. You can find the value for each Windows message in the Windows SDK.

Note ToolBook reserves the message numbers between 1124 and 1224 (WM_USER+100 to WM_USER+200) for its internal messages. Do not redefine or intercept these messages; doing so can cause system errors and data corruption.

The `send <tbkMsg> [to <tbkObj>]` statement indicates the OpenScript message to send and an optional target object. If no object is specified, the current page is the target.

For messages that return a value, the syntax is:

```plaintext
translateWindowMessage [for <winHandle>]
  on <winMsg> get tbkMsg> [of <tbkObj>] return <dllType>
end [translateWindowMessage]
```
This syntax closely resembles the syntax you use to send a ToolBook message. The difference is that instead of a message handler, you can specify an object property to be returned or a to get() handler to be called. The <dllType> parameter specifies the C data type ToolBook must use to return this value. This value is the same as for a DLL function of the same type, usually a LONG.

**Guidelines for translating Windows messages**

When translating Windows messages, keep in mind the following:

- If no target object is specified for the translated ToolBook message, the ToolBook message is sent to the current page.

- If the target object is destroyed after a translated message has been defined for that object, creating a new object with the same name will not restore the translation.

- Message translation stops if a translated message is being sent to a book and the book is saved with a new name.

- Utilities such as Spy.exe (supplied with the Microsoft Windows SDK) display all messages sent to a window, which can be useful for determining what messages to translate.

**Note** Each message can have only one current translation. For example, you cannot translate WM_LBUTTONDOWN more than once for the same window. Only the most recent translation works.
Handling translated messages

Your application must have a handler to respond to the translated message. When ToolBook sends the message, it provides parameters that match those found at the Windows system level. The meaning of these parameters is different for each Windows message, and, in many cases, your handler can ignore this information. Refer to the table on the next page for descriptions of the parameters.

Windows parameters passed with translated messages

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hWnd</td>
<td>Handle of the window that received the Windows message</td>
</tr>
<tr>
<td>dwMsg</td>
<td>Numeric value for the Windows message that is to be translated into a ToolBook message</td>
</tr>
<tr>
<td>wParam</td>
<td>&lt;wParam&gt; parameter for the Windows message</td>
</tr>
<tr>
<td>lParam</td>
<td>&lt;lParam&gt; parameter of the Windows message</td>
</tr>
</tbody>
</table>

For example, you can translate the Windows message WM_WININICHANGED into the ToolBook message winIniChanged. Then, you can write a handler to check the string pointed to by the lParam of the winIniChanged message, finding out which section of Win.ini was modified. The following example shows a pointer to the name of the changed section of the Win.ini file.
--Establishes Windows message translation
to handle enterBook

   translateWindowMessage for windowHandle of mainWindow
   --Indicates that Win.ini has been changed
   --0x001A = WM_WININICHANGE
     on 0x001A send winIniChanged
   end translateWindowMessage
   forward
end enterbook

--Handles the message sent by a translated Windows message
to handle winIniChanged hWnd, dwMsg, wParam, lParam
--Returns name of changed section in Win.ini
set vSection = pointerString(0, lParam)
if vSection is "MyAppName"
   --If section matches this app, sends a reset to the application
   send ResetPreferences
end if
   --Otherwise ignores it
forward
end winIniChanged

Returning a value

The example below translates WM_QUERYOPEN (Windows
message 0x0013) to return a user property or the result of a to get
function. Windows expects a Boolean value: zero to prevent
a minimized instance from being activated, or a nonzero number
to allow the instance to be activated.

--anyHandle is a local variable containing a window handle
translateWindowMessage for anyHandle

-- 0x0013 = WM_QUERYOPEN, which determines if minimized application
-- will allow itself to be opened
  on 0x0013 get openIcon of this book return LONG
end

The words return LONG in this example indicate that a LONG data type is required for this message. After the translation above is established, when ToolBook receives a WM_QUERYOPEN message, it looks for either of the following:

◆ A user-defined function that defines the response and return value for the WM_QUERYOPEN message. For example:

```plaintext
to get openIcon of this book hWnd, dwMsg, wParam, lParam
  system handleToLock
  if hwnd is handleToLock
    return 0
  else
    return 1
  end if
end if
end openIcon
```

This function must be placed in the script of the book or higher in the hierarchy because the translation statement specified of this book.

◆ A user property of the book. Because the WM_QUERYOPEN message in Windows returns an integer value, the user property in ToolBook must likewise contain an integer value. For example:

```plaintext
openIcon of this book = 1
```

**Tip** You can control whether a minimized ToolBook application can be opened by setting the state property of a viewer to minimized or lockedMinimized.
Canceling the translation of Windows messages

You can cancel message translation by doing any of the following:

◆ Executing the `untranslateWindowMessage` command for a specific Windows message
◆ Executing the `untranslateAllWindowsMessages` command for a particular window handle
◆ Exiting ToolBook
◆ Closing the window for which the message is being translated (all translations are canceled after the window receives the WM_NCDESTROY message)
◆ Deleting the target object of the `translateWindowMessage` command
Chapter 14

Debugging OpenScript programs

You debug a script to find and correct errors that prevent it from running, cause undesirable or unpredictable behavior, or produce incorrect results. Use the tools and the techniques presented in this chapter to build more reliable applications.

About debugging a ToolBook script ................. 289
Responding to the Execution Suspended message .... 295
Using the ToolBook Debugger ...................... 297
Using scripts for debugging ....................... 308
About debugging a ToolBook script

Debugging involves checking the syntax of OpenScript statements, testing statements, determining the source of errors that suspend script execution, and tracing the history of calls made in a script. Each technique described in this chapter helps you identify a specific type of error.

Debugging your application is an ongoing development task. You can reduce errors and make debugging easier by avoiding common errors in scripts, and by designing your scripts for easy testing. Because all parts of your application relate to each other, fixing one error may reveal another. Each time you correct a script or change the application, you need to test it.

Types of scripting errors

Three types of scripting errors can occur in your ToolBook applications:

◆ Compile errors
◆ Run-time errors
◆ Logic errors

Compile errors occur in the syntax of an OpenScript statement and do not allow ToolBook to compile the script. These errors are detected when you save a script and ToolBook compiles the OpenScript code. The compiler highlights the error. If you ignore the error and carry on, your script will not run. Sometimes the compiler cannot find the error (because of a missing end statement, for example), and it stops at the end of the questionable handler or script.
Run-time errors occur while script is running. They are typically caused by unexpected values or actions, such as errors in the logic of a script statement. For example, a run-time error occurs if you attempt to add a number to a string. When run-time errors occur, ToolBook suspends the script and displays the Execution Suspended message.

Using `sysSuspend` and `sysErrorNumber`, you can override the display of the ToolBook error message and provide your own custom error handling. To do this, set the `sysSuspend` variable to `false`. After an OpenScript command executes, the system variable `sysErrorNumber` will hold an error number value greater than zero if an error occurred. Note that not checking for errors can lead to serious problems; therefore, you should turn the display of the ToolBook error message off around only the code you intend to check yourself.

Logic errors occur when your application does not work in the way you intended, even though the syntax of the handler is correct. For example, every statement of a handler might operate perfectly, but not produce the expected results because it does not include a `forward` command.

Preventing errors

By planning, checking, and testing your scripts carefully, you can significantly reduce the number of errors in your scripts.

Plan the application carefully

Before you create an application, carefully plan how each part of it will function. Consider making a sketch of the application that shows the various objects, including the names of objects, the properties they will use, and the purpose of the handlers in their
scripts. Also, consider the best placement of objects and scripts in the ToolBook object hierarchy.

During the planning process, you will begin to recognize where you need to define local and system variables and where you might need to create your own properties, functions, and messages.

As you plan your application, consider:

◆ the purpose of each object and script.
◆ the effect a script will have on other objects in the application.
◆ the properties available to each object.
◆ the built-in messages that ToolBook sends and how they move up the object hierarchy.
◆ the variables used in a script with their data types and initial values.
◆ the source data that a script will use.
◆ the desired data that a script will produce.
◆ the steps required to turn the source data into the final data.

You should not duplicate handlers unnecessarily. For example, if two buttons have scripts that calculate the same value, such as grossMargin, it is usually more efficient to write a single to get handler and call it when needed, rather than write two separate handlers.

Unlike single-thread programming languages, ToolBook is event-driven, and messages are passed up an object hierarchy. The location of a script in the hierarchy can affect the reaction of the application to the corresponding message. Handlers higher in the hierarchy can affect other handlers.
Watch for handlers that respond to the same message at different points in the object hierarchy. For example, you can place an enterPage handler that executes correctly in the script of the background. However, unless you forward the message from that handler, a second enterPage handler in the script of the book will not execute.

**Design handlers for easy testing**

To make handlers easier to test:

- indent control structures appropriately so your scripts are easier to read.
- plan each handler so that it performs a single task or just a few tasks. For example, one handler might get data from an Excel spreadsheet and send a message to a second handler that formats the data. A third handler might display the appropriate number of objects to graph the data.

**Test handlers and scripts as you write them**

You should perform incremental testing of your scripts and application. In a script or in the Command window, write statements to test and show the results of running a handler. When areas of an application do not work correctly, you can isolate the problem by breaking the scripts into sections to test for errors.

When you are creating an application, keep in mind that the systems of those who will use it might be different than your own. If a script contains more than one handler, test each handler when you finish writing it. It is easier to isolate an error by testing one handler at a time than by testing a script that contains several handlers.
Read a script carefully after you create it

When you create a script in the script editor, print it and read it carefully for spelling and typographical errors. Although ToolBook can check the syntax of a script, it cannot verify whether you spell a variable, message, or function name correctly and consistently every time it occurs in an application. The same problem arises when you create user-defined functions, properties, and messages. ToolBook accepts any name you provide by assuming that the name already exists in another script, or that you are creating a new name.

Also, be sure to declare and initialize system variables before referring to them in a script. Be careful not to declare a system variable as a local variable.

Check the script for logic errors

Logic errors cause incorrect or unexpected results or undesirable behavior in an application. For example, an expression might not evaluate to the correct result, or an infinite or recursive loop will prevent ToolBook from exiting a control structure.

To check for logic errors, test statements in the Command window or step through the execution of the script on paper. To check an expression, perform the calculation manually and check your results against the results of the script. Be especially careful if you use data types to declare variables; use the correct types for the data you are working with. For example, if you assign a real number to a variable typed as an int, ToolBook will truncate the decimal portion of the number.

To avoid errors such as infinite or recursive loops, make certain that each control structure can actually be exited before you attempt
to run the script. If you get stuck in a loop use SHIFT+SHIFT to break to the ToolBook Debugger.

**Check the syntax before compiling the script**

As you write a script in the script editor, periodically choose Check Syntax from the File menu or click the Check Syntax button on the script editor toolbar. However, even when the syntax of a script is correct, it might still contain other types of errors that appear at run time.

**Test the value of the sysError property**

As ToolBook executes a script, some commands send an error message to the `sysError` property when certain errors occur. For example, if a handler requests that ToolBook import a file that does not exist, ToolBook sets the `sysError` property to *No such file*.

You can get the value of the `sysError` property from a script. The following statement gets the value of `sysError` and displays it in a field:

```
text of field "Error" = sysError
```

For details about the `sysError` property, see “Checking for results and errors” in Chapter 8, “Writing common scripts.”

**Test the script at Reader level**

The only sure way to check a script for errors is to switch to Reader level and test it as a user. For example, to test a `mouseEnter` handler for a field, switch to Reader level and move the mouse pointer over the field.

If you run a script at Reader level and ToolBook displays the Execution Suspended message, a run-time or logic error has
occurred. ToolBook cannot continue executing the script until you correct the error. Even if the Execution Suspended message does not appear when you execute a script, you will want to verify that the script behaves as expected and returns the correct results.

Responding to the Execution Suspended message

ToolBook displays the Execution Suspended message when it encounters a run-time error. Typical execution errors include:

- referring to a nonexistent object.
- setting a property that cannot be set.
- setting a property to an invalid value.
- setting a typed variable to an inappropriate value.
- specifying a parameter that is outside the valid range of a function.

The Execution Suspended message dialog box contains details about the error in its Why and Where boxes. The Why box displays the reason that ToolBook suspended script execution. The Where box shows the handler identifier for the message and the object that was handling it when ToolBook suspended execution.
When ToolBook displays the Execution Suspended message, you can respond as shown in the table below.

### Responses in the Execution Suspended message box

<table>
<thead>
<tr>
<th>Click</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author button</td>
<td>Suspend further execution of the script and switch to Author level</td>
</tr>
<tr>
<td>Edit button</td>
<td>Suspend further execution of the script and display the script editor; the script term that caused the error is highlighted</td>
</tr>
<tr>
<td>Debug button</td>
<td>Display the ToolBook Debugger with the error highlighted in the script box (for details about the ToolBook Debugger, see the next section)</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Suspend the execution of the current handler but complete the operation that triggered the suspended handler</td>
</tr>
</tbody>
</table>
Note To prevent ToolBook from displaying the Execution Suspended message when it encounters an error, set `sysSuspend` to `false`. You can then check the value of `sysError` after commands that set it to determine the result of the command. However, do not leave `sysSuspend` set to `false` any longer than absolutely necessary. Subtle errors multiply when you disable ToolBook error trapping and do not replace it with something else.

Using the ToolBook Debugger

To locate a problem with a script, use the ToolBook Debugger to view and change variables, and to trace or methodically step through the execution of a script. Use the ToolBook Debugger to:

- determine where you are in the script.
- edit the script to change how it executes.
- set breakpoints so that you can halt the script as it is evaluating expressions or running commands.
- trace the sequence of calls to handlers.
- execute a single statement or expression.
- examine and change the values of variables and arrays.
- halt execution of a script and return to Author level.

You can open the ToolBook Debugger in the following ways:

- In the script editor, choose Debug from the File menu, click the Debug button on the toolbar, or press CTRL+D.
- Set a breakpoint so that the ToolBook Debugger is called automatically when the script is running. For details, see “Setting,
using, and removing breakpoints” later in this chapter.

◆ Send the `debugScript` message. For details, refer to the entry for `debugScript` in the OpenScript reference in online Help.

◆ Click the Debug button in the Execution Suspended message box.

◆ Press SHIFT+SHIFT while a script is running.

◆ Press CTRL and click the Debug button on the main window toolbar.

**Note** If you open the ToolBook Debugger from the script editor, you cannot trace script execution or display the Variables window. To trace script execution or to display the Variables window, you must first set a breakpoint in the ToolBook Debugger, and then exit the debugger and run the script. For details, see “Setting, using, and removing breakpoints” later in this chapter.

*Figure 2  The ToolBook Debugger window*
The ToolBook Debugger contains three areas that provide different types of information: the trace box at the top, the script box, and the status bar.

The trace box displays an identifier for each handler currently running and highlights the handler that suspended execution in the script box. If there is more than one handler running, the trace box contains a call stack, or history, of all the handlers that are running. In many cases, there is only one handler in the call stack. However, if the handler that caused the ToolBook Debugger to appear was called from another handler, or if it is a user-defined function, the call stack includes the calling handler as well.

The script box displays the script of the object that contains the currently selected handler and highlights the term at which execution stopped. When you double-click a handler identifier in the trace box, ToolBook displays the associated script in the script box. If the Variables window is also displayed, double-clicking the unique handler identifier automatically updates the values for any displayed variables.

**Setting, using, and removing breakpoints**

A breakpoint is an indicator, or marker, that you place in a script to tell ToolBook to stop executing a script at the specified point and display the ToolBook Debugger. Breakpoints are useful for forcing a break in the execution of a script to evaluate the script up to that point. Every time the ToolBook Debugger appears, you can trace the execution of the script, check the values in the variables of the handler, and edit the script before allowing it to continue running.
Use the following methods to set and remove breakpoints:

◆ To set a breakpoint, open the ToolBook Debugger and click the term you want to use as a breakpoint in the script box. ToolBook overstrikes the term with slashes (/). When the script runs next, ToolBook halts execution when it reaches the term you have marked.

◆ To remove a breakpoint, open the ToolBook Debugger and click the term from which you want to remove the breakpoint in the script box. The slashes disappear and the term is no longer a breakpoint.

◆ To remove all breakpoints from a script, choose Clear Script Breakpoints from the Breakpoints menu.

◆ To remove breakpoints for all scripts in the application (even if they are not shown in the trace box), choose Clear All Breakpoints from the Breakpoints menu.

A breakpoint is valid only in the current instance in which the ToolBook Debugger is running and cannot be saved with the script. If you set a breakpoint in one instance of ToolBook and execute the script in another instance, the executing script will not have the breakpoint. When you edit the script of an object, ToolBook automatically removes all the breakpoints from that script. ToolBook removes all breakpoints from all scripts in a book when you close the book.

To isolate just a portion of a script to find an error, set a breakpoint on the last term known to execute correctly before the error occurred, and then trace execution forward from the breakpoint.

Tip You can set breakpoints in scripts of unopened books using the debugScript message. This is useful if you want to debug the startup sequence of an application.
Tracing script execution

The ToolBook Debugger allows you to trace or step through statements and expressions in a script. When ToolBook traces execution, it highlights each term in the script box as it is executed. By tracing the execution of a script, you can see:

◆ the order in which statements execute.
◆ how variable values change.
◆ how ToolBook evaluates expressions.
◆ how one handler calls another handler.

By default, ToolBook highlights and displays the handler that was running when execution stopped, but you can select any handler listed in the trace box to display it. The Trace menu in the ToolBook Debugger includes the options for tracing execution shown in the table below.

Options for tracing script execution

<table>
<thead>
<tr>
<th>Trace menu command</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace Statement</td>
<td>CTRL+S</td>
<td>Traces execution of a statement and pauses after tracing that statement (Trace Statement is the equivalent of the Step Over command in other debugging products.)</td>
</tr>
<tr>
<td>Trace Call</td>
<td>CTRL+I</td>
<td>Traces a call; when a handler calls another handler, pauses at the start of the called handler (Trace Call is the equivalent of the Step Into command in other debugging products and is useful for debugging subroutines.)</td>
</tr>
</tbody>
</table>

(continued)
Options for tracing script execution, continued

<table>
<thead>
<tr>
<th>Trace menu command</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace Expression</td>
<td>CTRL+E</td>
<td>Traces execution of a statement incrementally so you can verify an evaluation order of an expression</td>
</tr>
<tr>
<td>Trace Return</td>
<td>CTRL+R</td>
<td>Finishes the execution of the called handler, and then pauses at the next statement in the original calling handler (Trace Return is the equivalent of the Until Return command in other debugging products.)</td>
</tr>
<tr>
<td>Continue Execution</td>
<td>CTRL+G</td>
<td>Closes the Toolbook Debugger and continues executing the script until the next breakpoint is encountered (Continue Execution is the equivalent of the Run command in other debugging products.)</td>
</tr>
</tbody>
</table>

Displaying and modifying variables

Incorrect results in a script are often caused by incorrect variable values. If you use an incorrect value more than once in an application, or if other variables are based on it, that value causes other values to be incorrect as well.

To display or modify the value of variables, display the Variables window while tracing script execution in the ToolBook Debugger. The Variables window shows the types, names, and values of all variables; the arguments referenced in the currently executing handler; and the values of the properties sysError, target, and targetWindow.
To open the Variables window:

1. Open the ToolBook Debugger.
2. Choose Variables from the View menu, or press CTRL+F3.

The Variables window displays the variables for the handler that is selected in the trace box. To display the variables for a different handler, click its handler identifier in the trace box.

Viewing variables

The Variables window shows you the name, scope, and value of all the variables in the current handler.
If the value of a variable is too long to fit into the display area, ToolBook displays a continuation character to indicate this. If the variable is an array, ToolBook displays a small scroll bar that allows you to scroll through the elements of the array. To show more of the variable, resize the Variables window, or drag the vertical bars between parts of the display area to make more room. You can also double-click the value of the variable to display a separate window for that value.
Changing the values of variables

You can use the Variables window to change the value of a variable. Your change is effective immediately for the current handler. For example, you can change the value of a variable if ToolBook suspends the current handler because the value of the variable is null or because a statement in the current handler attempts to assign an invalid value to the variable.

To change the value of a variable:

1 In the Variables window, click the value of the variable you want to change. If the variable is an array, use the scroll bar for that array to display the value you want to change and then click the value.

ToolBook displays the current value of the variable in the edit area of the Variables window.
2. Enter a new value and click the checkmark to save the change, or click the X to cancel the change.

Displaying and editing system variables

To see and edit a list of all the system variables declared in the current instance of the book, choose System Variables from the View menu. ToolBook displays a window similar to the Variables window, but which shows only the current system variables. You can view and edit the values of system variables using the same techniques you use in the Variables window. For details, see “Displaying and modifying variables” earlier in this chapter.

Displaying and editing user properties

To see and edit the user properties of the object whose script is running, choose User Properties from the View menu in the Toolbook Debugger. ToolBook displays a window similar to the Variables window, listing the user properties for the object and their current values. You can view and edit the values in this window using the same techniques you use in the Variables window. For details, see “Displaying and modifying variables” earlier in this chapter.

The User Properties window displays the user properties for the object whose handler is selected in the trace box. To display the user properties for a different object, click its handler identifier in the trace box.

Checking the values of properties

You can check the value of a property by choosing Command from
the View menu and testing the value there. You cannot directly view
the value of a property of an object in the Toolbook Debugger.

Using the Command window with the ToolBook Debugger

You can display the Command window while in the ToolBook
Debugger by choosing Command from the View menu or by clicking
the Command Window button on the ToolBook Debugger toolbar.
The Command window is very helpful for getting and setting:

- system properties, such as `activeWindowHandle`, `focus`,
  `focusWindow`, `printerConditions`, `selection`, `sysErrorNumber`, and
  `sysTimeFormat`.

- object properties, such as `header of this book`, `name of focus`,
  `name of this page`.

- user properties.

You cannot use the Command window to:

- change local variables.

- get the value of `target` (`target` is always the current page for the
  Command window).

- set `It` in the context of the handler being debugged (`It` is local to
  the handler being debugged).
While using the Command window in the ToolBook Debugger, keep in mind the following:

- Changes to system variables are updated after the next statement is executed, not immediately.
- To change a system variable, you must declare it in the context of the Command window. That means `svLevel = 4`, where `svLevel` is a system variable, does nothing to the system variable. However, `system svLevel; svLevel = 4` does change the value of the system variable.

**Important** Proceed carefully while using the Command window in the ToolBook Debugger as you can perform tasks that are potentially destabilizing. For example, deleting the object whose script is being debugged can cause errors and possibly change values in unexpected ways.

**Debugging a Command window script**

To debug a Command window script, place it into a handler in the script of an object and debug it from there. The ToolBook Debugger is unavailable because the text in the Command window appears as one line of script to ToolBook. The debugger cannot break this combined line into its components. Pressing RETURN or ENTER for the Command window executes the command `execute commandWindow`.

**Using scripts for debugging**

Instead of using the ToolBook Debugger to trace the execution of scripts, you can use OpenScript commands and functions to perform similar actions. For example, you can include statements in your
scripts that display the values of variables in the Command window or status bar, or that write error information to a file.

Using OpenScript commands to debug scripts gives you more precise control over which values and statements you are debugging than the ToolBook Debugger does. In addition, you can use OpenScript commands to trace execution and display values without stopping and calling the debugger; this is particularly useful when you are processing continuous user-interface actions.

The OpenScript commands listed in the following table are useful for debugging.

### OpenScript commands for debugging

<table>
<thead>
<tr>
<th>OpenScript term</th>
<th>Use to</th>
<th>Example</th>
</tr>
</thead>
</table>
| request         | Display values | request userProperties of \ field "notes"  
request It  
request my fillColor |
| beep            | Alert user to a problem | if xPos < 0 then  
beep 2  
request “You have reached” & \ “the left margin.”  
end |
| pause           | Allow time to call the ToolBook Debugger | if xPos < 0 then  
request “Error condition” & \ “detected.”  
pause 3 seconds  
end |
| sysCursor       | Alert user to current status | to handle searchBook  
sysCursor = 4  
... --Further statements here  
sysCursor = 1  
end |
Creating a function for debugging

When you are testing an application and need a quick look at whether it is executing correctly, it can be helpful to create a user-defined function that displays values in the Command window or field. For example:

```plaintext
-- Displays values in the Command window
to get debugCommandWindow fObjRef, fData
    put "Debug in " & fObjRef & ":" & fData
    return null
end

-- Displays values in a field
to get debugFieldDisplay fObjRef, fData
    text of field "debug"="Debug in " & fObjRef & ":" & fData
    return null
end
```

You can then build a debugging function call into your scripts to display values:

```plaintext
step i from 1 to 1000
    vPos = myFunc(i)
    -- Additional statement calls the function
    get debugCommandWindow(self, i && vPos)
end
```
When you want to disable debugging, simply remove or rename the function and your scripts will run normally.

**Note** Before releasing a ToolBook application as a final product, remove the calls to user-defined debugging functions to achieve maximum performance.

**Using the status bar for debugging**

You can use the status bar to display information while a script is running. Using the status bar is convenient if you do not want to display the Command window in the middle of the screen. However, the status bar is limited to displaying about 60 characters, so it might not be useful if you want to display longer strings of text.

To use the status bar, make sure that it appears when the script is running. You can display information in the status bar by setting its *caption* property. The following example illustrates a handler that displays the unique name of the object under the mouse pointer while the mouse button is pressed:

```plaintext
to handle buttonStillDown loc
    readerStatusBar of this viewer = true
    system vCurrentObject
    objPoint = objectFromPoint(loc)
    if objPoint is not vCurrentObject then
        caption of statusBar = objPoint
        vCurrentObject = objPoint
    end if
end buttonStillDown
```

You can use the status bar to display data in the same way you use the Command window. For example, you can display debugging information in the status bar instead of the Command window:
to get debugCommandWindow fObjRef, fData
  in viewer mainWindow
    caption of statusBar = "Debug in " & fObjRef & " : " & fData
  end
return null
end

Using a trace file to record errors

You might not always be able to monitor the execution of your script, but you can track problems that occur in your application while it is being used elsewhere. To keep track of areas in the application that need debugging, write your traces to a file. For details about tracing, see “Tracing script execution” earlier in this chapter.

Writing traces to a file is similar to displaying them in the Command window, except that the messages that would appear in the ToolBook Debugger trace box are written to a file that you can examine later. To create a trace file, first open or create a text file to store the error information. A good place to create this file is in an enterBook handler in the book script or in a system book script. For example:

to handle enterBook
  system svDebugFile
  svDebugFile = "debug.txt"
  clear sysError
  openFile svDebugFile
  if sysError is not null
    clear sysError
    createFile svDebugFile

You can write to this file at any time to record an activity while the book is running. One easy way to do this is to write a user-defined function that updates the file. You can call this function as part of any script, and have your script pass it the error information that you want to record. The following example contains the script for a function to update the trace file.

--This handler creates entries in a trace file; place this
--user-defined function in the script of the book you are debugging
--or in a system book
to get debugTraceFile fErrText
    system svDebugFile
    openFile svDebugFile
    vLine = CRLF & sysDate && sysTime && fErrText
    writeFile vLine to svDebugFile
    closeFile svDebugFile
    return null
end

You can call the debugTraceFile function as you called the Command window in the example illustrated under “Creating a function for debugging” earlier in this chapter. For example:

to handle buttonClick
    clear sysError
    fileName = "\data.txt"
    openFile fileName
    if sysError is not null then
        --If error detected, records the error in the trace file
        get debugTraceFile( "Error opening" && fileName && 
                       "from buttonClick handler of" && self )
    end if
end buttonClick
**Note** You should not use a trace file after debugging an application. If you do, you might build up large files, and the file manipulation will slow application performance considerably. You can use the search-and-replace utility to remove the `debugTraceFile` calls from all of your scripts.